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Introduction

License Agreement

HIGHWAY SAFETY SOFTWARE™ (HSS™)
END-USER LICENSE AGREEMENT (EULA)

Effective Date: 10/15/2024

Copyright © 2024 University of Florida. All rights reserved.

This End User License Agreement (“Agreement”) is a legal agreement between you (“End User”, “you”) and the
University of Florida Board of Trustees for the benefit of the McTrans Center (“McTrans”, "we”) regarding the use
of the Highway Safety Software (“Software”). By accessing or using the Software programs within the electronically

transmitted package or direct download, you agree to be bound by the terms and conditions of this Agreement.

1. INTEGRATION:

This License Agreement is the complete and exclusive statement of the agreement between End User and McTrans
and supersedes any previous End User License Agreements distributed by older versions of the software proposal
or prior agreement, oral or written, and any other communications between End User and McTrans relating to the
subject matter of this License Agreement. This License Agreement may only be modified by a written agreement
made subsequent to the date hereof and signed by both parties.

2. LICENSE GRANT:

2.1 Subscription-Based License:

McTrans grants you a non-exclusive, non-transferable license to access and use the Software, subject to the terms
of your active subscription. The license is valid only for the duration of your subscription and is contingent upon full
payment of all applicable fees.

2.2 Access to Software Versions:

Your subscription grants access to versions 8 series and beyond (2022 onward) of the Software. When a new
version of the Software is released, the End User with an active subscription can download and access the latest
version at no additional cost for the remainder of their subscription term.

3. TYPES OF SUBSCRIPTIONS:
The type of subscription determines the permitted use of the Software. Once a subscription type is selected, it
cannot be changed or exchanged for a different type.

3.1 Office-Based Subscription:

This subscription grants access to the Software for a predetermined number of computers within a physical office.
An "office" refers exclusively to a fixed geographical location, typically a single physical address, where an
organization conducts its business or operational activities. This location must consist of one or more contiguous
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rooms or spaces within a single building. Virtual offices or any non-physical locations are excluded from this
definition.

The Software may be installed on multiple devices within the office, and access is restricted to end users officially
assigned to that licensed office. End Users may also use the Software on portable computers, such as laptops,
while on official travel, provided that all (100%) such use is exclusively on behalf of the office for which this Software
license was purchased. Additional offices must obtain proper licensing prior to accessing the Software. The
Software may only be installed on devices owned or controlled by the licensed office.

This subscription is intended exclusively for commercial use.

Virtualization Restriction:

The Software under an office-based subscription is prohibited from being used in a virtualized environment. All
installations of the Software must be conducted on a physical computer, such as a desktop or laptop. Remote
access technologies, such as remote desktop, are strictly prohibited under this subscription type.

3.2 Computer-Based Subscription:

This subscription permits the installation and use of the Software on a specified number of individual devices. An
"individual device" refers to a single, standalone computing unit, such as a desktop or laptop, intended for use by a
single user at a time. It is not shared concurrently with other users and is intended for use by a single user only The
Software may only be accessed directly from the device(s) on which it is installed, regardless of whether the device
is located in a physical office or used in a virtual office. End users working remotely or in virtual offices must ensure
that the device remains dedicated to their use and fully complies with the terms of this subscription.

Virtualization Restriction:

The Software under a computer-based subscription is prohibited from being used in a virtualized environment. All
installations must be conducted on a physical computer, such as a desktop, PC, or laptop. Remote access to the
Software via any technology, including but not limited to remote desktop, is strictly prohibited under this subscription
type.

3.3 Academic Subscription:

The academic subscription is available exclusively to academic institutions and grants access to a specified number
of seats (copies) across the entire academic institution. This subscription is intended solely for use in a classroom
setting for teaching or a lab for research purposes under the direct supervision of faculty or other authorized
personnel. The Software may only be installed on devices owned or controlled by the academic institution.

The End User is required to implement appropriate protection measures to prevent students or any other individuals
from copying the Software and removing it from the lab or classroom environment. The responsibility for
safeguarding the Software and preventing unauthorized copying or distribution rests entirely with the End User.

Virtualization for Virtual Classrooms:

Under the academic license, the End User may request permission to utilize a virtual environment for the installation
and use of the Software. Such virtualization is only permitted with prior written consent from McTrans. If such
permission is granted, the virtual environment must adhere to all protections and restrictions outlined in this
Agreement, ensuring that the Software is used exclusively for its intended educational purposes and its access is
limited to the institution's faculty and actively enrolled students only. Additionally, the number of seats purchased
must be sufficient to cover the number of students and faculty accessing the virtual classroom.

4., SUBSCRIPTION TERM:

4.1 Duration:

The subscription term begins on the date of purchase and continues for the period specified at the time of purchase
("Subscription Term"). The license granted under this Agreement is valid only for the duration of the Subscription
Term.
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4.2 Renewal:

Subscriptions may be renewed upon payment of applicable fees before the end of the Subscription Term. If the
subscription is not renewed, access to the Software and all related services, including technical support, will be
terminated.

5. TECHNICAL SUPPORT:

5.1 Support Services:

During the active Subscription Term, the End User is entitled to reasonable telephone or email support provided
during the normal business hours of McTrans. McTrans reserves the right to determine the extent of the support
provided.

5.2 Revisions and Enhancements:

McTrans reserves the right to make substantial revisions and enhancements to the Software and to market such
substantially revised versions as separate products. The End User shall not be entitled to receive such separate
products without additional charge. Upon the release of any such revised version of the Software, the obligation to
provide the above-described technical support services to the End User shall cease unless the End User chooses
to pay to license the enhanced version of the Software, regardless of whether the End User has previously
requested or received support on the prior version.

6. NETWORK USE:

The End User is strictly prohibited from using the Software on any network. This prohibition includes but is not
limited to the use of the Software either directly or indirectly through commands, data, or instructions transmitted to
or from a computer that is not licensed or is not part of the licensed internal network. This also includes any use for
Internet or web hosting services or by any user who does not hold a valid license for the Software from McTrans.

The Software is not designed for network use, and such use is unsupported. McTrans will not provide technical
support for any issues resulting from network incompatibilities or unauthorized network use.

7. RESTRICTIONS ON USE:
The End User agrees that they shall not, nor shall they permit any third party to:
e Software Modification: Modify, adapt, translate, or create derivative works based on the Software, in whole
or in part, without the express prior written consent of McTrans.
e Reverse Engineering: Reverse engineer, decompile, disassemble, or otherwise attempt to derive the
source code of the Software, except to the extent expressly permitted by applicable law.
e Unauthorized Use: Use the Software for any purpose other than as expressly permitted under this
Agreement, including unauthorized copying, distribution, or dissemination of the Software.
e Intellectual Property Infringement: Engage in any activity that infringes on the intellectual property rights of
McTrans, including any unauthorized copying or distribution of the Software or associated documentation.
e Copying and Distribution: Copy, reproduce, or distribute the Software or associated printed documentation
for sale, distribution, or dissemination, except as expressly provided under the terms of this Agreement or
with the express prior written consent of McTrans.
e Documentation Use: Reproduce the associated documentation only as necessary for use within the
permitted scope of the subscription type as outlined in this Agreement.

Ownership of Software Modifications:

Any modifications, adaptations, translations, derivative works, or any other products or materials resulting from any
prohibited actions shall become the exclusive property of McTrans, regardless of whether such actions were
performed with or without McTrans’ consent.
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8. INTELLECTUAL PROPERTY RIGHTS:
The Software and all associated intellectual property rights are owned by McTrans. No rights are granted to the
End User other than the limited license expressly set forth in this Agreement.

9. USE OF RESULTS IN RESEARCH AND COMMERCIAL PUBLICATIONS:

McTrans grants the End User legal permission to use the results generated by the Software in academic, research,
or commercial publications, provided that such use complies with the terms of this agreement. The End User may
publish or present findings derived from the Software as part of their research or commercial work as long as the
Software is properly cited and all applicable license terms and restrictions are adhered to. Unauthorized
reproduction or distribution of the Software itself remains strictly prohibited.

10. TRANSFER RESTRICTIONS:

The Software is licensed only to the End User, and this License Agreement may not be assigned or transferred to
anyone without McTrans’ prior written consent. Any authorized transferee of this License Agreement shall be bound
by the terms of this License Agreement. The End User may not transfer, assign, rent, lease, sell, or otherwise
dispose of the Software except as expressly provided in this License Agreement.

11. LIMITED WARRANTY AND LIMITATIONS OF REMEDIES:

End User acknowledges and agrees that it is the sole responsibility of End User to fully understand the limitations
and assumptions underlying the Software and to refrain from using the Software without the assistance of personnel
with appropriate expertise. The End User accepts full responsibility for reviewing, interpreting, applying, and utilizing
the output of the Software and for ensuring that such output complies with any applicable design codes, standards,
or project specifications.

Except as expressly provided herein, the Software is provided “AS IS” without warranty of any kind, whether
expressed or implied, including, but not limited to, implied warranties of merchantability and fitness for a particular
purpose. McTrans does not warrant that the functions contained in the Software will meet the End User’s
requirements or that the operation of the Software will be uninterrupted or error-free. The entire risk as to the quality
and performance of the product is with the End User.

In no event will McTrans be liable to the End User for any damages, including any lost profits, lost savings, or other
incidental or consequential damages arising out of the use of or inability to use the Software, even if McTrans has
been advised of the possibility of such damages, or for any claim by any other party. The above warranty gives the
End User specific legal rights, and the End User may also have other rights in the United States, which vary from
state to state.

Use of the Software where the End User believes or has reason to believe that damage may occur constitutes a
violation of any and all warranties. McTrans has no knowledge of the hardware or Software configurations of the
End User and assumes no liability for their damage.

12. TERMINATION:

12.1 Termination by McTrans:

McTrans may terminate this Agreement immediately upon notice if you fail to comply with any term or condition of
this Agreement. Upon termination, you must cease all use of the Software and destroy all copies of the Software in
your possession.

12.2 Termination by End User:
You may terminate this Agreement at any time by discontinuing the use of the Software and notifying McTrans. No
refunds will be provided for any remaining portion of the Subscription Term.
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13. GOVERNING LAW:

This License Agreement shall be governed by the laws of the State of Florida, U.S.A. Venue for all disputes related
to this License Agreement shall be in the United States District Court of the Northern District of Florida, Gainesville
Division, or in the Circuit Court of the Eighth Judicial Circuit for Alachua County, Florida.

14. U.S. GOVERNMENT RESTRICTED RIGHTS:

The Software and associated documentation are provided with RESTRICTED RIGHTS. Use, duplication, or
disclosure by the U.S. Government is subject to restrictions as set forth in subdivision (c)(1)(ii) of The Rights in
Technical Data and Computer Software clause at 52.227-7013 or subparagraphs (c)(1) and (2) of the Commercial
Computer Software - Restricted Rights at 48CFR52.227-19. The contractor is McTrans, University of Florida, PO
Box 116585, Gainesville, FL 32611-6585.

15. EXPORT REGULATION:

The Software may be subject to U.S. export control laws and regulations, including the U.S. Export Control Reform
Act and its associated regulations. End User will not directly or indirectly export, re-export, transfer, or release the
Software to, or make the Software accessible from, any country, jurisdiction, or person to which export, re-export,
transfer, or release is prohibited by applicable U.S. laws and regulations. End User will comply with all applicable
laws and regulations and complete all required undertakings (including obtaining any necessary export license or
other governmental approval) prior to exporting, re-exporting, transferring, or releasing, or otherwise making the
Software available, outside the U.S. End User shall not export, re-export, transfer, or release the software or
software source code to any country which is comprehensively sanctioned by the U.S. Department of the Treasury,
Office of Foreign Assets Control (OFAC), as updated from time to time, which currently includes: Cuba, Iran, North
Korea, Syria, and the Donetsk, Luhansk, and Crimea regions of Ukraine.

16. SEVERABILITY:

If any portion of this License Agreement shall be declared void or a nullity by a court of competent jurisdiction, then
the remainder shall survive and remain in full force. Should you have any questions concerning this license, you
may contact the McTrans Center, University of Florida, PO Box 116585, Gainesville, FL 32611-6585, U.S.A,, [1]
(800) 226-1013.

Highway Safety Software User Guide Introduction - 5



Acknowledgements

McTrans Center, University of Florida Transportation Institute
PO Box 116585, Gainesville FL 32611-6585

Telephone: 1-800-226-1013 Fax: 352-392-6629

Web: mctrans.ce.ufl.,edu Email: mctrans@ce.ufl.edu

We acknowledge the Transportation Research Board (TRB), the USDOT’s Federal Highway Administration
(FHWA), the American Traffic Safety Services Association (ATSSA), the Institute of Transportation Engineers (ITE),
and the American Association of State Highway and Transportation Officials (AASHTO) for all text, figures, and
references included in HSS and express our sincere appreciation for permission to include this information.

Trademarks and Copyrights

Microsoft(R), MS-DOS(R), and Windows(TM) are registered trademarks of Microsoft Corporation.

e McTrans(TM), HCS(TM), HSS(TM), TSIS-CORSIM(TM), and TRANSYT-7F(TM) are trademarks of the
University of Florida.

e HCS, HCS2025, HCS2024, HCS2023, HCS2022, HCS7, HCS 2010, HCS+, HSS, HSS2025, HSS2024,
TRANSYT-7F, and T7F are copyright University of Florida.

e TSIS-CORSIM, TSIS-CORSIM2025, TSIS-CORSIM2024, TSIS-CORSIM2023, TSIS-CORSIM2022, TSIS,
CORSIM, NETSIM, FRESIM, TRAFED, TRAFVU, and TShell are copyright University of Florida, with portions
copyright ITT Industries, Inc., Systems Division.

6 - Introduction Highway Safety Software User Guide



Getting Started

Getting Started

To begin, click on File then New (or the "New File..." button on the Start page).

Normal Windows keyboard and mouse functions are available. Tabbing, clicking to a new field, or pressing the
Enter key will trigger a recalculation and update the report.
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General Controls

Menu Items

New — Creates a new HSS file (*.xhz) and starts a new analysis project based on one of the selections below;
shortcut is Ctrl+N

Segment — Creates a new HSS file (*.xhz) and starts a new Segment analysis project

Intersection/Speed Change Lanes — Creates a new HSS file (*.xhz) and starts a new Intersection/Speed
Change Lanes analysis project

Rural Facility — Creates a new HSS file (*.xhz) and starts a new Rural Facility analysis project

Urban Facility — Creates a new HSS file (*.xhz) and starts a new Urban Facility analysis project

Freeway and Ramp Facility — Creates a new HSS file (*.xhz) and starts a new Freeway and Ramp Facility
analysis project

Open — Opens an existing HSS file (*xhz) or HCS Freeways/Highways file (*.xuf); shortcut is Ctrl+O
Example Folder — Opens folder with HSS examples in File Explorer
Save — Saves an open HSS file (*.xhz) using the current file name; shortcut is Ctrl+S
Save As... — Saves an open HSS file (*.xhz) using a specified file name; shortcut is F12
Close — Closes an existing HSS file (*.xhz); shortcut is Ctrl+W
Units
USC Units — Changes the units of the current file to U.S. Customary
Metric Units — Changes the units of the current file to Metric
Print — Brings up printer selection and prints an HSS report to the printer or specified file type; shortcut is Ctrl+P

Print Preview — Displays preview of current report before printing; shortcut is Ctrl+F2

View
Page View — Changes the view to display inputs and report by pages; shortcut is F9
Full View
Report -> Right — Changes the view to display both the input screen and report simultaneously;
the report is displayed on the right portion of the screen; shortcut is F10
Report

Formatted Report — Displays formatted report including the most important values; shortcut is F4

Text Report — Displays text report with input, intermediary, and final results; shortcut is F6
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Parameter Template

View/Edit Template — Displays all Segment and Intersection Common Parameters for every Facility Type
on the General page, including the Economic Analysis Common Parameters, for editing; all other pages
and navigation buttons will be disabled until editing is finished; during editing, ‘View/Edit Template’ changes
to “To Normal Mode’, which can be selected after editing is finished

Export Template — Opens a Save As dialog box for user to save the exported template as an HSS
Template File (*.xhzt)

Import Template — Displays a popup indicating the template was successfully imported; all parameters for
the file will update according to values saved in the imported template

Export to CSV — Opens a Save As dialog box for the user to save exported results as an HSS CSV file (*.csv);
results saved in exported file are dependent on the Analysis Type of the dataset

Default Settings — Opens a dialog box for the user to input defaults for Analyst, Agency, Jurisdiction, and Default
Template (which allows the user to add a default path to a saved template), which will be applied to all new files;
also allows selection of USC or Sl units, which will be applied to all new files; shortcut is Alt+F

Help

Contents — Provides access to glossary, acknowledgements, copyrights, and information on the HSS
procedures; shortcut is Ctrl+F1

Index — Allows user to search keywords within the glossary
Search — Allows user to search for any word within the glossary
User Guide — Opens a comprehensive user guide in PDF format; shortcut is Ctrl+G

HSS Updates — Sends the HSS version number anonymously without any personally identifiable
information to McTrans to check for a newer version

HSM/HSS Training — Opens the McTrans Training Page in the default web browser to view the latest
training opportunities

Support

Frequently Asked Questions — Opens the McTrans support page for HSS in the default web
browser

HSS Overview — Opens the McTrans HSS Overview page in the default web browser
McTrans Website — Opens the McTrans home page in the default web browser

E-mail McTrans — Composes a new e-mail addressed to McTrans in the default e-mail client with
registration number, serial key, module, and version number already populated in the Subject field

About HSS - Opens an about window with software version information, EULA, general
acknowledgements, contact information, and other relevant links

Exit — Exits the Highway Safety Software; shortcut is Alt+F
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Highway Safety

Highway Safety Manual

The Highway Safety Software (HSS) is designed to determine the predicted number of crashes for segments and
intersections following the Predictive Method found in the AASHTO Highway Safety Manual (HSM) and NCHRP
reports. The basis of the Predictive Method is calculating a Safety Performance Function (SPF) and applying Crash
Modification Factors (CMFs) based on certain geometric and safety feature data in the intersection/segment. The
Crash Modification Factors Clearinghouse provides a searchable database of CMFs along with guidance and
resources on using CMFs in road safety practice: https://cmfclearinghouse.fhwa.dot.gov/index.php. The Predictive
Method is explained in the HSM Part C and the HSM Supplement in the following chapters:

Chapter 10 — Rural Two-Lane, Two-Way Roads
Chapter 11 — Rural Multilane Highways
Chapter 12 — Urban and Suburban Arterials
Chapter 18 — Freeways

Chapter 19 — Ramps

The Highway Safety Software also includes new methods developed as a product of research projects. These
methods were implemented as published in the reports listed below, and may be adjusted when formally
incorporated in a future release of the Highway Safety Manual:

Roundabouts — NCHRP Report 888: Development of Roundabout Crash Prediction Models and Methods /
NCHRP Project 17-70

Intersections with All-Way Stop Control - NCHRP Web-Only Document 297: Intersection Crash Prediction
Methods for the Highway Safety Manual /| NCHRP Project 17-68, Chapter 3

Three-Leg Intersections with Signal Control on Rural Highways — NCHRP Web-Only Document 297:
Intersection Crash Prediction Methods for the Highway Safety Manual | NCHRP Project 17-68, Chapter 4
Urban and Suburban Segments with Six or More Lanes — NCHRP Web-Only Document 318: Safety
Prediction Models for Six-Lane and One-Way Urban and Suburban Arterials /| NCHRP Project 17-58,
Chapter 5

Intersections of Urban and Suburban Arterials with Six or More Lanes — NCHRP Web-Only Document 318:
Safety Prediction Models for Six-Lane and One-Way Urban and Suburban Arterials | NCHRP Project 17-
58, Chapter 6

Urban and Suburban One-Way Arterial Roadway Segments — NCHRP Web-Only Document 318: Safety
Prediction Models for Six-Lane and One-Way Urban and Suburban Arterials /| NCHRP Project 17-58,
Chapter 7

Intersections of Urban and Suburban One-Way Arterials — NCHRP Web-Only Document 318: Safety
Prediction Models for Six-Lane and One-Way Urban and Suburban Arterials | NCHRP Project 17-58,
Chapter 8

Intersections on High-Speed Urban and Suburban Arterials — NCHRP Web-Only Document 297:
Intersection Crash Prediction Methods for the Highway Safety Manual | NCHRP Project 17-68, Chapter 5
Crossroad Ramp Terminals at Single-Point Diamond Interchanges — NCHRP Web-Only Document 297:
Intersection Crash Prediction Methods for the Highway Safety Manual | NCHRP Project 17-68, Chapter 8
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e Crossroad Ramp Terminals at Tight Diamond Interchanges — NCHRP Web-Only Document 297:
Intersection Crash Prediction Methods for the Highway Safety Manual | NCHRP Project 17-68, Chapter 9

Initial Steps

When creating a new file in HSS from the Start page, a prompt appears asking for the Analysis Type, as shown
below:

r% .

Start , Help
-

New File... % Select Analysis Type X Topics
Open File... HSS ates
® Segment )
Example Folder... : . HSS Overview
) Intersection/Speed Change Lanes
Recent Rural Facility McTrans Website
D Urban Facility HSM/HSS Training
) Freeway and Ramp Facility E-mail McTrans

oKk | About HSS

& HSS2025
UF | nperteion e | MICTFANs

Copyright ® 2024 University of Florida. All Rights Reserved. HSS™ Version 2025

The process for user inputs is very similar between all five available Analysis Types. Once Analysis Type is selected,
it cannot be changed. A new file must be created if the user wishes to change the Analysis Type.

Segment Analysis

Once Segment is selected as the Analysis Type, the user will be brought to the General page, which includes a
section for Project Properties. The Project Properties section includes general information about the project, which
include: Analyst, Agency, Date, Jurisdiction, Analysis Year, Project Description, Empirical Bayes Analysis, Number
of Years of Observed Crashes, Facility Type, and Area Type. The user can switch between different Facility Types.
The five choices of Facility Type include: Rural Two-Lane Segment, Rural Multilane Segment, Urban Segment,
Freeway Segment, and Ramp Segment. If the Facility Type selected is Rural Two-Lane Segment or Rural Multilane
Segment, the Area Type will automatically be set to Rural. If the Facility Type selected is Urban Segment, the Area
Type will automatically be set to Urban. If the Facility Type selected is Freeway Segment or Ramp Segment, a drop-
down menu will be enabled for Area Type, allowing a selection between Rural and Urban. An Empirical Bayes (EB)
Analysis checkbox is provided for the user to indicate whether or not to use the EB analysis, which is a method
used to combine observed crash frequency data for a given site with predicted crash frequency data from many
similar sites to estimate its expected crash frequency. Checking this will also enable the Number of Years of
Observed Crashes input on the General page and the Observed Crashes inputs on the Details page.

If economic results are enabled through the Default Settings, then Economic Analysis Common Parameters will
also show on the General page. Other parameters are included on the Details page under the Parameters section.
The Facility Type selected on the General page will determine which segment parameters to show. The parameters
listed vary based on the Model Type under analysis.
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Rural Two-Lane Segment Common Parameters include:

e Calibration Factor, C
e Proportion of Related Crashes, Pra
e Proportion of Nighttime Crashes that Involve a Fatality or Injury, Pinr
e Proportion of Nighttime Crashes that Involve Property Damage, Ppnr
e Proportion of Crashes that Occur at Night, Pnr
e Proportion of Fatal
e Proportion of Incapacitating Injury
e Proportion of Nonincapacitating Injury
e Proportion of Possible Injury
e Crash distribution proportions for Total, Fatal-and-Injury, and Property-Damage-Only crashes:
o Single-Vehicle Crashes
= Collision with Animal
= Collision with Bicycle
= Collision with Pedestrian
=  Overturned
= Ran Off Road
= Other Single-Vehicle Collision
o Multiple-Vehicle Crashes
= Angle Collision
= Head-On Collision
= Rear-End Collision
= Sideswipe Collision
= Other Multiple-Vehicle Collision

Rural Multilane Segment Common Parameters include:

e Calibration Factor, C
e Proportion of Related Crashes, Pra
e Proportion of Nighttime Crashes that Involve a Fatality or Injury, Pinr
e Proportion of Nighttime Crashes that Involve Property Damage, Ppnr
e Proportion of Crashes that Occur at Night, Pnr
e Crash distribution proportions for Total, Fatal-and-Injury, Fatal-and-Injury KAB, and Property-Damage-Only
crashes:
o Head-On Collision
Sideswipe Collision
Rear-End Collision
Angle Collision
Single-Vehicle Crashes
Other Multiple-Vehicle Crashes

O O O O O

Urban Segment Common Parameters include:

e Calibration Factor, C (Speed <=30)

e Calibration Factor, C (Speed >30)

e Proportion of Nighttime Crashes that Involve a Fatality or Injury, Pinr
e Proportion of Nighttime Crashes that Involve Property Damage, Ppnr
e Proportion of Crashes that Occur at Night, Pnr

e Pedestrian Crash Adjustment Factor, fpedr (Speed <=30)

e Pedestrian Crash Adjustment Factor, fpedr (Speed >30)

e Bicycle Crash Adjustment Factor, foiker (Speed <=30)

e Bicycle Crash Adjustment Factor, foiker (Speed >30)
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e Crash distribution proportions for Fatal-and-Injury and Property-Damage-Only crashes:

o Single-Vehicle Crashes

= Collision with Animal

= Collision with Fixed Object

= Collision with Fixed Object-Left

= Collision with Fixed Object-Right

= Collision with Other Object

= Other Single-Vehicle Collisions
o Multiple-Vehicle Crashes

= Rear-End Collisions

= Head-On Collisions

= Angle Collisions

= Sideswipe, Same Direction

= Sideswipe, Opposite Direction

= Other Multiple-Vehicle Collision

Freeway Segment Common Parameters include:

e Calibration Factor for Multiple-Vehicle Fatal-and-Injury Crashes, Cmviii

e Calibration Factor for Multiple-Vehicle Property-Damage-Only Crashes, Cmv,pdo
e Calibration Factor for Single-Vehicle Fatal-and-Injury Crashes, Csy;i

e Calibration Factor for Single-Vehicle Property-Damage-Only Crashes, Csv,pdo

Ramp Segment Common Parameters include:

Calibration Factor for Multiple-Vehicle Fatal-and-Injury Crashes, Cmvifi
Calibration Factor for Multiple-Vehicle Property-Damage-Only Crashes, Cmv,pdo
Calibration Factor for Single-Vehicle Fatal-and-Injury Crashes, Csv i
Calibration Factor for Single-Vehicle Property-Damage-Only Crashes, Csv,pdo

The Economic Analysis Common Parameters include Societal Crash Costs by Crash Severity:

e Fatal/lnjury, $
e Property Damage Only, $

Below is an example of the General page:

Project Description

Analyst Jurisdiction

Agency Analysis Year 2024
Date 9/21/2024 Project Description

Empirical Bayes Analysis O Number of Years of Observed Crashes 1
Facility Type Ramp Segment © Area Type Rural

@ Economic Analysis Common Parameters

Societal Crash Costs by Crash Severity

Fatal/Injury, $ 158200

Property Damage Only, $ 7400

On the Details page, four sections are provided: Segment, Input, Parameters, and Output. Depending on if Empirical
Bayes Analysis is selected on the General page, there could also be an additional Observed Crashes section. The
Segment section states the Facility Type selected on the General page and provides a drop-down menu for
selecting the Model Type based on the Facility Type selected. Inputs and Parameters available are based on the
Facility Type and Model Type selected. Outputs include the Safety Performance Functions (SPFs), the various

Crash Modification Factors (CMFs), and the Predicted Crash Frequencies.
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Below is an example of the Details page for a Rural Two-Lane Facility Type and an Undivided Roadway Segment
(2U) Model Type, with Empirical Bayes Analysis checked on the General page:

Section Data
Section 1> B Facility Type Rural Two-Lane
Section Type Segment Model Type Two-Lane Undivided Segment (2U)
Input
AADT, veh/day 1000 Length, mi 1.000
Lane Width, ft 120 Shoulder Width, ft 6.0
Shoulder Type Paved - Horizontal Curve O
Horizontal Curve Length, mi Horizontal Curve Radius, ft
Spiral Transition Superelevation Variance, ft/ft
Grade, % 0.0 Number of Driveways 0
Centerline Rumble Strips [m] Passing Lanes No Passing or Climbing Lanes
Two-Way Left-Turn Lanes [m] Roadside Hazard Rating 3
Lighting O Automated Speed Enforcement [m}
Observed Crashes 0
User-Defined CMFs
CMF Name CMF Description CMF Type  CMF Value
Parameters
O]
Output
Safety Performance Function (SPF) 0.267 Predicted Crash Frequency (Npredicted) 0.267
CMF1 (Lane Width) 1.000 CMF2 (Shoulders) 1.000
CMF3 (Horizontal Curves) 1.000 CMF4 (Horizontal Curves: Superelevation) 1.000
CMFS (Grades) 1.000 CMF6 (Driveway Density, CMF6 = 1 when <=5) 1.000
CMEF7 (Centerline Rumble Strips) 1.000 CMF8 (Passing Lanes) 1.000
CMF9 (Two-Way Left-Turn Lanes) 1.000 CMF10 (Roadside Design) 1.000
CMF11 (Lighting) 1.000 CMF12 (Automated Speed Enforcement) 1.000

Intersection Analysis

Once Intersection/Speed Change Lanes is selected as the Analysis Type, the user will be brought to the General
page, which includes a section for Project Properties. The Project Properties section includes general information
about the project, which include: Analyst, Agency, Date, Jurisdiction, Analysis Year, Project Description, Empirical
Bayes Analysis, Number of Years of Observed Crashes, Facility Type, and Area Type. The user can switch between
different Facility Types. The five choices of Facility Type include: Rural Two-Lane Intersection, Rural Multilane
Intersection, Urban Intersection, Speed Change Lanes, and Ramp Terminal. If the Facility Type selected is Rural
Two-Lane Intersection or Rural Multilane Intersection, the Area Type will automatically be set to Rural. If the Facility
Type selected is Urban Intersection, the Area Type will automatically be set to Urban. If the Facility Type selected
is Speed Changes Lanes or Ramp Terminal, a drop-down menu will be enabled for Area Type, allowing a selection
between Rural and Urban. An Empirical Bayes (EB) Analysis checkbox is provided for the user to indicate whether
or not to use the EB analysis, which is a method used to combine observed crash frequency data for a given site
with predicted crash frequency data from many similar sites to estimate its expected crash frequency. Checking this
will also enable the Number of Years of Observed Crashes input on the General page and the Observed Crashes
inputs on the Details page.

If economic results are enabled through the Default Settings, then Economic Analysis Common Parameters will
also show on the General page. Other parameters are included on the Details page under the Parameters section.
The Facility Type selected on the General page will determine which intersection parameters to show. The
parameters listed vary based on the Model Type under analysis.

Rural Two-Lane Intersection Common Parameters include:

e Calibration Factor, C

e Proportion of Total Crashes for Unlighted Intersections that Occur at Night, Phni
e Proportion of Fatal

e Proportion of Incapacitating Injury

e Proportion of Nonincapacitating Injury
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e Proportion of Possible Injury

e Crash distribution proportions for Total, Fatal-and-Injury, and Property-Damage-Only crashes:

o Single-Vehicle Crashes

= Collision with Animal

= Collision with Bicycle

= Collision with Pedestrian

= Vehicle Overturned

= Ran Off Road

= Other Single-Vehicle Collision
o Multiple-Vehicle Crashes

= Angle Collision

= Head-On Collision

= Rear-End Collision

= Sideswipe Collision

= Other Multiple-Vehicle Collision

Rural Multilane Intersection Common Parameters include:

e Calibration Factor, C
e Proportion of Total Crashes for Unlighted Intersections that Occur at Night, Pni

e Crash distribution proportions for Total, Fatal-and-Injury, Fatal-and-Injury KAB, and Property-Damage-Only

crashes:
o Head-On Collision
Sideswipe Collision
Rear-End Collision
Angle Collision
Single-Vehicle Crashes
Other Multiple-Vehicle Crashes

O O O O O

Urban Intersection Common Parameters include:

Calibration Factor, C

Proportion of Total Crashes that Occur at Night, Pni

Pedestrian Crash Adjustment Factor, fpedi

Bicycle Crash Adjustment Factor, foikei

Proportion of MV Crashes by Right-Angle Collisions, Pramv (FI)
Proportion of MV Crashes by Right-Angle Collisions, Pramv (PDO)
Proportion of MV Crashes by Rear-End Collisions, Premv (FI)
Proportion of MV Crashes by Rear-End Collisions, Premv (PDO)
Proportion of Fatal-and-Injury Crashes for Combined Sites, foisv

o Single-Vehicle Crashes
= Collision with Parked Vehicle
= Collision with Animal
= Vehicle Overturned
= Collision with Fixed Object
= Collision with Other Object
= Other Single-Vehicle Collision
= Noncollision
o Multiple-Vehicle Crashes
= Rear-End Collision
= Head-On Collision
= Angle Collision
= Sideswipe
= Other Multiple-Vehicle Collision

Crash distribution proportions for Fatal-and-Injury and Property-Damage-Only crashes:
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Speed Change Lanes Intersection Common Parameters include:

e Calibration Factor for Fatal-and-Injury Crashes, Cr;
e Calibration Factor for Property-Damage-Only Crashes, Cpdo

Ramp Terminal Intersection Common Parameters include:

e Calibration Factor for Fatal-and-Injury Crashes, Cii
e Calibration Factor for Property-Damage-Only Crashes, Cpdo

The Economic Analysis Common Parameters include Societal Crash Costs by Crash Severity:

e Fatal/lnjury, $
e Property Damage Only, $

Below is an example of the General page:

Analyst

Agency

Date 9/21/2024
Empirical Bayes Analysis O

Facility Type Urban Intersection

@ Economic Analysis Common Parameters
Societal Crash Costs by Crash Severity

Fatal/Injury, $ 158200

Property Damage Only, $ 7400

Project Description

Jurisdiction

Analysis Year

Project Description

Number of Years of Observed Crashes

Area Type

2024

Urban

On the Details page, four sections are provided: Intersection, Input, Parameters, and Output. Depending on if
Empirical Bayes Analysis is selected on the General page, there could also be an additional Observed Crashes
section. The Intersection section states the Facility Type selected on the General page and provides a drop-down
menu for selecting the Model Type based on the Facility Type selected. Inputs and Parameters available are based
on the Facility Type and Model Type selected. Additional input sections may also appear depending on the Facility
Type and/or Model Type selected. Outputs include the Safety Performance Functions (SPFs), the various Crash
Modification Factors (CMFs), and the Predicted Crash Frequencies.

Below is an example of the Details page for an Urban Facility Type and a Four Approach Stop (4ST) General Model
Type, with Empirical Bayes Analysis checked on the General page:

Section 1>

Section Type Intersection

Is Major Street One-Way? O

Is Minor Street One-Way? O
Method Type General
AADT (maj), veh/day 1000
Approaches with Left-Turn Lanes 0
Lighting O

Add User-Defined CMF

CMF Name CMF Description

Multiple Vehicle 0

Safety Performance Function (SPF) 0330
CMF1 (Left-Turn Lanes) 1.000
CMF3 (Right-Turn Lanes) 1.000
CMFS (Lighting) 1.000

Section Data
Facility Type
Model Type
Number of Through Lanes on Major Street
Number of Through Lanes on Minor Street
Major Street Posted Speed
Input
AADT (min), veh/day

Approaches with Right-Turn Lanes

User-Defined CMFs

Parameters

Observed Crashes
Single Vehicle
Output
Predicted Crash Frequency (Npredicted)
CMF2 (Left-Turn Phases)
CMF4 (Right-Turn on Red)

CMF6 (Red Light Running Cameras)

Urban

Four-leg, Minor-Stop (4ST)

4

2

Under 50 mi/h

1000

Delete User-Defined CMF

CMF Type  CMF Value

0343

1.000

1.000

1.000
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Roundabout Analysis
Intersection-level inputs:

¢ Inscribed Circle Diameter (ICD)

o Number of legs: different crash prediction models are applied for 3-leg or 4-leg intersections

e Max. number of circulating lanes: different crash prediction models are applied to one or two circulating
lanes; hybrid roundabouts mixed circulating lanes (one or two) are always analyzed as two circulating lanes

Leg-level inputs:

Number of entering lanes
Number of circulating lanes
Number of exiting lanes
Entry width

Circulating width

Posted speed limit
Entering AADT

Circulating AADT

Exiting AADT

Note: The Highway Safety Software implements the “Design Level” crash prediction model for roundabouts. NCHRP
Report 888 also developed a planning-level method, which is not included in the software.

Method Type

For urban intersections, there are different method types available for calculations. The method types include:
General, Six or More Lanes, One-Way, and High-Speed. The General methodology can be found in Chapter 12 of
the Highway Safety Manual. The Six or More Lanes methodology can be found in Chapter 6 of NCHRP 17-58. The
One-Way methodology can be found in Chapter 8 of NCHRP 17-58. The High-Speed methodology can be found in
Chapter 5 of NCHRP 17-68.

The following inputs help indicate which method type will be used:

e Number of Through Lanes on Major Street

o If the number of lanes is 5 or less, the method type used will be General. If the number of lanes is
6 or more, the method type used will be Six or More Lanes. If ‘Is Major Street One-Way?’ is
checked, the method type used will be One-Way and the number of through lanes on major street
will have no influence on the method type used.

e |Is Major Street One-Way

o A checkbox is provided to indicate whether or not the major street is one-way. If checked, the
method used will be One-Way.

e Major-Street Posted Speed

o A drop-down selection is provided to indicate whether the posted speed is ‘Under 50 mi/h’ (or
‘Under 80 km/h’ in metric) or ‘50 mi/h and Over (or ‘80 km/h and Over’ in metric). If the posted
speed is under 50 mi/h (or 80 km/h in metric), the method type used will be General, Six or More
Lanes, or One-Way, depending on the other inputs previously mentioned. If the posted speed is 50
mi/h or over (or 80 km/h or over in metric), the method type used will be High-Speed.

Rural Facility Analysis

Once Rural Facility is selected as the Analysis Type, the user will be brought to the General page, which includes
sections for Project Description, Facility Data, and Parameters. The Project Description section includes general
information about the project, which include: Analyst, Agency, Date, Jurisdiction, Analysis Year, Project Description,
Empirical Bayes Analysis, and Number of Years of Observed Crashes. An Empirical Bayes (EB) Analysis checkbox
is provided for the user to indicate whether or not to use the EB analysis, which is a method used to combine
observed crash frequency data for a given site with predicted crash frequency data from many similar sites to
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estimate its expected crash frequency. Checking this will also enable the Number of Years of Observed Crashes
input on the General page and the Observed Crashes input on the Details page.

The Facility Data section includes a table that specifies details for individual sections within a rural facility. When a
new Rural Facility analysis is created, the table will have one row of section data already added to the table. The
user can choose to keep this section or delete it by selecting the row and clicking the button ‘Delete Section’. If
there are multiple rows of data the user wishes to delete, consecutive rows can be selected at a time and then
deleted together using the same button. To add a section, two buttons are provided: ‘Add Section’ and ‘Insert
Section’. ‘Add Section’ will add a new row of section data at the end of the table. ‘Insert Section’ will add a new row
of section data before the selected row. Before adding or inserting a section, the user can specify the Facility Type
and Section Type of the new section being added. The New Section Facility Types include: Rural Two-Lane and
Rural Multilane. The New Section Types include: Segment and Intersection. The row of data added to the table
includes: Section Type; Facility Type; Name; Model Type; AADT, veh/day; Length; Details; N(spf); and N(predicted).
Observed Crashes and N(expected) are also included in the table if Empirical Bayes Analysis is checked. Clicking
on Details will bring the user to the corresponding Details page. N(spf), N(predicted), Observed Crashes, and
N(expected) are determined by the inputs found on the Details page. Under the table, the total number of predicted
crashes, which is the summation of N(predicted) for all sections, is specified.

The Parameters section gives the option of using Project-Level Parameters or Section-Level Parameters. A
checkbox is provided to indicate this. If Project-Level Parameters is checked, the Parameters section on the General
page will include Segment Common Parameters and Intersection Common Parameters for Rural Two-Lane and
Rural Multilane facilities, along with corresponding crash distribution proportions; and Economic Analysis Common
Parameters if enabled. If Project-Level Parameters is not checked, only Economic Analysis Common Parameters
will display on the General page if enabled. Corresponding section-level parameters will display on the Details page
of each of the sections. For the list of parameters, please see Segment Analysis and/or Intersection Analysis.

Below is an example of the General page:

Project Description

Analyst Jurisdiction

Agency Analysis Year 2024
Date 9/21/2024 Project Description

Empirical Bayes Analysis O Number of Years of Observed Crashes

Facility Data

Map-Based Segmentation Add Section New Section Facility Type | Rural Multilane | New Section Type | Segment v

[ section Type Facility Type Name Model Type AADT, veh/day Length, mi Details N(spf) N(predicted)

1 Segment Rural Two-Lane Two-Lane Undivided Segment (2U) 1000 1.000 0.267 0.267

2 Intersection Rural Two-Lane Four-leg, Minor-Stop (4ST) - 0.817 0.817

3 Segment Rural Multilane Divided 1000 1.000 0.169 0.169

4 Intersection Rural Multilane Four-leg, Minor-Stop (4ST) = - Details 0.348 0.348

The total number of predicted crashesis: 1.601
Parameters
Project-Level Parameters

(») Segment Common Parameters
(®) Rural Two-Lane

(®) Rural Multilane
Undivided  Divided
Calibration Factor, C 1.00 1.00
Proportion of Related Crashes, Pra 0.270 0.500
Proportion of Nighttime Crashes that Involve a Fl, Pinr 0.361 0.323
Proportion of Nighttime Crashes that Involve PDO, Ppnr 0.639 0.677
Proportion of Crashes for Unlighted Segment that Occur at Night, Pnr -~ 0.255 0.426

On the Details page, three sections are provided: Section Data, Input, and Output. If Project-Level Parameters is
not checked on the General page, a fourth section (Parameters) will appear on the Details page after the Input
section. Section Data allows the user to select which section details to display. It also specifies the Facility Type,
Section Type, and Model Type of the section. Inputs available are based on the Facility Type, Section Type, and
Model Type selected. Section-level parameters display in the Parameters section according to the Facility, Section,
and Model Type of the section displayed. Outputs include the Safety Performance Function (SPF), the various
Crash Modification Factors (CMFs), and the Predicted Crash Frequency (Npredicted)-
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Below is an example of the Details page for a Rural Multilane Facility Type, Segment Section Type, and Divided
Model Type combination, with Empirical Bayes Analysis checked and Project-Level Parameters not checked on the
General page:

Section Data
Section 3> v Facility Type Rural Multilane
Section Type Segment Model Type Divided

Input

AADT, veh/day 1000 Length, mi 1.000
Lane Width, ft 120 Paved Right Shoulder Width, ft 8.0
Automated Speed Enforcement O Median Barriers
Lighting O
Observed Crashes Fl 0 Observed Crashes PDO 0

User-Defined CMFs
Add User-Defined CMF Delete User-Defined CMF

CMF Name CMF Description CMF Type  CMF Value

Parameters

©)

Output
Safety Performance Function (SPF) 0.169 Predicted Crash Frequency (Npredicted) 0.169
CMF1 (Lane Width) 1.000 CMF2 (Shoulders) 1.000
CMF3 (Median Width) 1.000 CMF4 (Lighting) 1.000

CMF5 (Automated Speed Enforcement) 1.000

Urban Facility Analysis

Once Urban Facility is selected as the Analysis Type, the user will be brought to the General page, which includes
sections for Project Description, Facility Data, and Parameters. The Project Description section includes general
information about the project, which include: Analyst, Agency, Date, Jurisdiction, Analysis Year, Project Description,
Empirical Bayes Analysis, and Number of Years of Observed Crashes. An Empirical Bayes (EB) Analysis checkbox
is provided for the user to indicate whether or not to use the EB analysis, which is a method used to combine
observed crash frequency data for a given site with predicted crash frequency data from many similar sites to
estimate its expected crash frequency. Checking this will also enable the Number of Years of Observed Crashes
input on the General page and the Observed Crashes input on the Details page.

The Facility Data section includes a table that specifies details for individual sections within an urban facility. When
a new Urban Facility analysis is created, the table will have one row of section data already added to the table. The
user can choose to keep this section or delete it by selecting the row and clicking the button ‘Delete Section’. If
there are multiple rows of data the user wishes to delete, consecutive rows can be selected at a time and then
deleted together using the same button. To add a section, two buttons are provided: ‘Add Section’ and ‘Insert
Section’. ‘Add Section’ will add a new row of section data at the end of the table. ‘Insert Section’ will add a new row
of section data before the selected row. Before adding or inserting a section, the user can specify the Section Type
of the new section being added. The New Section Types include: Segment and Intersection. The row of data added
to the table includes: Section Type; Facility Type; Name; Model Type; AADT, veh/day; Length; Details; N(spf); and
N(predicted). Observed Crashes and N(expected) are also included in the table if Empirical Bayes Analysis is
checked. Clicking on Details will bring the user to the corresponding Details page. N(spf), N(predicted), Observed
Crashes, and N(expected) are determined by the inputs found on the Details page. Under the table, the total number
of predicted crashes, which is the summation of N(predicted) for all sections, is specified.

The Parameters section gives the option of using Project-Level Parameters or Section-Level Parameters. A
checkbox is provided to indicate this. If Project-Level Parameters is checked, the Parameters section on the General
page will include Segment Common Parameters and Intersection Common Parameters for an Urban facility, along
with corresponding crash distribution proportions; and Economic Analysis Common Parameters. If Project-Level
Parameters is not checked, only Economic Analysis Common Parameters will display on the General page.
Corresponding section-level parameters will display on the Details page of each of the sections. For the list of
parameters, please see Segment Analysis and/or Intersection Analysis.
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Below is an example of the General page:

Project Description

Analyst Jurisdiction

Agency Analysis Year 2024
Date 9/21/2024 Project Description

Empirical Bayes Analysis O Number of Years of Observed Crashes 1

Facility Data

Map-Based Segmentation Add Section New Section Type | Segment -

| section Type Facility Type Name Model Type AADT, veh/day Length, mi Details N(spf) N(predicted)
1 Segment Urban Two-Lane Undivided Segment (2U) 1000 1.000 Details 0228 0241
2 Intersection Urban Four-leg, Minor-Stop (4ST) - - Details 0330 0343
3 Segment Urban Three-Lane Segment Including a Center TWI 1000 1.000 Details 0.204 0218
4 Intersection Urban Four-leg, Signal (45G) - 0.160 0.162
5 Segment Urban Four-Lane Undivided Segment (4U) 1000 1.000 ils 0.178 0.184
6 Intersection Urban Three-leg, Minor-Stop (35T) - - Details 0.170 0.178
7 Segment Urban Four-Lane Divided Segment (4D) 1000 1.000 Details 0217 0235
8 Intersection Urban Three-leg, Signal (35G) - - Details 0.104 0.105
9 Segment Urban Five-Lane Segment Including a Center TWLT| 1000 1.000 Details 0535 0577
The total number of predicted crashes is : 2.243
Parameters
Project-Level Parameters
(®) segment Common Parameters
() urban
(@) Intersection Common Parameters
() urban

(®) Economic Analysis Common Parameters
Societal Crash Costs by Crash Severity

Fatal/Injury, $ 158200

Property Damage Only, $ 7400

On the Details page, three sections are provided: Section Data, Input, and Output. If Project-Level Parameters is
not checked on the General page, an extra section (Parameters) will appear on the Details page after the Input
section. If Empirical Bayes Analysis is checked on the General page, an extra section (Observed Crashes) will
appear on the Details page before the Output section. Section Data allows the user to select which section details
to display. It also specifies the Facility Type, Section Type, and Model Type of the section. Inputs available are
based on the Facility Type, Section Type, and Model Type selected on the General page. Section-level parameters
display in the Parameters section according to the Facility, Section, and Model Type of the section displayed.
Observed Crashes inputs are based on the Section Type selected. Outputs include the Safety Performance
Functions (SPFs), the various Crash Modification Factors (CMFs), and the Predicted Crash Frequencies.
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Below is an example of the Details page for an Urban Facility Type, Intersection Section Type, and Three Approach
Stop (3ST) General Model Type combination, with Empirical Bayes Analysis checked and Project-Level Parameters
not checked on the General page:

Section Data
Section 6> v Facility Type Urban
Section Type Intersection Model Type Three-leg, Minor-Stop (3ST)
Is Major Street One-Way? O Number of Through Lanes on Major Street 4
Is Minor Street One-Way? O Number of Through Lanes on Minor Street 2
Method Type General Major Street Posted Speed Under 50 mi/h
Input
AADT (maj), veh/day 1000 AADT (min), veh/day 1000
Approaches with Left-Turn Lanes 0 Approaches with Right-Turn Lanes 0
Lighting O
User-Defined CMFs
CMF Name CMF Description CMF Type  CMF Value
Parameters
©
Observed Crashes
Multiple Vehicle 0 Single Vehicle 0
Output
Safety Performance Function (SPF) 0.170 Predicted Crash Frequency (Npredicted) 0.178
CMF1 (Left-Turn Lanes) 1.000 CMF2 (Left-Turn Phases) 1.000
CMF3 (Right-Turn Lanes) 1.000 CMF4 (Right-Turn on Red) 1.000
CMFS5 (Lighting) 1.000 CMF6 (Red Light Running Cameras) 1.000

Freeway and Ramp Facility Analysis

Once Freeway and Ramp Facility is selected as the Analysis Type, the user will be brought to the General page,
which includes sections for Project Description, Facility Data, and Parameters. The Project Description section
includes general information about the project, which include: Analyst, Agency, Date, Jurisdiction, Analysis Year,
Project Description, Area Type, Empirical Bayes Analysis, and Number of Years of Observed Crashes. An Empirical
Bayes (EB) Analysis checkbox is provided for the user to indicate whether or not to use the EB analysis, which is a
method used to combine observed crash frequency data for a given site with predicted crash frequency data from
many similar sites to estimate its expected crash frequency. Checking this will also enable the Number of Years of
Observed Crashes input on the General page and the Observed Crashes input on the Details page.

The Facility Data section includes a table that specifies details for individual sections within a freeway facility. When
a new Freeway and Ramp Facility analysis is created, the table will have one row of section data already added to
the table. The user can choose to keep this section or delete it by selecting the row and clicking the button ‘Delete
Section’. If there are multiple rows of data the user wishes to delete, consecutive rows can be selected at a time
and then deleted together using the same button. To add a section, two buttons are provided: ‘Add Section’ and
‘Insert Section’. ‘Add Section’ will add a new row of section data at the end of the table. ‘Insert Section’ will add a
new row of section data before the selected row. Before adding or inserting a section, the user can specify the
Section Type of the new section being added. The New Section Types include: Segment and Intersection. The row
of data added to the table includes: Section Type; Facility Type; Name; Model Type; AADT, veh/day; Length;
Details; N(spf); and N(predicted). Observed Crashes and N(expected) are also included in the table if Empirical
Bayes Analysis is checked. Clicking on Details will bring the user to the corresponding Details page. N(spf),
N(predicted), Observed Crashes, and N(expected) are determined by the inputs found on the Details page. Under
the table, the total number of predicted crashes, which is the summation of N(predicted) for all sections, is specified.
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The Parameters section gives the option of using Project-Level Parameters or Section-Level Parameters. A
checkbox is provided to indicate this. If Project-Level Parameters is checked, the Parameters section on the General
page will include Segment Common Parameters and Intersection Common Parameters for Freeway Segment and
Ramp Segment, and Speed Change Lanes and Ramp Terminal, respectively; and Economic Analysis Common
Parameters. If Project-Level Parameters is not checked, only Economic Analysis Common Parameters will display
on the General page. Corresponding section-level parameters will display on the Details page of each of the
sections. For the list of parameters, please see Segment Analysis and/or Intersection Analysis.

Below is an example of the General page:

Project Description

Analyst Jurisdiction

Agency Analysis Year 2024
Date 9/21/2024 Project Description

Empirical Bayes Analysis O Number of Years of Observed Crashes 1
Area Type Rural ¥

Facility Data

Ramp | New Section Type |Ramp Segment ~

Section Type Facility Type Name Model Type AADT, veh/day Length, mi Details N(spf) N(predicted)
1 Freeway Segment | Freeway Freeway Segment 1000 1.000 Details - 0292
2 Speed Change Lanes | Freeway Speed Change Lanes 1000 1.000 0,026

3 Ramp Segment Ramp Ramp Segment 1000 1.000 Details = 0304

4 Ramp Terminal Ramp Signal-Controlled - - Details - 0.765

The total number of predicted crashesis: 0.292
Parameters
Project-Level Parameters

() Segment Common Parameters
() Freeway Segment

Calibration Factor for Multiple-Vehicle Fatal-and-Injury Crashes, Cmvfi 1.00
Calibration Factor for Multiple-Vehicle Property-Damage-Only Crashes, Cmv,pdo 1.00
Calibration Factor for Single-Vehicle Fatal-and-Injury Crashes, Csv,fi 1.00
Calibration Factor for Single-Vehicle Property-Damage-Only Crashes, Csv,pdo 1.00

(® Ramp Segment

() Intersection Common Parameters
() speed Change Lanes
(%) Ramp Terminal

(®) Economic Analysis Common Parameters

On the Details page, three sections are provided: Section Data, Input, and Output. If Project-Level Parameters is
not checked on the General page, an extra section (Parameters) will appear on the Details page after the Input
section. If Empirical Bayes Analysis is checked on the General page, an extra section (Observed Crashes) will
appear on the Details page before the Output section. Section Data allows the user to select which section details
to display. It also specifies the Facility Type, Section Type, and Model Type of the section. Inputs available are
based on the Facility Type, Section Type, and Model Type selected on the General page. Section-level parameters
display in the Parameters section according to the Facility, Section, and Model Type of the section displayed.
Observed Crashes inputs are based on the Section Type selected. Outputs include the Safety Performance
Functions (SPFs), the various Crash Modification Factors (CMFs), and the Predicted Crash Frequencies.

22 - Highway Safety Highway Safety Software User Guide



Below is an example of the Details page for a Freeway Facility Type, Speed Changes Lanes Section Type, and
Speed Change Lanes Model Type combination, with Empirical Bayes Analysis checked and Project-Level
Parameters not checked on the General page:

Section Data

Section 2> v Facility Type Freeway
Section Type Speed Change Lanes Model Type Speed Change Lanes
Input
AADT, veh/day 1000 AADT Volume of Ramp (AADTY), veh/day 1000
Length of Ramp Entrance, mi 1.000 Ramp Type Entrance v
Primary Direction Lanes 3 Secondary Direction Lanes 3
Include Horizontal Curves O Is Left Side Ramp O
Lane Width (WI), ft 120 Median Width (Wm), ft 60
Inside Shoulder Width (Wis), ft 6 Distance from Inside Shoulder to Barrier (Wicb), ft 10.00
Proportion of Median Barrier Length (Pib) 0.000 Proportion of AADT during High Volume Hours (Phv) 0.000

User-Defined CMFs

CMF Name CMF Description CMF Type  CMF Value
Parameters
Observed Crashes
Fatal/Injury 0 Property Damage Only 0
Output
N (SPF, fi) 0.007 N (SPF, pdo) 0.019
CMF Combined (fi) 1.032 CMF Combined (pdo) 1.026
Predicted Crashes (fi) 0.007 Predicted Crashes (pdo) 0.019

Report

The report page shows a formatted version of the analysis in a dynamic form, reacting to changes in the General
and Details pages. All or a portion can be copied to the Windows clipboard for insertion into other files by right-
clicking into the report and selecting Copy.

Both formatted and text reports are available for viewing (through the Report tab or Print Preview) and printing. The
formatted report provides data and results that are most important to the user, and are displayed in a clean and
more presentable fashion. The text report provides more details to the user, rather than a summary. A drop-down
menu is provided for section selection for both formatted and text reports. Reports can be displayed based on the
specific individual section selected or all sections can be displayed together.
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How To

Create a New File

1. From the Start screen, there are three options for creating a new file:

4 Highway Safety Software

Start
>
New File... ‘

Open File... //‘—-
Example Folder... HSS
Recent
4 HSS2025

Ti rtation Institut
UF Gvianomoun | MICTFANS

Help

Topics

HSS Updates

HSS Overview
McTrans Website
HSM/HSS Training
E-mail McTrans

About HSS

HSS™ Version 2025

7 Copyright © 2024 University of Florida. All Rights Reserved.
Note: A new file can be created if an existing file is already open; you do not need to start from the Start
screen.

a. Selecting File > New from the main menu; this can be found by selecting the three lines in the top
left-hand corner of the screen, hovering over “New”, and then selecting one of the analysis types.
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4 Highway Safety Software

‘

Ctrl+N »|| | Segment

Intersection/Speed Change Lanes
Rural Facility
Urban Facility

New

Open Ctri+0
Example Folder

g Freeway and Ramp Facility
Save As.
Close Ctrl+W Hel,
el
Units v 1 .P
"~ opics
Print trl+P ‘
Print P Ctrl+F2 HSS Updates
i / :
View » — HSS Overview
S , HSS McTrans Website
Parameter Template > HSM/HSS Training
Export to CSV E-mail McTrans
Default Settings Alt+F
= About HSS
Help 4
Exit Alt+F4

Transportation lnstikule‘ M 7_
UF [ienomounn  MCTrans
Copyright © 2024 University of Florida. All Rights Reserved. HSS™ Version 2025

b. Selecting “New File...” from the Start screen; this can be found below in the red box. A Select New
File Type dialog box will pop up after selecting “New File...” which allows you to choose the desired
analysis type.

4 Highway Safety Software = a X

Start Help
Skl = HSS Updates
Eramale foldar. HSS HSS Overview
Recent McTrans Website

HSM/HSS Training

-mail McTran:

About HSS

4 HSS2025
e MlCTFANS 4

Copyright © 2024 University of Florida. All Rights Reserved. HSS™ Version 2025

c. Using the keyboard shortcut “Ctrl+N”, selecting one of the analysis types from the Select New File
Type dialog box, and clicking “OK”

4 Select Analysis Type X

(® Segment

O Intersection/Speed Change Lanes
O Rural Facility

O Urban Facility

O Freeway and Ramp Facility
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Once a new f|Ie is created, you will be brought to the General page of the selected analysis type

Project Description

Analyst Jurisdiction

Agency Analysis Year 2024

Date 9/21/2024 Project Description

Empirical Bayes Analysis O Number of Years of Observed Crashes 1

Facility Data
New Section Facility Type ' Rural Two-Lane v New Section Type | Segment v
Section Type Facility Type Name Model Type AADT, veh/day Length, mi Details N(spf) N(predicted)
1 Segment | Rural Two-Lane | [Two-Lane Undivided Segment (2u) ] 1000 1.000 Details 0267 |o267 |
The total number of predicted crashesis: 0.267
7EEN Parameters s\
“\\/,/' Project-Level Parameters O '\?//
Back Next

HSS™ Version 2025 (USC)

Copyright © 2024 University of Florida. All Rights Reserved.

Open an Existing File

From the Start screen, there are six options for opening an existing file:

4 Highway Safety Software

& HSS2025
UF 'McTrans

Transportation Institute
UNIVERSITY of FLORIDA

Start ) Help

Open File... //; HSS Updates
Example Folder... HSS HSS Overview
Recent McTrans Website

HSM/HSS Training

E-mail McTrans

About HSS

Copyright © 2024 University of Florida. All Rights Reserved. HSS™ Version 2025

Note: A file can be opened even if another file is currently open; you do not need to start from the Start
screen.
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Parameter Template
Export to CSV

Default Settings Alt+F
Help
Exit Alt+F4

Transportation Institute
UNIVERSITY of FLORIDA

& HSS2025

IMcTrans

a. Selecting File > Open from the main menu; this can be found by selecting the three lines in the top
left-hand corner of the screen and then selecting “Open”
% Highway Safety Software = a X
New Ctrl+N »
[ Open Ctrl+O
Example Folder
Save Ctrl+S
Save As. F12
Close Ctrl+W
Units. } HEIP
"~ Topics
Print Ctrl+P (7
Print Preview Ctrl+F2 /‘_ st lladiies
e a— HSS Overview
Report HSS McTrans Website

HSM/HSS Training

E-mail McTrans

About HSS

Copyright © 2024 University of Florida. All Rights Reserved. HSS™ Version 2025 (USC)

b. Selecting “Open File...” from the Start screen; this can be found below in the red box

% Highway Safety Software

Copyright © 2024 University of Florida. All Rights Reserved.

Transportation Institute
UNIVERSITY of FLORIDA

Start }
-
New File,.. 7
== -
Example Folder.. HSS
Recent

& HSS2025

\McTrans

Help

Topics

HSS Updates

HSS Overview
McTrans Website
HSM/HSS Training
E-mail McTrans
About HSS

HSS™ Version 2025

c. Using the keyboard shortcut “Ctrl+O”
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d. Selecting a file under the Recent files list from the Start screen; this can be found below in the red

box

% Highway Safety Software = [m] X

Start Help
New File... j Topics

. = HSS Updates
Example Folder.. HSS HSS Overview
Recent McTrans Website
HSS$10-1 RuralTwolan... HSM/HSS Training
HSS11-1_RuralMultila... E-mail McTrans
HSS12-1_UrbanThreel... About HSS
HSS518-1 TangentSixL...

HSS19-1 OnelaneUrb...

4 HSS2025
T 5 tati Institut
UF e | McTrans

Selecting File > Example Folder from the main menu; this can be found by selecting the three lines
in the top left-hand corner of the screen and then selecting “Example Folder”. Opening the example
folder will open the path of the HSS exampile files in File Explorer. The desired example file can be
double-clicked or right-clicked and selecting ‘Open’, which will open the example file in the Highway
Safety Software program.

%

% Highway Safety Software = o X
New Ctrl+N »
Open Ctrl+O

Example Folder

Save
Save As. F1

Close W "
Units > ::le'p
- opIcs
Print Ctrl+P e
Ctrl+F2 / HSS Updates

Print Preview

View » — HSS Overview
Report » H SS McTrans Website
Parameter Template » HSM/HSS Training
Export to CSV E-mail McTran
Default Settings Alt+F "
Help » About HSS
Exit Alt+F4

& HSS2025

Transportation Institute ‘ M 7_
UF ‘ UNIVERSITY of FLORIDA c rans
Copyright © 2024 University of Florida. All Rights Reserved. HSS™ Version 2025 (USC)

Selecting “Example Folder...” from the Start screen; this can be found below in the red box.
Opening the example folder will open the path of the HSS example files in File Explorer. The desired
example file can be double-clicked or right-clicked and selecting ‘Open’, which will open the
example file in the Highway Safety Software program.
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% Highway Safety Software = o X

Start Help
New File... ] " Topics

Open File... —_ HSS Updates

Example Folder... HSS HSS Overview

Recent McTrans Website
HSM/HSS Training
E-mail McTrans
About HSS

& HSS2025
UF Covrememoan: | MCTrans

Copyright © 2024 University of Florida. All Rights Reserved. HSS™ Version 2025

2. Once an existing file is opened, you will be brought to the General page

4 HS$10-5_RuralTwoLaneFacility.xhz - Highway Safety Software - o 54

=  START GENERAL DETAILS REPORT @

Project Description

Analyst Jurisdiction
Agency Analysis Year 2024
Date 9/9/2024 Project Description HSM Chapter 10: Sample Problem 5
Empirical Bayes Analysis Number of Years of Observed Crashes 1
Facility Data
Map-Based Segmentation New Section Facility Type | Rural Two-Lane ¥ New Section Type ' Segment v
Section Type Facility Type Name Model Type AADT, veh/day  Length, mi Details Observed Crashe N(spf) N(predicted) N(expected)
1 Segment Rural Two-Lane Two-Lane Undivided Segment (2U) | 10000 1.500 Details 10 4.008 6.106 8.010
2 Segment Rural Two-Lane Two-Lane Undivided Segment (2U) |8000 0.100 Details 2 0214 0.527 1343
/k\ 3 Intersection Rural Two-Lane |Three-leg, Minor-Stop (35T) E = Details 3 1.868 2.847 2.940 e
— /
& i ( \
\ e/’ The total number of predicted crashes is: 9.480 \ —) )
oL N,
Back Parameters Next
Project-Level Parameters O

Copyright © 2024 University of Florida. All Rights Reserved. HSS™ Version 2025 (USC)

3. Note: HSS can open both HSS files (*.xhz) and HCS Freeways/Highways (*.xuf) files. By default, the Open
dialog will display HSS files (*.xhz). To open Freeways/Highways (*.xuf), please change the file type in the
Open dialog. If opening a Freeways/Highways file, HSS will convert any relevant Freeways/Highways inputs
to the corresponding HSS inputs. It is recommended to review inputs for accuracy.
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[ % Open X
& > v N « HCS.. > Exam.. > v C Search Example L
Organize ~ New folder =- 0 0

My Doc-To-He # Name Date modified
HCS * Alternative Intersections 9/9/2024 1:43 PM
HSS » Network 9/9/2024 1:43 PM
TSIS-CORSIM # Streets Reliability 9/9/2024 1:43 PM
HCM » F Basic1-FourLaneFreeway.xuf 11/9/2023 1:02 PM
(g Basic2-TargetLOS.xuf 11/9/2023 1:02 PM
HSM »
 Basic2-TargetlOS-Design.xuf 11/9/2023 1:02 PM |
Pey F Basic3a-SixLaneFreewaysPresent.xuf 11/9/2023 1:02 PM |
< UFL Dropbox > : |
§ Basic3b-SixLaneFreewayFuture.xuf 11/9/2023 1:02 PM
O This PC * Basic5-MixedFlow.xuf 11/9/2023 1:02 PM
h Network 7 Basic6-SevereWeather.xuf 11/9/2023 1:03 PM
§ Basic7a-ManagedLane1.xuf 11/9/2023 1:03 PM
File name: ‘ v | HCS Freeways/Highways Files (*.xuf) | '
HSS Files (*.xhz)
HCS Freeways/Highways Files (*.x

Save a File

1. There are five options for saving an open file:

a. Selecting File > Save from the main menu; this can be found by selecting the three lines in the top
left-hand corner of the screen and then selecting “Save”

4 HSS1.xhz* - Highway Safety Software

4
=  START GENERAL DETAILS REPORT

New CtrlsN » Project Description
Open Siiie) Jurisdiction
Example Folder
Save s Analysis Year 2024
-

Save As... F12 9/21/2024 Project Description
Close Ctrl+W O Number of Years of Observed Crashes 1

= & T
ot Facility Data
Print Ctrl+P . . .
Prink Preview Ctrl+F2 New Section Facility Type | Rural Two-Lane v New Section Type | Segment v
View L ‘ Name Model Type AADT, veh/day Length, mi Details N(spf) N(predicted)
Report Lne | [Fwo-Lane Undivided Segment (2) | 1000 1.000 Details 0.267 0267
Parameter Template » The total number of predicted crashes is: 0.267
Export to CSV Parameters @
Default Settings Alt+F O Next
Help 4
Exit Alt+F4

Copyright © 2024 University of Florida. All Rights Reserved. HSS™ Version 2025 (USC)
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b. Selecting File > Save As... from the main menu; this can be found by selecting the three lines in
the top left-hand corner of the screen and then selecting “Save As...”

4 HSS1.xhz* - Highway Safety Software - o $%
= START GENERAL DETAILS REPORT @
New Ctri+N Project Description
Ppen Gigier Jurisdiction
Example Folder
Save Ctri+s Analysis Year 2024
7 rl+
{ Save As... F12 9/21/2024 Project Description
Close Ctrl+W O Number of Years of Observed Crashes 1
i > e
tnits Facility Data
Print Ctrl+P ) .
Prit Preview PSPPI /d section New Section Facility Type ' Rural Two-Lane v New Section Type | Segment
View > Name Model Type AADT, veh/day Length, mi Details N(spf) N(predicted)
Report ) Ine | ‘Two'Lane Undivided Segment (2U) |moo 1.000 Details 0.267 |0.267
Parameter Template » The total number of predicted crashes is : 0.267 —
—
Export to CSV Parameters 7
Default Settings Alt+F O Next
Help >
Exit Alt+F4
Copyright © 2024 University of Florida. All Rights Reserved. HSS™ Version 2025 (USC)

c. Using the keyboard shortcut “Ctrl+S” for Save
d. Using the keyboard shortcut “F12” for Save As

e. Exiting the program or closing the file without saving changes beforehand; this will prompt you to
save changes to the file before anything is closed

Highway Safety Software

{ Save changes to HSS1.xhz?
@ s

Yes | No Cancel

i. Selecting “Yes” will save the file if it is an existing file. If the file has not been previously
saved, the Save As dialog box will pop up allowing you to change the file name and save
it.

ii. Selecting “No” will exit the program or close the file without saving the file
iii. Selecting “Cancel” will prevent the file from closing

Note: Using Save with an existing file will save a file without prompting you to specify a file name. Using Save with
a new file will bring up the Save As dialog box for you to specify a file name for saving. Using Save As will always
bring up the Save As dialog box for you to specify a file name for saving.
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Close a File

1. There are three options for closing an open file:

a. Selecting File > Close from the main menu; this can be found by selecting the three lines in the top
left-hand corner of the screen and then selecting “Close”

4 HSS10-5_RuralTwoLaneFacility.chz - Highway Safety Software - o x
= START GENERAL DETAILS REPORT ®
New Ctrl+N > Project Description
Open CHEO Jurisdiction
Example Folder
Analysis Year 2024
Save ctil+s
Save As... F12 9/9/2024 Project Description HSM Chapter 10: Sample Problem 5
_Close Ctrl+W. Number of Years of Observed Crashes 1
, g

i Facility Data
print cl+p i - )
e o New Section Facility Type | Rural Two-Lane ~| New Section Type | Segment ~
View > | Neme Model Type AADT, veh/day  Length, mi Details Observed Crashe N(spf) Nipredicted)  N(expected)
Report R [Two-Lane Undivided Segment (2U) | 10000 1.500 Details 10 4008 6106 8010

[Two-Lane Undivided Segment (2U) |8000 0.100 Details 2 0214 0527 1343

,
Pacmet=fiTemplate Three-leg, Minor-Stop (35T) - . [Details 3 1868 2847 2940
Export to CSV. \
The total number of predicted crashes is: 9.480 )
Default Settings Alt+F /
Parameters
Help »
[m]

Exit Alt+F4

b. Using the keyboard shortcut “Ctrl+W”

c. Exiting the program itself; please see How To: Exit the Program

Exit the Program

1. From the Start screen, there are three options for exiting the program:

% Highway Safety Software — [m] X

Start Help
New File... ‘/ Topics

Example Folder... HSS HSS Overview
Recent McTrans Website
HSM/HSS Training
E-mail McTrans
0 SS

& HSS2025
UF oo | MICTFANS

Copyright © 2024 University of Florida. All Rights Reserved. HSS™ Version 2025

Note: The program can be exited even if a file is still open; you do not need to start from the Start screen.
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a. Selecting File > Exit from the main menu; this can be found by selecting the three lines in the top
left-hand corner of the screen and then selecting “Exit”

% Highway Safety Software - o %
New Ctrl+N >

Open Ctrl+O
Example Folder

Save
Save As..

Close Ctrl+W Hel
el
Units » / I _P
"~ opics
Print Ctrl+P s
HSS Updates

Print Preview Ctrl+F2
View » /“— HSS Overview
Report , HSS McTrans Website
Parameter Template > HSM/HSS Training
EiEE E-mail McTrans
Default Settings Alt+F bout HSS
Help » About HSS
Exit Alt+F4

4 HSS2025 4

| Transportation Institute ‘ M 1_
W | UNIVERSITY of FLORIDA c rans
Copyright 2024 University of Florida. All Rights Reserved. HSS™ Version 2025 (USC)

b. Using the keyboard shortcut “Alt+F4”

c. Selecting “X” in the top right-hand corner of the screen; this can be found below in the red box
Highway Safety Software - (w]

i

Start } Help

New File.. 4 ‘, Topics

Open File... (:-'—_ HSS Updates

Example Folder... HSS HSS Overview

Recent McTrans Website
HSM/HSS Training
E-mail McTrans
About HSS

& HSS2025
oo | MICTTANS

Copyright © 2024 University of Florida. All Rights Reserved. HSS™ Version 2025
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Edit the Default Settings

1. From the Start screen, there are two options for editing the Default Settings:
4 Highway Safety Software — o X

Start Help
New File... ‘/ Topics

Open File... /4——' HSS Updates
Example Folder... HSS HSS Overview
Recent McTrans Website

HSM/HSS Training
E-mail McTran

About H

& HSS2025
Ti rtati Institute
UF oo | MCTrans

Note: The Default Settings can be changed even if an existing file is already open; you do not need to start
from the Start screen.

a. Selecting File > Default Settings from the main menu; this can be found by selecting the three lines
in the top left-hand corner of the screen and then selecting “Default Settings”

% Highway Safety Software — a X
New Ctrl+N »
Open Ctrl+O
Example Folder
Save
Save As...
Close trl+W Hel
e
Units ¥ T .P
- opIcs
Print trl+ ‘
Print Preview trl+F2 HSS Updates
: //_4— <
View > HSS Overview
Report , HSS McTrans Website
Parameter Template » HSM/HSS Training
Export to CSV E-mail McTran
Default Settings Alt+F
Help » About HSS
Exit Alt+F4
y
4 HSS2025 4

Transportation Institule‘ M 1—
UF UNIVERSITY of FLORIDA c rans
Copyright © 2024 University of Florida. All Rights Reserved. HSS™ Version 2025 (USC)

b. Using the keyboard shortcut “Alt+F4”
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2. Opening the Default Settings will cause a Default Settings window to pop up:

4

Analyst
Agency
Jurisdiction

Default Template

Reports
[C] Show Economic Results in Reports
Units

® ysc O Metric

ok | Cancel

3. You can specify Analyst, Agency, and Jurisdiction by clicking in the corresponding text boxes and typing
the desired text.

4. You are also given the option to specify a default parameters template. You can either click the ‘Default
Template’ button which will allow you to browse through files in an Open dialog box and select an HSS
Template File (*.xhzt) or you can type out the path of the file in the provided text box. Selecting a file through
the dialog box will automatically fill out the text box with the path of the file. For more information on the
Default Template, please see How To: Change Parameters.

5. Under ‘Units’, you are given the option of running the analysis in either U.S. Customary (USC) or SI (Metric)
units.

6. Clicking “OK” will save the changes made and close the Default Settings window; clicking “Cancel” will
close the Default Settings window without saving any changes.

7. When a new file is created, the Analyst, Agency, and Jurisdiction fields will automatically be populated with
the text specified in the Default Settings.

8. When a new file is created or an existing file is opened, the parameters from the default template selected
will be applied to the analysis.

9. When starting a new file, the inputs and results will display according to the units specified in the Default
Settings

Change Parameters

1. Parameters within HSS can be changed by editing individual fields or with the use of a Parameters
Template.

2. Individual Fields

a. To edit individual fields, you can access parameters either on the General page with Project-Level
Parameters or the Details page with Section-Level Parameters.

i. Project-Level Parameters

1. On the General page, there is a ‘Project-Level Parameters’ checkbox. Checking
this box will add the parameters to the General page where you can edit any of the
enabled fields. Note: Parameter fields are enabled/disabled depending on the
analysis type.
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15105 e

iy - 1Fghisy Salety Sutwere

[y =

START GENERAL DETAILS REPORT

Analyst
aqency Anslysis Yoar 1
Date arazz024 Projert Description HSH Chapter 16 Sample Prablem &
Empinsal Bayes Analyss Number of Years of Observed Crashes 2
e Type Urban
Facllity Data
T BT Froeesy ¢ NewSecion Type | frecwmy Segment ©
e e P iee N Modd ALy Lrhon Deials Olserved Crshe Nissl) [T T——
v (120300 2720 e 0 |- 2080 |1e1s |
[ren o e u i [ [ |
The toral number of precicie rashes fs - 44 646
arameter:
100
Crashes, Cinvpdo 100
Calibration Factar for Single-ehicle Fatal-and-Injury 100
Calibratian Factar for Single-Vehicle Property Damage-Only Crashes, Csvpda 100
Ramp Segrert
‘Calibraton Factor for Fatal-and-njury Crashes 100
calibratian Factor for Property-Damage-Only Crashes Cpda T

2. Corresponding parameters are applied to all the sections within the facility.

3. The Parameters section on the Details page is hidden when ‘Project-Level
Parameters’ is checked.

ii. Section-Level Parameters

1. On the Details page, there is a Parameters section. This section is only available
when ‘Project-Level Parameters’ on the General page is unchecked. If it is
checked, then the Parameters section on the Details page will be hidden.

1

T

START GEMERAL DETAILS REPORT

Pararneters

o x

User-Defined Chiks

Ml g

2. The parameters available in the Parameters section is dependent on the Facility
Type, Section Type, and Model Type of the current section displayed. Note: You
can switch between sections by selecting a different section using the Section drop
down menu on the Details page.

3. Parameters Template

a. Default Template in Default Settings
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To specify a default parameters template to use, a valid path must be provided in the
Default Template textbox within the Default Settings. This can be done by either selecting
the HSS Template File (*.xhzt) or typing out the path of the file in the textbox.

1. To select the template file, click the ‘Default Template’ button. An Open dialog box
will pop up allowing you to browse through files and select a template. Once
selected and opened, the Default Template textbox will automatically populate with
the path of the selected file.

& Default Settings
Analyst
Agency
Jurisdiction
Reports
[C1 Show Economic Results in Reports
Units
® usc O Metric
4 Open X
« v 4 > This PC > Desktop > HSS v O Search HSS
Organize ¥ New folder =~ O @
Name B Date modified Type Size
# Quick access
| Template1.xhzt 12/3/2021 10:08 AM XHZT File 97
&% Dropbox (Personal)
& Dropbox (UFL)
@ OneDrive
& This PC
W Network
< >
File name: | Template1.xhzt V] HSS Template Files (*xhzt) v
6’4 Default Settings
Analyst
Agency
Jurisdiction
\HSS\Template1.xhzt
Reports

[Z] Show Economic Results in Reports
Units

® usc O Metric
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2. When typing out the path itself, the full path must be specified, and it must be valid.

An

example

of a

parameters

C:\Users\UserName\Desktop\FileName.xhzt.

template

file

path

would

be

Once a default template file is specified in the Default Settings, the parameters within that
template will apply to all new files or to any changes made in existing files (e.g., adding

new sections).

b. View/Edit Template

To view or edit the parameters template, select File > Parameter Template > View/Edit
Template from the main menu; this can be found by selecting the three lines in the top left-
hand corner of the screen, hovering over “Parameter Template”, and then selecting
“View/Edit Template”.

4 HSS1xhz* - Highway Safety Software

= START GENERAL DETAILS REPORT

New Ctrl+N Project Description
Open Jurisdiction
Example Folder
e =ue Analysis Year 2024
Ve Ctri+s
Save As. 12 9/23/2024 Project Description
Close Crl+W [m] Number of Years of Observed Crashes 1
\nts Facility Data
Print Ctri+F " .
o e New Section Facilt Type | Rural TworLane ~| New Section Type | Segment
View > Name Model Type AADT.veh/day Length, mi Details Nispf) Nipredicted)
Report vie | [fwo-Lane Undivided Segment 2u) | 1000 1,000 Details 0267 |o2s7
Parameter Template V[T [View/edit emplate The total number of predicted crashes is : 0.267
Export to CSV/ Export Template Parameters
Default Settings Alt+F JmpoEiempisty
Help » meters
Exit AltsF4 b Severity
Fatal/Injury, 158200
Property Damage Only, $ 7400

g(J

Copyright © 2024 University of Florida. All Rights Reserved. HSS™ Version 2025 (USC)

When viewing or editing the parameters template, you are taken to the General page where
all existing parameters for all facility types, model types, and section types become

available to view and edit.

GENERAL

10 e

Project-Level Parameters |m}

(®) segment Common Parameters
(@) Rural Two-Lane

Calibration Factor, C 100
Proportion of Related Crashes, Pra 0574
Proportion of Nighttime Crashes that Involve a Fatality or Injury, Pinr 0.382
Proportion of Nighttime Crashes that Involve Property Damage, Ppnr 0618
Proportion of Crashes that Occur at Night, Pnr 0370
Proportion of Fatal 0013
< Proportion of Incapacitating Injury 0054
Proportion of Nonincapacitating Injury 0109
Proportion of Possible Injury 0145
Collision Type Total fl PDO

Single-Vehicle Crashes

Collision with Animal 0.121 0.038 0.184
Collision with Bicycle 0.002 0.004 0.001
Collision with Pedestrian 0.003 0.007 0.001
Overturned 0.025 0.037 0.015

Ran Off Road 0521 0.545 0.505

Copyright © 2024 University of Fiorida. All Rights Reserved.

Parameters

HSS™ Version 2025 (USC)

Other pages become disabled, and you can no longer navigate to other pages to make
edits to inputs. Viewing or editing of the parameters template must be completed before

editing other inputs.
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iv. To finish viewing or editing the parameters template, select File > Parameter Template >
To Normal Mode from the main menu; this can be found by selecting the three lines in the
top left-hand corner of the screen, hovering over “Parameter Template”, and then selecting
“To Normal Mode”. Note: This option only becomes available when in the middle of viewing
or editing the parameters template.

4 HSS1xhz* - Highway Safety Software = [=] X
H GENERAL o

New Ctrl+N » Parameters

Open Ctri+0 [m]

Example Folder

Save Ctrl+S

Save As... F12

1.00

Close Ctri+W

Uniits , rashes, Pra 0574

Print Ctrl+P = Crashes that Involve a Fatality or Injury, Pinr ~|0.382

Print Preview Ctrl+F2

2 Crashes that Involve Property Damage, Ppnr 0618

View »

Report , hat Occur at Night, Pnr 0370

Parameter Template » [ [ 7o Normal Mode | 0013

Export to CSV Export Template = ; ;;\

Default Settings Alt+F Import Template \%7)

Jacitating Injury 0109 -
Help »
Bxit AltsFg IOV oS
Collision Type Total Fl PDO

Single-Vehicle Crashes

Collision with Animal 0.121 0.038 0.184
Collision with Bicycle 0.002 0.004 0.001
Collision with Pedestrian 0.003 0.007 0.001
Overturned 0.025 0.037 0.015

Ran Off Road 0.521 0.545 0505
Ath e Cinnin Vabicln Callicinn Y Ann7 Anaa

Copyright © 2024 University of Florida. All Rights Reserved. HSS™ Version 2025 (USC)

c. Export Template

i. Editing the parameters template is necessary before exporting if you want to export
parameters other than the default HSM/HSS parameters.

ii. To export the parameters into a template, select File > Parameter Template > Export
Template from the main menu; this can be found by selecting the three lines in the top left-
hand corner of the screen, hovering over “Parameter Template”, and then selecting “Export

Template”
4 HSS1.xhz* - Highway Safety Software - o X
=  START GENERAL DETAILS REPORT [ ]
New Ctrl+N > Project Description
Opeit Eaie Jurisdiction
Example Folder
By e Analysis Year 2024
Ctrl+
Save As. F12 9/23/2024 Project Description
Close Ctrl+W O Number of Years of Observed Crashes
»
il Facility Data
Print Ctrl+P ) -
i P i New Section Facility Type | Rural Two-Lane v| New Section Type | Segment v
View » Name Model Type AADT, veh/day Length, mi Details Nespf) N(predicted)
Report ) e | [Four-leg, Minor-stop (4sT) - - Details 0.817 0817
2 ! F—"ne Undivided Segment (2U) 1000 1000 Detals 0267 0267
Parameter Template > View/Edit Template

D Signal (456) = = Details 1486 1486
Sroitio ol J[EPDIEIEmplate ine Undivided Segment (2U) 1000 1.000 Details 0267 0267

Import Template

Default Settings Alt+F leg, Minor-Stop (35T) - - Details 0361 0361
Help » e [Two-Lane Undivided Segment (2U) 1000 1.000 Details 0267 0.267 Next
= Aters e [Three-leg, Signal (35G) - - Details 0571 0571

s oeymene [rurartwo-cdne [Two-Lane Undivided Segment (2U) 1000 1,000 Details 0.267 0267

9 Intersection Rural Two-Lane Roundabout (R) - - Details 0848 0729

The total number of predicted crashesis: 5.034
Parameters
Project-Level Parameters [m]

() Economic Analysis Common Parameters
Societal Crash Costs by Crash Severity

Fatal/Injury, § 158200

Property Damage Only, $ 7400

Copyright © 2024 University of Florida. All Rights Reserved. HSS™ Version 2025 (USC)
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ii. This will open a Save As dialog box allowing you to specify a name for saving the template

file (*.xhzt).
& SaveAs X
4+ > ThisPC > Desktop > HSS v O Search HSS
Organize ¥ New folder = 0

Name Date modified Type Size
# Quick access

3/2021 10:08 AM XHZT File

Template1.xhzt
& Dropbox (Personal)

&% Dropbox (UFL)
@ OneDrive
= This PC

@ Network

<

File name: | HSS1.xhzt

Save as type: 'HSS Template Files (*.xhzt)

~ Hide Folders Cancel

iv. Once a file name is specified, click the Save button. Note: The default template file name
is the name of the HSS file with the template file extension (*.xhzt) but can be overwritten.

v. The template file will be saved in the folder you specified when saving.

% = | HSS = o X
- °
« v 4 > ThisPC > Desktop > HSS v O S: HS!
Name ) Date modified Type size
s Quick access
HSS1.xhzt

& Dropbox (Personal) Template1.xhzt
33 Dropbox (UFL)
@ OneDrive

% This PC

&b Network

2items  1item selected 96.6 KB

d. Import Template
i. Importing a parameters template file requires access to an already saved template file
(*.xhzt).
ii. To import parameters from a template, select File > Parameter Template > Import

Template from the main menu; this can be found by selecting the three lines in the top left-
hand corner of the screen, hovering over “Parameter Template”, and then selecting “Import

Template”.
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4 HSS1.xhz” - Highway Safety Software

= START GENERAL DETAILS REPORT

New Ctrl+N » Project Description
Open Ctri+0 Jurisdiction
Example Folder
Analysis Year 2024
Save ctrl+s v
Save As. F12 9/23/2024 Project Description
Close Ctri+W. ] Number of Years of Observed Crashes 1
> =
Units Facility Data
Print Ctrl+P N N
e Gt New Section Facility Type | Rural Two-Lane v| New Section Type  Segment ~
View , Name Model Type AADT, veh/day Length, mi Details Nispf) Npredicted) |
Report vhe | [Four-leg, Minor-Stop (4sT) L - Details 0817 0817
T =" ne Undivided Segment (2U) 1000 1,000 Details 0267 0267

[Farcmeteijlerplate ey EC e plate Ig.Signal 4561 - Detail 4% 1486
Export to CSV “‘ffﬂ"ﬂ?ﬂp'ﬂ? [ne Undivided Segment (2U) 1000 1000 Details 0.267 0267
Default Settings Alt+F Import Template leg. Minor-stop (35T) < 2 Details 0361 0361
Help » fne Two-Lane Undivided Segment (2U) 1000 1.000 0267 0.267
Bt [Three-leg, Signal (35G) = = 0571 0571

& oegmenc [Two-Lane Undivided Segment (2U) 1000 1.000 0.267 0.267

|9 Intersection ]Rmx Two-Lane [Roundabout (R) pmdus 0.848 0.729

Fatal/Injury, §

Project-Level Parameters [m]

() Economic Analysis Common Parameters

Societal Crash Costs by Crash Severity

158200

Property Damage Only, 7400

yright © 2024 University of Florida. All Rights Reserved.

The total number of predicted crashes is: 5.034
Parameters

HSS™ Version 2025 (USC)

iii. This will open an Open dialog box allowing you to select a template file (*.xhzt).

4 Open X
T > ThisPC > Desktop > HSS v O Search HSS
Organize ~ New folder - O @
Name Date modified Type Size
» Quick access
|| HSS1.xhzt 12/3/2021 2:07 PM XHZT File 97
»e
&* Dropbox (Personal) [7] Template1.xhzt 12/3/2021 10:08 AM XHZT File 97
&3 Dropbox (UFL)
@ OneDrive
% This PC
W Network
< >
File name: v ‘ HSS Template Files (*xhzt) X

iv. Once a file name is selected, click the Open button.

@ OneDrive
@ This PC

& Network

& Dropbox (Personal)

&3 Dropbox (UFL)

4 Open
T > ThisPC > Desktop > HSS
Organize New folder
Name
# Quick access .
|1 HSS1.xhzt

[ ] Template1.xhzt

v O O Search HSS

Date modified Type Size
12/3/2021 2:07 PM XHZT File 97
12/3/2021 10:08 AM XHZT File 97

File name: | Template1.xhzt

v} HSS Template Files (*xhzt) v

[ =

Highway Safety Software User Guide

How To - 41



v. The template file will be imported, and a message will pop up saying if the template was
imported successfully.

X

Template is imported successfully.

vi. The ‘Project-Level Parameters’ checkbox on the General page should now be checked, if
it was not already, and the parameters from the imported template file should be reflected
in the project-level parameters.

Export to CSV

1. To export data to a CSV file, select File > Export to CSV from the main menu; this can be found by selecting
the three lines in the top left-hand corner of the screen, and then selecting “Export to CSV”.

4 HSS12-9_UrbanFacilityWithCrashData.xhz - Highway Safety Software - B X

= | START GENERAL DETAILS REPORT

New Ctrl+N > Project Description
Open ctito Jurisdiction
Example Folder
Analysis Year 2024

Save Ctrl+S
Save As. F12 9/22/2024 Project Description HSM Chapter 12: Sample Problem 9
Close Ctrl+W Number of Years of Observed Crashes 1

) " o
bnits Facility Data
Print Ctrl+P -
AP . . New Secien e | Segment -
View » | Name Model Type AADT, veh/day  Length, mi Details Observed Crashe N(spf) N(predicted) ~ N(expected)
— } Three-Lane Segment Including a Cen| 11000 1,500 [Details 13 4274 7.043 10.759

Four-Lane Divided Segment (4D) ~ |23000 0750 Details 10 3.509 3.430 6733
Parameter Template > Three-leg, Minor-Stop (35T) - i Details 5 2.241 1.557 2.454
Export to CSV Four-leg, Signal (45G) E E Details 6 4324 2855 4091 N
; = — 2]
Detanlt Sctongs Allel The total number of predicted crashes is: 14.886 uey
Next

EEip > Parameters ‘
Exit Alt+F4

() segment Common Parameters

() urban
() Intersection Common Parameters
() urban

() Economic Analysis Common Parameters
Societal Crash Costs by Crash Severity

Fatal/Injury, $ 158200
Property Damage Only, $ 7400

Copyright © 2024 University of Florida. All Rights Reserved. HSS™ Version 2025 (USC)

2. When an analysis is exported to a CSV file, a Save As dialog box will pop up allowing you to specify a name
for saving the HCS CSV file (*.csv). Note: The default CSV file name is the name of the HSS file (*.xhz)
along with “-Results.csv” but can be overwritten.
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[ 4 Save As X

« > v oA > Downloads > HSS v G SearchHss »
Organize ~  New folder =- @
HCS » Name Date modified Type Size
HsS »
T No items match your search. |
HCM »
HSM » ‘
33 UFL Dropbox
I This PC
B8 Network
File name: | HSS12-9_UrbanFacilityWithCrashData-Results.csv ]|
Save as type: CSV file (*.csv) ~ 1
A Hide Folders Save Cancel

3. Once afile name is specified, click the Save button.

<« > v » Downloads » HSS v O Search H5S P
Organize = New folder =- @
HCs » Name Date madified Type Size
HSS »
No items match your search.
= TSIS-CORSIM # No items match your sears ‘
~ HCM »
HSM » ‘

33 UFL Dropbox
I This PC
4 Network

File name: | HS512-9_UrbanFacilityWithCrashData-Results.csv 2

Save as type: | CSV file (*.csv) ol

A Hide Folders Cancel

4. The CSV file of the analysis results will be saved in the folder you specified when saving.

HSS x [ - o X
€ ~e Q> Downloads > HSS Search HSS Q
® New % © B ® W N = View B Details
O Name Date modified. Type Size
@ Desktop » —
é DOciaES_# ’ii HSS12-9 L it shData-Result..  9/23/2024 2:11 PM Microsoft Excel Com... 1 KB

L Downloads #
My Doc-To-He #

HCS »
HsS »
TSIS-CORSIM #
HCM »
HSM »

33 UFL Dropbox
I This PC
&Sos(c)
= McTians Shared
=L@
= Dev (V)
8 Network

Titem  1item selected 803 bytes EL
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5. If you open the exported CSV file, the default program for CSV files will open.

<] fe}
File Home Insert Draw Pagelayout Formulas Data Review View Automate Help O Comments
Sy o v | = V] ti ing ¥ : % v B
LD X [rm——— i YA A = General [EH Conditional Formatting H Insert > v v @
“ v 9 v « | @ "
peste 1D B I Uville e A. = $ v % 9 [BiromatasTable EE Delete L Add-ins  Analyze  Send to
MR- 4 - = = - @4 58 i Cell Styles v [ Formatv @~ Data Nvivo
Clipboard Font & Alignment & Number 5] Styles Cells Editing Sensitivity Add-ins NVivo ¥
@ POSSIBLE DATA LOSS Some features might be lost if you save this workbook in the comma-delimited (.csv) format. To preserve these features, save it in an Excel file format. | Don't show again Save As... X
AL v i Jx~  section ~
A B © D E F G H | J K L M N o P Q R s T a
1 Section SPFFI SPFPDO N(pedr/pe N(biker/bil CMF Comt Predicted : Predicted Predicted Predicted Predicted Total PrediAverage O Average O Average O Expected (Expected (Expected (Total Expected Crash
2 1 1062 3212 0.09 0048 1616 1186 4984 0736  1.854 5189  7.043 4 7 2 2928 653  1.301  10.759
B 2 092 2589 0213  0.041 0905 0488 2538 015  1.087  2.343 3.43 3 6 1 1232 5204 0297 6733
4 3 0714 1527 0032  0.024 067 0234  1.267- 0534  1.023 1557 3 2- 0.818  1.636 - 2.454
5 4 1365 2959 0476  0.035 0542  0.161  2.183- 1251 1604  2.855 0 6- 0.152  3.939 - 4.091
6
7
8
9
10
1
12
13
14
15
16
17
18
19
20 v
HSS12-9_UrbanFacilityWithCrashD + HE | »
Ready % Accessibility: Unavailable i23 M -—F——+ 100%

6. Results from the HSS file (*.xhz) will be displayed in the CSV file. HSS currently only exports select outputs
from each analysis type.

Run an Empirical Bayes Analysis
1. Empirical Bayes Analysis, or EB Analysis, is a method used to combine observed crash frequency data for
a given site with predicted crash frequency data from many similar sites to estimate its expected crash
frequency.

2. To run an EB Analysis, the ‘Empirical Bayes Analysis’ checkbox on the General page must be checked.

4

START GENERAL DETAILS REPORT

Project Description

Analyst Jurisdiction

Agency Analysis Year 2024

Date 9/22/2024 Project Description HSM Chapter 12- Sample Problem 9
Empirical Bayes Analysis =) Number of Years of Observed Crashes 1

Facility Data

New Sacion Type. RN

SectionType  Facility Type Name Model Tyoe AADT, veh/day  Length, mi Detalls Observed Crashe N{spf) Mipredicted)  Nfexpected)
1 Segment Urban Three-Lane Segment Including a Cen| 11000 1.500 13 4274 7043 10758
| 2'segment Urban Four-Lane Divided Segment (4D)  [23000 0.750 0 3.509 3430 6733
| 3 Intersection Urban Threa-leg. Minar-Stop (35T} - 5 224 1.557 2454
& 4 Intersection Urban Four-leg, Signal (45G) Detai 6 4324 2855 4091 =
) e = —
The total number of predicted crashesis: 14.886 e
Bach Next
Parameters
Project-Level Parameters

(#) Segment Camman Parameters

(%) utban

(#) Intersection Commen Parameters

(%) urban

(%) Economic Analysis Common Parameters

University of Florida_ All Rights Reserved._ HSS™ Version 2025 (USC)
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3. Running an EB analysis will enable new fields:

a. ‘Observed Crashes’ in the table on the General page for facility analyses;

Note: Depending on the

4
=  START GENERAL DETAILS REPORT

Analyst
Agency

Date 9/22/2024
Empirical Bayes Analysis

Map-Based Segmentation

Project Description

Facility Data

New Secton Type: [ERERE

analysis type of the dataset, these field may be readable only.

Jurisdiction

Analysis Year 2024

Project Description HSM Chapter 12: Sample Problem 9

Number of Years of Observed Crashes 1

(%) Segment Comman Parameters

(%) urban
(#) Intersection Common Parameters

(3) urban

(%) Economic Analys's Comman Parameters

of Florida. All Rights Reserved.

Section Type  Facility Type Name Model Type AADT. veh/day  Length, mi Observed Crashe | Nispf) Mipredicted)  Nfexpected)

|1 Segment Urban [Three-Lane Segment Including & Cer] 11000 1.500 13 4074 7.043 10.759

|2 Segment Urban Four-Lane Divided Segment (4D)  [23000 0.750 o 3509 3430 6733

|3 Intersection Urban Three-leg, Minor-Stop (35T} E 5 2241 1.557 2454
(¢ |4 mtersection Urban Four-leg, Signal (456) Deto g 4324 2.855 4091
(&) —

4 The total number of predicted crashes is: 14.886
Parameters
Project-Level Parameters

HSS™ Version

b. ‘N(expected) in the table on the General page for facility analyses; Note: These fields are readable

only.

4

START GENERAL DETAILS REPORT

Analyst

Agency

Date 9/22/2024
Empirical Bayes Analysis

Project Description

New Section Type | Segment ~

Jurisdiction

Analysis Year 2024

Project Description HSM Chapter 12: Sample Problem 9

Number of Years of Observed Crashes 1

Facility Data

() segment Common Parameters
(%) Urban
(%) Intersection Common Parameters

(%) urban

() Economic Analysis Common Parameters

24 University of Florida. All Rights Res

Segmentation
Section Type  Facility Type Name Model Type AADT, veh/day  Length, m Details Observed Crashe Nispf} Nipredicted) | N{expected)
1 Segment Urban Three-Lane Segment Including a Cen] 11000 1500 13 4274 7043 10.759
2 Segment Urban Four-Lane Divided Segment (4D)  [23000 0750 10 3509 3430 6733
3 Intersecti Urban Thee-leg, Minor-Stop (35T) 5 2241 1557 2454
4 Intersection Urban Four-leg, Signal (45G) - - 6 4324 2855 4091 e
The total number of predicted crashes is :  14.886
Parameters

Project-Level Parameters
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c. Observed Crashes on the Details page; Note: Depending on the analysis type of the dataset, there
may be an Observed Crashes section with multiple fields.

& 118512-9 UrbanFacilityWitiC
START GENERAL DETAILS REPORT

AADT, veh/day 11000 Length, mi 1.500

Number of Major Commercial Driveways ] Number of Minor Commercial Driveways 10

Number of Major Industrial/Institutional Driveways ) Number of Minor Industrial/Institutional Driveways 3

Number of Major Residential Driveways 2 | Number of Minor Residential Driveways 15

Number of Other Driveways 0 Parking Type Paralie| Parking S
Curb Length of On-Street Parking for Both Sides of Road, mi 200 Road Type Commercial or Industrial/institutional ~
Roadside Fixed Objects Fixed-Object Offset, fi 3

Fixed-Object Density, abj /mi 10 | Median Barriers

Lighting Median Width, ft 15

Automated Speed Enforcement [m] Pasted Speed, mi/h 35

User-Defined CMFs o\
(—)

ik Name CME Description CHF Type  CMF Value

Observed Crashes !

Multiple Vehicle Nen Driveway 7 Multiple Vehicle Driveway 2
single Vehicle 4

QOutput
Safety Performance Functian (SPF) 4274 Predicted Crash Frequency (Npredicted) 7043
CMF1 (On-Street Parking) 1716 CMF2 (Roadside Fixed Objects) 1.008
CMF3 (Median Width) 1.000 CMF4 (Lighting) 0834
CMFS (Automated Speed Enforcement) 1.000

4. Running an EB analysis will add new sections and results to the reports:

a. ‘Expected Roadway Section Crashes’ in the formatted report
& 1S512-8 UrbanfacilityWith CrashDatad wiay Salety Soltware
=  START GENERAL DETAILS REPORT

Crash Modification Factors
On-Street Parking - CMF1 1.716 Lighting - CMF4 0.934
Roadside Fixed Objects - CMF2 1.008 Auto. Speed Enforcement - CMF5 1.000
Median Width - CMF3 1.000 Combined CMF 1616
Predicted Roadway Section Crashes
Crash Severity Predicted Crash Frequency Predicted Crash Rate (crashes/mifyear) Predicted Crash Rate
(crashes/year) (crashes/100M VMT)
Fatal and Injury (Fl) 1.854 1236 30.783
Property Damage Only (PDO) | 5.189 3.480 86.166
~ Total 7.043 4.635 116,949
\ _(f ‘ Expected Roadway Section Crashes
ik Crash Severity Expected Crash Frequency Expected Crash Rate (crashes/mi/year) Expected Crash Rate
(crashes/mi/year) (crashes/100M VMT)
Fatal and Injury (FI) 2832 1.888 47,023
Property Damage Only (PDO) | 7.927 5.285 131623
Total 10.759 7173 178.647
E iic Analysis (Expected Crashes)
Crash Severity Per Crash Societal Crash Cost Expected Annual Crashes Total Societal Crash Cost
Fatal and Injury (FI} $158,200.00 2.832 $448,018.69
Property Damage Cnly (PLO) $7,400.00 7.927 $58,659.97
Total - 10.759 $506,678.66
section | 1>
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b. ‘Expected Crashes’ in the text report

& 15512

= START GENERAL DETAILS REPORT

Rear-End Collision

Head-On Collision

Angle Collision

Sideswipe Collision, Same Direction
Sideswipe Collision, Opposite Dir
Other Multiple-Vehicle Collision
Total Multiple-Vehicle Crashes

8.845
2.834
.869
8.001
8.817
@.634
1.600

1.e13
a.241
@.083
a.ea1
8.820
@a.641
1.199

2.842
a.020
@.020
@.078
@.820
2.020
1.000

3.187
0.87¢6
@.e76
8.295
8.876
@.876
3.785

Total Observed Crashes (SV)

Average Observed Crashes (SV)
Overdispersion Parameter
Overdispersion Parameter (SV), k

Weighted Adjustment (SV), w
Expected Crashes (MV, Non-Driveway)
Expected Crashes (MV, Driveway)
Expected Crashes (SV)

Expected Crashes (FI)

Expected Crashes (PDO)

Total Expected Crashes

Total Observed Crashes (MV, Non-Driveway)
Total Observed Crashes (MV, Driveway)

Average Observed Crashes (MV, Non-Driveway)
Average Observed Crashes (MV, Driveway)

¢
Overdispersion Parameter (MV, Non-Driveway), k
(Mv, Driveway), k

Weighted Adjustment (MV, Non-Driveway), w
Weighted Adjustment (MV, Driveway), w

7
2
a

T

crashes/year

7.000
2.000
4.000
0.660
1.100
1.37@
0.233
9.553
@.381
6.530
1.301
2.928
2.832
7.927
10.759

crashes
crashes
crashes

crashes/mi/year crashes/18aM VMT

1.888 47.023
5.285 131.623
7.173 178.647

**Based on Expected Crash Frequency
Annual Societal Crash Cost (FI)
Annual Societal Crash Cost (PDQ)
Total Annual Societal Crash Cost

124 University of Florida. All Righls Reserved.

$448,018.69
$58,659.97
$586,678.66

Section 1> . E - +

HES™ Version 2025 (USC)

5. Economic analysis will be based on Expected Crash Frequency instead of Predicted Crash Frequency
when an EB analysis is run. Please see How To: Run an Economic Analysis.

Run an Economic Analysis

1. The Federal Highway Administration (FHWA) has completed research that established a basis for
quantifying, in monetary terms, the human capital crash costs to society of fatalities and injuries from

highway crashes

2. State and local jurisdictions often have accepted societal crash costs by crash severity and collision type.
When available, their locally-developed societal crash cost data are used with procedures in the HSM.

3. To run the economic analysis, it must first be enabled in the Default Settings. This can be done by checking
‘Show Economic Results in Reports’.

& Default Se

Analyst
Agency
Jurisdiction

Default Template

Reports
Show Economic Results in Reports

Units
® ysc O Metric
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4. On the General page of an analysis, Economic Analysis Common Parameters are provided. This includes

& 151

START GENERAL DETAILS REPORT

Societal Crash Costs by Crash Severity.

Project Description

Analyst Jurisdiction
Agency Analysis Year 2024
Date 9/17/2024 Project Description HSM Chapter 11: Sample Problem 4
Empirical Bayes Analysis Number of Years of Observed Crashes 1
Facility Data
New Section Faty Type  Rural Two-Lane | New Secton Type | Seqment =
Section Type Facility Type Name Maodel Type AADT, veh/day  Length, mi Details Observed Crashe  N(spf) Nipredicted) N(expected)
1 Segment Rural Multilane Divided 10000 1.500 4 2835 3308 3529
2 Segment Rural Multilane Undivided 8000 0.100 2 0.250 0.290 0.892
3 Intersection Rural Multilane Thiee-leg, Minor-Stop (35T} ] 0924 0927 1547

Project-Level Parameters
() Segment Cammon Parameters
(%) Rural Twa-Lane
() Rwral Multiane

() Intersection Common Parameters
(%) Rural Two-Lane
(%) rural Multilane

() Economic Analysis Common Parameters
Societal Crash Costs by Crash Severity

Fatal/Injury, $

Property Damage Only, $

158200

7400

2024 University of Florida. All Rights Reserved.

Parameters

The total number of predicted crashes is :

4525

HSS™ Version 2025 (USC)

a.
i.

Default Values
Fatal/Injury: $158,200
Property Damage Only: $7,400

An Economic Analysis in HSS is automatically run. However, you have the option of adjusting the cost of

fatal and injury (FI) crashes and property damage only (PDO) crashes by editing the monetary value in the
corresponding text boxes.

a.

On both the formatted and text reports, an Economic Analysis section is provided.

Formatted Report

START GENERAL DETAILS REPORT

Crash Modification Factors

Lane Width - CMF1 1.000 Lighting - CMF4 1.000
Shoulder Type/Width - CMF2 1.040 Auto, Speed Enforcement - CMFS 1.000
Median Width - CMF3 1.020
Combined CMF 1.061

Predicted Roadway Section Crashes

Crash Severity

Nsplas by Severity

Predicted Crash Frequency

Predicted Crash Rate

Predicted Crash Rate

(crashes/year) (crashes/mi/year) (crashes/100M VMT)
Fatal and Injury (FI) 1.480 1727 1.151 31,541
Property Damage Only (PDO) | 1.355 1.581 1.054 28.885
Total 2835 3.308 2.206 60.426

Expected Roadway Se:

ction Crashes

Crash Severity Average Observed | Weight | Expected Crash Frequency | Expected Crash Rate | Expected Crash Rate
Crashes (crashes/mifyear) {crashes/mi/year) (crashes/100M VMT)
Fatal and Injury (FI) 4.000 0.825 2125 1417 38.813
Property Damage Only (PDO) | 0.000 1.404 0.936 25.644
Total 4.000 0.680 3.529 2.353 64.457

Economic Analysis (Expected Crashes)

Crash Severity

Per Crash Societal Crash Cost

Expected Annual Crashes

Total Societal Crash Cost

Fatal and Injury (Fl) $158,200.00 2,125 $336,175.00
Property Damage Only (PDO) $7,400.00 1.404 $10,389.60
Total = 3.529 $346,564.60

Section | 1>
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b. Text Report

15511-4_RuralMultlaneFacility shz? - Highway Safety Soltware o x

4

START GENERAL DETAILS REPORT

Total Crashes Fatal-and-Injury Property-Damage-Only
Collision Type Prop. [ Prap. N Prop. [

Head-On 8.086 0.820 8.013 0022 a.882 a.ga3
Sideswipe 0.043 0.142 9.027 0.047 8.053 0.084
Rear-End 8.116 0.382 8.163 6.281 0.088 8.139
Angle 0.043 0.142 0.048 ©.083 2.841 8.865
single 8.768 2.541 0.727 1.255 0.792 1.253
Other 8.024 0.87% 6.022 6038 2.624  0.038

Total Observed Crashes 4 crashes
Total Observed Crashes (FI) a crashes
Total Observed Crashes (PDO) e crashes

crashes/year crashes/mi/year crashes/180M VMT
/ Average Observed Crashes 08
Average Observed Crashes (FI)
Average Observed Crashes (PDO)
Overdispersion Parameter, k
Overdispersion Parameter (FI), k
Weighted Adjustment, w
Weighted Adjustment (FI), w
Expected Crashes (FI)
Expected Crashes (PDO)
Tatal Expected Crashes

eo8
600
142
123
680
825
125 1.417 38.813
404 9.936 25.644
529 2.353 64.457

LURNSIO OO ® AR
®

**Based on Expected Crash Frequency

Annual Societal Crash Cost (FI) $336,175.00
Annual Societal Crash Cost (PDO) $18,389.68
Total Annual Societal Crash Cost $346,564.60

Section | 1>

7. The societal crash costs are based on either predicted crashes or expected crashes. This is dependent on
whether an EB analysis is run.

a. If ‘Empirical Bayes Analysis’ is unchecked on the General page, then the societal crash costs are
based on predicted crashes.

4 s relbtilan =

START GENERAL DETAILS REPORT

Project Description

Analyst Jurisdiction

Agency Analysis Year 2004

Date 9/17/2024 Project Description HSM Chapter 11: Sample Problem 4
Empirical Bayes Analysis ]| Number of Years of Observed Crashes

4 H53114_RuralMultlanekacilityhz” - Highway Safety Seftware

= START GENERAL DETAILS REPORT D

1 Input Data

j Length of Segment (mi) 1.500 AADT {veh/day) 10000
Lane Width (ft) 12,0 Roadway Type Divided
Right Shoulder Width (ft) 6.0 Automated Speed Enforcement No
Calibration Factor 1.10 Median Width (ft) 20

Crash Modification Factors

Lane Width - CMF1 1.000 Lighting - CMF4 1.000
G Shoulder Type/Width - CMF2 1.040 Auto. Speed Enforcement - CMFS 1.000

Median Width - CMF3 1.020

Combined CMF 1.061

Predicted Roadway Section Crashes

Crash Severity Nplss by Severity Predicted Crash Frequency | Predicted Crash Rate | Predicted Crash Rate
{crashes/year) (crashes/mifyear) (crashies/100M VMT)

Fatal and Injury (FI) 1.480 1727 1.151 31541

Praperty Damage Only (PDO) | 1.355 1581 1.054 28885

Total 2835 3.308 2.206 50426

E ic Analysis (Predicted Crashes)

Crash SE‘JGI‘\W Per Crash Societal Crash Cost Predicted Annual Crashes Total Societal Crash Cost

Fatal and Injury (FI) $158,20000 1727 $273.189.24

Property Damage Only (PDO) $7,400.00 1581 $11,70293

Total = 3308 4284,892.18

Section | 1>
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b.

If ‘Empirical Bayes Analysis’ is checked on the General page,

then the societal crash costs are

based on expected crashes

START GENERAL DETAILS REPORT

Project Description

Analyst Jurisdiction
Agency Analysis Year 2024
Date 9/17/2024 Project Description HSM Chapter 11: sample Froblem 4

Empirical Bayes Analysis

I Number of Years of Gbserved Crashes 1

& 155114 RersiMultiler =
START GENERAL DETAILS REPORT

Crash Modification Factors

£l Lane Width - CMF1 1.000 Lighting - CMF4 1.000
L] Shoulder Type/Width - CMF2 1.040 Auto. Speed Enforcement - CMFS 1.000
Median Width - CMF3 1.020
Combined CMF 1.061

Predicted Roadway Section Crashes

Crash Severity Nspt s by Severity Predicted Crash Frequency | Predicted Crash Rate | Predicted Crash Rate

(crashes/year) (crashes/mi/year) (crashes/100M VMT)
C Fatal and Injury (FI) 1.480 1727 1,151 31.541
Property Damage Only (PDO) | 1.355 1581 1.054 28.885
Total 2835 3308 2206 60426

Expected Roadway Section Crashes

Crash Severity Average Observed | Weight | Expected Crash Frequency Expected Crash Rate Expected Crash Rate
Crashes (crashes/mifyear) (crashes/mi/year) (crashes/100M VMT)
Fatal and Injury (FI) 4.000 0825 2125 1417 38813
Property Damage Only (PDQ) | 0.000 1404 0936 25.644
Total 4.000 0,680 3.529 2353 64.457
E ic Analysis (Exp d Crashes)
Crash Severity Per Crash Societal Crash Cost Expected Annual Crashes Total Societal Crash Cost

Fatal and Injury (FI) $158,200.00 2125 $336,175.00
Property Damage Only (PDO) $7,400.00 1404 $10,389.60
Total = 3.529 $346,564.60

Section 1>

Version 2025 (USC)

4 University of Flarida. All Rights Reserved.

Apply User-Defined CMFs

In any analysis, a user has the option to add additional CMFs that they can define. Once defined, the
CMFs added will get applied in the analysis in addition to the CMFs that are already calculated in the
methodology.

On the Details page, there is a ‘User-Defined CMFs’ section provided. By default, the table is empty.

START GENERAL DETAILS REPORT

Segment
Facility Type Rural Two-Lane Model Type Two-Lane Undivided Segment (2U) -
Input
AADT, veh/day 1000 Length, mi 1.000
Lane Width, ft 120 Shoulder Width, ft 60
Shoulder Type Paved v Horizontal Curve O
Horizontal Curve Length, mi Horizontal Curve Radiius, ft
Spiral Transition Superelevation Variance, ft/ft
Grade, % 00 Number of Driveways 0
Centerline Rumble Strips a Passing Lanes No Passing or Climbing Lanes
Two-Way Left-Turn Lanes m} Roadside Hazard Rating 3
Lighting a Automated Speed Enforcernent [m}
User-Definad CMFs
| CMF Name: CMF Description CMFType  CMF Value
Parameters
©
Qutput
Safety Performance Function (SPF) 0267 Predicted Crash Frequency (Npredicted) 0267
CMFT (Lane Width) 1.000 CMF2 (Shoulders) 1000
CMF3 (Horizontal Curves) 1.000 CMF4 (Horizontal Curves: Superelevation) 1000
CMFS (Grades) 1.000 CMF6 (Driveway Density, CMFE = 1when <=5) 1.000
CMF7 (Centerline Rumble Strips) 1.000 CMF8 (Passing Lanes) 1000
CMFS (Two-Way Left-Turn Lanes) 1.000 CMF10 (Roadside Design) 1000
CMF11 (Lighting) 1.000 CMF12 (Automated Speed Enforcement) 1000
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3. To add a user-defined CMF, click on the ‘Add User-Defined CMF’ button.

START GENERAL DETAILS REPORT

Segment
Facility Type Rural Two-Lane Madel Type Two-Lane Undivided Segment (2U) -
Input
AADT, veh/day 1000 Length, mi 1.000
Lane Width, ft 120 Shoulder Width, ft 6.0
Shoulder Type Paved - Horizontal Curve ]
Horizontal Curve Length, mi Horizontal Curve Radius, ft
Spiral Transition Superelevation Variance, ft/ft
Grade, % 0o Number of Driveways 0
Centerline Rumble Strips [m} Passing Lanes No Passing or Climbing Lanes E
Twa-Way Left-Turn Lanes. ] Roadside Hazard Rating 3
Lighting [m] Automated Speed Enforcement O

User-Defined CMFs —

CMF Name CMF Description CMF Type - CMF Value
Parameters
®
Qutput
Safety Performance Function (SPF) 0267 Predicted Crash Frequency (Npredicted) 0267
CMF1 (Lane Width) 1.000 CMF2 (Shoulders) 1.000
CMF3 (Horizontal Curves) 1.000 CMF4 (Horizantal Curves: Superelevation) 1.000
CMFS (Grades) 1.000 CMF6 (Driveway Density, CMF6 = 1 when <=5) 1.000
CMF7 (Centerline Rumble Strips) 1.000 CMFB (Passing Lanes) 1.000
CMF9 (Two-Way Left-Turn Lanes) 1.000 CMF10 (Roadside Design) 1.000
CMF11 (Lighting) 1.000 CMF12 (Automated Speed Enfarcement) 1.000

024 University of Florida. All Rights Reserved HSS™ Version 2025 (USC)

4. This will add a row to the table where the following can be edited:

& HSSTahz - Highway Safety Saftwars i = - |
Segment
Facility Type Rural Two-Lane Madel Type Two-Lane Undivided Segment (2U) E ‘
Input
AADT, veh/day 1000 Length, mi 1.000
Lane Width, ft 120 Shoulder Width, ft 6.0
Shoulder Type Paved v Horizontal Curve O
Harizontal Curve Length, mi Horizontal Curve Radius, ft
Spiral Transition Superelevation Variance, ft/ft
Grade, % 0o Number of Driveways 0
Centerline Rumble Strips [m} Passing Lanes No Passing or Climbing Lanes
Twa-Way Left-Turn Lanes. ] Roadside Hazard Rating 3
Lighting [} Automated Speed Enforcement El

User-Defined CMFs —

CMF Naie. CMI Description CMF Type CMF Value
I 1 Totat 1000 | I

Parameters

®
Output
Salety Performance Function (SPF) 0.267 Predicted Crash Frequency (Npredicted) 0.267
CMF1 (Lane Width) 1.000 CMF2 (Shoulders) 1.000
CMF3 (Herizontal Curves) 1.000 CMF4 (Horizontal Curves: Superelevation) 1.000
CMFS (Grades) 1.000 CMF6 (Driveway Density, CMF6 = 1 when <=5) 1.000
CMF7 (Centerline Rumble Strips) 1.000 CMF8 (Passing Lanes) 1.000
CMF9 (Two-Way Left-Turn Lanes) 1.000 CMF10 (Roadside Design) 1.000
CMF11 (Lighting) 1.000 CMF12 (Automated Speed Enforcement) 1.000
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a. CMF Name - this allows the user to specify a short name for any CMF added
b. CMF Description — this allows the user to specify a longer detailed description of any CMF added

c. CMF Type - this allows the user to specify the type of CMF for any added CMFs. The different
CMF types include the following: Total, FI, PDO. Depending on the type selected, the user-
defined CMF will get applied with the calculated CMFs in the methodology for the facility/model
type combination established.

d. CMF Value - this allows the user to specify the value of the CMF for any added CMFs. This value
will then get applied in the analysis based on the CMF type established for it.

5. If any added CMFs need to be removed, a ‘Delete User-Defined CMF’ button is provided.

= START GENERAL DETAILS REPORT ®

-~

Segment |
Facility Type Rural Twa-Lane Model Type Twa-Lane Undivided Segment (2U)
Input
AADT, veh/day 1000 Length, mi 1.000
Lane Width, ft 120 Shoulder Width, ft 6.0
Shoulder Type Paved ¥ Harizontal Curve O
Horizontal Curve Length, mi Horizontal Curve Radius, ft
Spiral Transition Superelevation Variance, ft/ft
Grade, % 0o Number of Driveways 0
Centerline Rumble Strips O Passing Lanes No Passing or Climbing Lanes
Two-Way Left-Turn Lanes [m] Roadside Hazard Rating 3
Lighting [} Automated Speed Enforcement O

User-Defined CMFs |

Added User-Delined CMF

CMF Name CMF Description CME Type  CMF Value
1 CMH CMF1 Description Total 1010
2 CMF2 CMF2 Descriptian Fl 1.020
3 CME3 CMF3 Description PDO 1030

Parameters

©]
Output
Safety Performance Function {SPF) 0.267 Predicted Crash Frequency (Npredicted) 0277
CMF1 {Lane Width) 1.000 CMF2 (Shoulders) 1.000
CMF3 {Horizontal Curves) 1.000 CMF4 (Horizontal Curves: Superefevation) 1000
CMFS (Grades) 1.000 CMF6 (Driveway Density, CMF6 = 1 when <=5) 1.000
CMF7 {Centerline Rumble Strips) 1.000 CMF8 (Passing Lanes) 1.000
Mico Ty oo VI PR
Copyright @ 2024 University of Florida. All Rights Reserved HSS™ Version 2025 (USC)
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6. Toremove a CMF, select the row(s) desired to be removed. Then click the ‘Delete User-Defined CMF’

button.

4 HSS1ahz* - Highway Safety Software

X

START GENERAL DETAILS REPOI &

Segment
Facility Type Rural Two-Lane Model Type Two-Lane Undivided Segment {2U)
Input
AADT, veh/day 1000 Length, mi 1.000
Lane Width, ft 120 Shoulder Wilth, ft 6.0
Shoulder Type Paved Horizontal Curve ]

Horizantal Curve Length, mi

Spiral Transition

Horizontal Curve Radius, ft

Superelevation Variance, ft/ft

Grade, % 00 Number of Driveways 0
Centerline Rumble Strips O Passing Lanes No Passing or Climbing Lanes
Two-Way Left-Turn Lanes o Roadside Hazard Rating 3
Lighting [m] Automated Speed Enforcement O
User-Defined CMFs
(&)
CMF Name CMF Description CMF Type  CMF Value
CME Total |1.010
Parameters
[€]
Output

Safety Perfarmance Function (SPF) 0267 Predicted Crash Frequency (Npredicted) 0277
CMFT (Lane Width) 1.000 CMF2 (Shoulders) 1.000
CMF3 (Horizontal Curves) 1.000 CMF4 (Herizontal Curves: Superelevation) 1.000
CMFS (Grades) 1.000 CMF6 (Driveway Density, CMF6 = 1when <=5) 1.000
CMF7 (Centerline Rumble Strips) 1.000 CMF8 (Passing Lanes) 1.000

Gopyright © 2024 University of Florida. All Rights Reserved.

HSS™ Version 2025 (USC)

7. The selected row(s) will be removed and those CMFs will no longer apply in the analysis.

View Results of the Analysis

1. After editing all the necessary inputs, results of the analysis can be found in the form of pages and in the

form of reports.

2. There are two options for pages: Details and Report

a. Although the Details page includes inputs, there is an Output section at the bottom of the page that

includes a few results.

& HSS10-5 RuralT Hig

START GENERAL DETAILS REPORT

AADT, veh/day 10000 Length, mi 1500

Lane Width, fc 0.0 Shoulder Width, ft 40

Shoulder Type Gravel Horizontal Curve o

Horizontal Curve Length, mi Horizontal Curve Radius, ft

Spiral Transition Superelevation Variance, fift

Grade, % 20 Numbser of Driveways 5

Centerline Rumble Strips [m} passing Lanes No Passing or Climbing Lanes

Two-Way Left-Turn Lanes m] Roadside Hazard Rating 4

Lighting [m} Automated Speed Enforcement m]

Observed Crashes 0

User-Defined CMFs
¢ | st user niined o] | Osce User s |
CME Name CMF Description CMFType  CMFValue
Patameters
]
Output

Safety Performance Function (SPF) 4,008 predicted Crash Frequency (Npredicted) 6106

CMF1 (Lane Width} 1472 CMF2 (Shoulders) 1093

CMF3 (Horizontal Curves) 1000 CMF4 (Horizontal Curves: Superelevation) 1.000

CMFS (Grades) 1000 CMFE (Driveway Density, CMF6 = 1 when <=5) 1.012

CMF7 (Centeriine Rumble Strips) 1000 CMF8 (Passing Lanes) 1.000

CMFS (Two-Way Left-Tum Lanes) 1.000 CMF10 (Raadside Design) 1069

CMF11 (Lighting) 1000 CMF12 (Autamated Speed Enforcement) 1.000

forida. All Rights Reserved.

™ Version 2026 {USC
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e Report pa

Th

= START GENERAL DETAILS REPORT

Highway Safety Software Rural

3. There are two options for reports: Formatted and Text

a.

Project Information

Analyst Date 5/9/2024

Jurisdiction Analysis Year 2024

Project Description HSM Chapter 10: Sample Section Number 1

Problem 5

Input Data

Length of Segment (mi) 1.500 AADT (veh/day) 10000

Lane Width (ft) 100 Grade (%) 20

Shoulder Type Gravel Shoulder Width (ft) 40

f;.:\; Driveway Density {driveway/mi) 6 Roadside Hazard Rating 4
N Centerline Rumble Strips No Passing Lanes No Passing or Climbing Lanes

s Two-Way Left Turn Lane Na segment Lighting Mo

‘Automated Speed Enforcement No Calibration Factor 110

Crash Modification Factors

Lane Width - CMF1 1172 Centerline Rumble Strips - CMF7 1.000

Shoulder Type/Width - CMF2 1.093 Passing Lanes - CMF& 1.000

Horizontal Curve - CMF3 1.000 Two-Way Left Turn Lane - CMF9 1.000

Superelevation - CMF4 1.000 Roadside Design - CMF10 1.069

Grade - CMF5 1.000 Lighting - CMF11 1.000

Driveway Density - CMF6 1.012 Auto. Speed Enforcement - CMF12 1.000

Combined CMF 1385

Section 1

Formatted reports show the most important results in a presentable format

Highway Safety Software Rural Two Lane Segment Report
Project Information
Analyst Date 979/2024
Jurisdiction Analysis Year 2024
Project Description HSM Chapter 10: Sample Section Number 1

Prablem 5

Input Data
Length of Segment (mi) 1500 AADT (veh/day) 10000
Lane Width (ft} 100 Grade (%) 20
Shoulder Type Gravel Shoulder Width (ft) 40
Driveway Density (driveway/mi) 6 Roadside Hazard Rating 4
Centerline Rumble Strips No Passing Lanes Na Passing or Climbing | anes
Two-Way Left Tum Lane No Segment Lighting Na
Automated Speed Enforcement No Calibration Factor 110
Crash Modification Factors
Lane Width - CMF1 1172 Centerline Rumble Strips - CMF/ 1.000
Shoulder Type/Width - CMF2 1.093 Passing Lanes - CMF8 1.000
Horizoral Curve - CMF3 1.000 Two-Way Left Turn Lane - CMF9 1.000
Superelevation - CMF4. 1.000 Roadside Design - CMF10 1.069
Grade - CMFS 1.000 Lighting - CMF11 1.000
Driveway Density - CMF6 1.012 Auto, Speed Enforcement - CMF12 1.000
Combined CMF 1385
Predicted Roadway Section Crashes

Crash Severity

Nspfirs by Severity

Predicted Crash Frequency

Preclicted Crash Rate

Predicted Crash Rate

(crashes/year) (crashes/mi/year) (crashes/100M WMT)
Fatal and Injury (Fl) 1286 1.960 1307 35801
Property Damage Only (PDQ) | 2721 4146 2764 75.730
Total 4008 6.106 4071 111531

Expected Roadway Section Crashes

Crash Severity Average Observed | Weight | Expected Crash Frequency |  Expected Crash Rate Expected Crash Rate
Crashes i i/year) (crash /| {crashes/100M VMT)
Fatal and Injury (FI) 2571 1714 99339
Property Damage Only (PDO) 5439 3626 99.339
Total 10.000 0511 8010 5340 146301
Ec ic Analysis (Exp d Crashes)
Crash Severity Per Crash Societal Crash Cost Expected Annual Crashes Total Societal Crash Cost

Fatal and Injury (Fl) $158,200.00 2571 §406, 76542
Property Damage Only (PDO) $7,400.00 5439 $40,247.05
Total BO10 444701247
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b. Text reports show a more detailed analysis in plain text

Highuay Safety Software Text Report CHF conbined 1.385

eeeseoooseooooos Pradictsd Crashes

File Kamei Hssie-5_RuralTwelansfacility. xhz
Analyst: crashes/year crashes/ni/year  crashes/loed T
Ageney: Predicted Crashes (FI) 1.950 1207 ss.ae
Jurizdiction: Predicted Crashes (Fatal) a.e73
Date: a2 Predicted Crashes (Incapacitating Injury) 8,338
Analysis vear: 2e24 Predicted Crasnes (Nonineapacitating Injury) 2.565
Project Deserlption: Kt Chapter 18: Sasple Problen 5 Predicted Crashes (Possible Tnjury) o.385
Units: U5, Customary Predictad Crashes (F03) 416 2.764 75738
Total Predicted Crashes 5,105 2en 11531
- “=+=<= Crashes by Severity Level and Collision Type
Section 10
Tatsl Crashes Fatal-and-Injury Proparty-Danage-Dnly
Facility Type RuralTuolane ;f:;};‘ﬂ,&{;: Proes 1N s ¥ e
Jactlon Type i " Collision with Aninal o121 a7 G.03  .aa c1ma o763
Hodad Type oLl b LA RITE (9) Collision ulth Bicycle o002  elow c.eea  o.ged eoel  ooea:
ez Tien = €ollision with Pacastrian 9.883 el 0.807  8.014 e.001  @.ea:
overturned e.628 .15 e.637  .873 e.015 @862
nput Ran OFF Road 0521 3.8 0.545  1.068 0.505  z.ema
other single-Vehicle collision e.621 128 6.007  .614 G023 812
12008 veh/day Total single-vel @693 a.m2 o.635  1.251 a7 s
Length 1.sen by Multiple-venicle
Lane Hidth 1.8 t Angle Cellision e.85  e.sis @00 e.i%6 o072 e.am
shoulder uidth as fr Kead-on collision @.815 .09 0.032  0.867 o0 @012
Shewider Trpe Craver Rear-End Collizion @132 .7 e84 321 0122 8505
Horizomtal Curve he Sidesuipe Collizion @.037 .22 .03  0.674 e.o: 015
Grade 28 5 Other ultiple-vehicle Collision @.627 153 G026 o.es1 s.e%8 8124
Orivenay Density H faT— Total Multiple-Vehicle Craches @307 1.7 6352 aie o265 1808

Centerline Runble Strips
Pas

eeesessessooe- Expected Crashes

Tuo-kay Left-Turn Lanes
Lignting el Tetal Dbserved Crashes 1w erashes
Autonated Speed Enforcesent o
crashes year crashes/ni/vear  crashes/1080 WIT
& Average Obzerved Crashes 18,088
Overdispersion Parareter, k o.187
Humber of Observed Crashes 10 Weighted sdjustnent, w 0.511
Expected C (FT) 2571 1714 25,962
output Expected Crashes (PO) 5.439 3.626 95,338
Total Expected Crashes 5 818 5350 125_381
........... SPE ceeee
W (5P, EL) 1.2%
M {5PF, POD) 27 *gased on Expected Crash Frequency
Annual Societal Crash Cost (FI) $405,765.42
,,,,,,,, B _— . #nnusl socistal Crash Cost (PGO) 540, 247,05
Total annusl Socistal Crash Cost 5447,012.47
CHF_WRA (for CHFZ Shoulders) 1158
CUFITRA (for CMF1 Shoulders) 1 ala
This Highway Safety Saftware Text report was crested dn HSS™ Version 2025 on $/23/2624 18:67:51
s
CHFL (Lane Width) 1472
CHE2 (Shoulders) 1.093
C#F3 [Horizontal Curves) 1.000
CHFA {Horizontsl Curves: Supereleation) 1 000
CHFS [Grades) 1 000
CES (Drivewsy Density, CHFE = 1 when <=5} 1e12
CHFT (Centerline Rumble Strips) 1000
CHFB (Passing Lanes) 1000
€3 (Two-way Lefr-Turn Lanes) 1.000
c¥F1a (Roadside Design) 1.883
11 (Lighting) 1,000
CF12 (suronated Speed Enforcement) 1800

4. The type of report displayed can be changed by using the main menu items, keyboard shortcuts, or toggle
buttons found under the report

a. Main Menu ltems

i. To switch to the Formatted Report, select File > Report > Formatted Report from the main
menu; this can be found by selecting the three lines in the top left-hand corner of the
screen, hovering over “Report”, and then selecting “Formatted Report”.

4 HS510-5_RuralTwolaneFacility.xhz* - Highway Safety Software

= START GENERAL DETAILS REPORT

New Ctrl+N »
g a are 0 are R a () ane eg e Repo
Open ctr+0
Example Folder !
ion
Save Ctrl+S
Save As. F12 Date 9/9/2024
Close Ctri+W Analysis Year 2024
ghis 5 HSM Chapter 10: Sample Section Number 1
Print Ctrl+P Problem 5
Print Preview Ctrl+F2
View 4
[ Report »|[_[Formatted Report _F4 AADT (veh/day) 10000
Parameter Template » TetReport £6 Grade (%) 20
Export to CSV
Gravel Shoulder Width (ft) 40
Default Settings Alt+F
Nay/mi) 6 Roadside Hazard Rating 4
Help >
= AR No Passing Lanes No Passing or Climbing Lanes
Two-Way Left Turn Lane No Segment Lighting No
‘ Automated Speed Enforcement No Calibration Factor 110
. . |
Crash Modification Factors |
Lane Width - CMF1 1172 Centerline Rumble Strips - CMF7 1.000
Shoulder Type/Width - CMF2 1.093 Passing Lanes - CMF8 1.000
Horizontal Curve - CMF3 1.000 Two-Way Left Turn Lane - CMF9 1.000
Superelevation - CMF4 1.000 Roadside Design - CMF10 1.069
Grade - CMF5 1.000 Lighting - CMF11 1.000
Driveway Density - CMF6 1.012 Auto. Speed Enforcement - CMF12 | 1.000
Combined CMF 1.385
) Section | 1> v —
Copyrigt 2024 University of Florida. All Rights Reserved.

™ Version 2025 (USC)

ii. To switch to the Text Report, select File > Report > Text Report from the main menu; this
can be found by selecting the three lines in the top left-hand corner of the screen, hovering
over “Report”, and then selecting “Text Report”.
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| 4 HSS10-5_RuralTwolaneFacility:xhz* - Highway Safety Software = o X

= START GENERAL DETAILS REPORT
New Ctrl+N »
et 0o Highway Safety Softuare Text Report
Example Folder
ctilss -
Save i HSS10-5_RuralTwolaneFacility.xhz
Save As. F12
Close ctrlew.
Units > 9/9/2024
Print 2024
HSM Chapter 10: Sample Problem 5
Print Preview
U.S. Customary
View »
Report > | Formatted Report  F4
Parameter Template »|l [Texl Report F6 .
e Section 1:
Default Settings Alt+F RuralTwolane
Help ' Segment
Tuo-Lane Undivided Segment (2U)
Exit Alt+F4 Rural
Input
AADT 10000 veh/day |
Length 1.500 mi |
Lane Width 10.0 ft
Shoulder Width 4.0 t
Shoulder Type Gravel
Horizontal Curve No
Grade 2.0 %
Driveuay Density 6 driveway/mi
Centerline Rumble Strips No
Passing Lanes NoPassinglLane
Tuo-Way Left-Turn Lanes No
Lighting No
Automated Speed Enforcement No
A Y
£l Section 1> Y; - —H +

b. Keyboard Shortcuts
i. Formatted Report: keyboard shortcut is “F4”
ii. Text Report: keyboard shortcut is “F6”

c. Report Toggle Buttons

i. Ifthe formatted report is currently being displayed, the toggle button will say “Switch to Text
Report” which will allow you to display the text report if clicked.

& 1SSI0.5 ol = -

=  START GENERAL DETAILS REPORT

Highway Safety Software Rural Two Lane Segment Report

Project Information

Analyst Date 9/9/2024
Jurisdiction Analysis Year 2024
Project Description HSM Chapter 10: Sample Section Number 1
Problem 5
Input Data
Length of Segment (mi] 1.500 AADT (vehjday) 10000
Lane Width (1) 10.0 Grade (%) 20
Shoulder Type Gravel Shoulder Width (ft) a0
Drivaway Density (driveway/mi) 6 Roadsida Hazard Rating 4
Centerline Rumble Strips No Passing Lanes Mo Passing or Climbing Lanes
Two-Way Left Turn Lane No Segment Lighting No
Automated Speed Enforcement Na Calibration Factor 110

Crash Modification Factors

Lane Width - CMF1 1172 Centerline Rumble Strips - CMF7 1.000
shoulder Type/width - cvF2 1,093 Passing Lanes - CMFB 1.000
Horizontal Curve - CMF3 1.000 Two-Way Left Turn Lane - CMF9 1.000
Superalevation - CMF4 1.000 Roadsida Design - CMF10 1.069
Grade - CMF5 1.000 Lighting - CMF11 1.000
Driveway Density - CMF6 1012 Auto, Speed Enforcement - CMF12 | 1.000
Cembined CMF 1385

Seetion | 1>

ity of Fiorida. All Rig!
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If the text report is currently being displayed, the toggle buttons will say “Switch to
Formatted Report” which will allow you to display the formatted report if clicked.

4 st
START GENERAL DETAILS REPORT
Highway Safety Software Text Report
File Name: H5510-5_RuralTwolanefacility.xhz
Analyst:
Agency:
Jurisdiction:
Date: 9/9/2824
Analysis Vear: 2024
Project Description: HSM Chapter 18: Sample Problem 5
Units: U.S. Customary
Section 1:
Facility Type RuralTwolane
Section Type Segment
\ Hodel Type Twa-Lane Undivided Segment (2U)
gack  Area Type Rural
Input
AdpT 16080 veh/day
Length 1.580 ni
Lane Width 10.8 ft
Shoulder Width aa ft
Shoulder Type Gravel
Horizontal Curve to
Grade 2.0
Driveusy Density 6 drivenay/mi
Centerline Rumble Strips ta
Passing Lanes loPassinglane
Two-Way Left-Turn Lanes to
Lighting tio
Automated Speed Enforcement to
Fihaain -
Section | 1>

ity of Fiarida. All Rights Rese

5. For both formatted and text reports, a Section drop down menu is provided next to the toggle button. All
reports are section specific reports. The drop-down menu allows you to select which section to display on
the Report page. There is also the option of showing all sections which will show each of the section reports
one after the other.

4 HS510-5_RuralTwoLaneFacility.xhz* - Highway Safety Software = X

= START GENERAL DETAILS REPORT

g a afe 0 are Rura o Lane Segme Repo
Project Information
Analyst Date 9/9/2024
Jurisdiction Analysis Year 2024
Project Description HSM Chapter 10: Sample Section Number 1
Problem 5
Input Data
Length of Segment (mi) 1.500 AADT (veh/day) 10000
Lane Width (ft) 10.0 Grade (%) 20
Shoulder Type Gravel Shoulder Width (ft) 4.0
/;\ Driveway Density (driveway/mi) 6 Roadside Hazard Rating 4
b Centerline Rumble Strips No Passing Lanes No Passing or Climbing Lanes
ok Two-Way Left Turn Lane No Segment Lighting No
Automated Speed Enforcement No Calibration Factor 1.10
Crash Modification Factors
Lane Width - CMF1 1172 Centerline Rumble Strips - CMF7 1.000
Shoulder Type/Width - CMF2 1.093 Passing Lanes - CMF8 1.000
Horizontal Curve - CMF3 1.000 Two-Way Left Turn Lane - CMF9 1.000
Superelevation - CMF4 1.000 Roadside Design - CMF10 1.069
Grade - CMF5 1.000 Lighting - CMF11 1.000
Driveway Density - CMF6 1.012 Auto. Speed Enforcement - CMF12 ;:
Combined CMF 1385 i; __ )

o) Section 1> v

opyright © 2024 University of Fiorida. All Rights Reserved. HSS™ Version 2025 (USC)
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6. The magnification of the report currently being displayed can be changed using the zoom slider found at
the bottom right-hand corner of the screen.

& HSS10-5 RuralTwoLar

= START GENERAL DETAILS REPORT

Project Information
Analyst Date 9/9/2024
Jurisdiction Analysis Year 2024
Project Description HSM Chapter 10: Sample Section Number 1
Problem 5
Input Data
Length of Segment (mi) 1.500 AADT (veh/day) 10000
Lane Width (ft) 100 Grade (%) 20
Sheulder Type Gravel Shoulder Width (ft) 4.0
f\'é’_": Driveway Density (driveway/mi) 6 Roadside Hazard Rating 4
5:_(1 Centerline Rumble Strips No Passing Lanes No Passing or Climbing Lanes
Two-Way Left Turn Lane No Segment Lighting No
Automated Speed Enforcement Ne Calibration Factor 110
Crash Modification Factors
Lane Width - CMF1 1172 Centerline Rumble Strips - CMF7 1.000
Shoulder Type/Width - CMF2 1.093 Passing Lanes - CMF8 1.000
Harizontal Curve - CMF3 1.000 Two-Way Left Turn Lane - CMF8 1.000
Superelevation - CMF4 1.000 Roadside Design - CMF10 1.068
Grade - CMFS 1.000 Lighting - CMF11 1.000
Driveway Density - CMF6 1.012 Auto. Speed Enforcement - CMF12 1.000
Combined CMF 1.385
=] Sui o Section | 13 - - . -

a. Tozoom in, drag the slider to the right; to zoom out, drag the slider to the left

b. Clicking the plus (+) button will zoom in; clicking the minus (-) button will zoom out

c. Holding down “ctrl” on the keyboard and scrolling up on the mouse wheel will zoom in; holding
down “ctrl” on the keyboard and scrolling down on the mouse wheel will zoom out

Print a Report

1. There are four options for printing a report:

a. Selecting File > Print from the main menu; this can be found by selecting the three lines in the top
left-hand corner of the screen and then selecting “Print”

4 HS510-5_RuralTwolaneFacilityxhz* - Highway Safety Software - o x

= START GENERAL DETAILS REPORT

New Ctri+N »
= Highway Safety Software Rural Two Lane Segment Report
Open Ctrl+O
Example Folder b
ion
Save Ctrl+S
Save As.. F12 Date 9/9/2024
Close Ctrl+W Analysis Year 2024
s & HSM Chapter 10: Sample Section Number 1
Print Cul+p Problem 5
Print Preview Ctrl+F2
View
Report > 1.500 AADT (veh/day) 10000
Parameter Template » 100 Grade (%) 20
Export to CSV
s Gravel Shoulder Width (ft 40
Default Settings Alt+F
— way/mi) 6 Roadside Hazard Rating 4
elp B
= L g No Passing Lanes No Passing or Climbing Lanes
Two-Way Left Tur Lane No Segment Lighting No
Automated Speed Enforcement No Calibration Factor 1.10 |
|
Crash Modification Factors
Lane Width - CMF1 1172 Centerline Rumble Strips - CMF7 [ 1.000
Shoulder Type/Width - CMF2 1.093 Passing Lanes - CMF8 1.000
Horizontal Curve - CMF3 1.000 Two-Way Left Turn Lane - CMF9 1.000
Superelevation - CMF4 1.000 Roadside Design - CMF10 1.069
Grade - CMF5 1.000 Lighting - CMF11 1.000
Driveway Density - CMF6 1012 Auto. Speed Enforcement - CMF12 [ 1.000
Combined CMF 1385
=) S epo Section 1> v -—=~ +

Copyright © 2024 University of Florida. All Rights Reserved. HSS™ Version 2025 (USC)
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b. Selecting File > Print Preview from the main menu; this can be found by selecting the three lines in

the top left-hand corner of the screen and then selecting “Print Preview”

4 HSS10-5 RuralTwolanefacility.xhz* - Highway Safety Software

=  START GENERAL DETAILS REPORT

New Ctrl+N > 3
o = Highway Safety Software Rural Two Lane Segment Report

Example Folder

ion

Save Ctrl+S

Save As.. F12 Date 9/9/2024

Close Ctrl+W Analysis Year 2024

Units & HSM Chapter 10: Sample Section Number 1

Print Ctri+P Problem 5

| GARHGGHED Gibdel |

View »

Report L 1.500 AADT (veh/day) 10000

Parameter Template > 100 Grade (%) 20

Export to CSV. =

Gravel Shoulder Width (ft) 40

Default Settings Alt+F

way/mi) 6 Roadside Hazard Rating 4

Help »

Exit AltsFa B No Passing Lanes No Passing or Climbing Lanes
Two-Way Left Turn Lane No Segment Lighting No
Automated Speed Enforcement No Calibration Factor 1.10
Crash Modification Factors
Lane Width - CMF1 1172 Centerline Rumble Strips - CMF7 1.000
Shoulder Type/Width - CMF2 1.093 Passing Lanes - CMF8 1.000
Horizontal Curve - CMF3 1.000 Two-Way Left Turn Lane - CMF9 1.000
Superelevation - CMF4 1.000 Roadside Design - CMF10 1.069
Grade - CMF5 1.000 Lighting - CMF11 1.000
Driveway Density - CMF6 1.012 Auto. Speed Enforcement - CMF12 1.000
Combined CMF 1.385

E Switch to Text Report Section 1> v

Copyright © 2024 University of Fiorida. All Rights Reserved.

c. Using the keyboard shortcut “Ctrl+P” for Print

d. Using the keyboard shortcut “Ctrl+F2” for Print Preview

2. Print

o

B - +

HSS™ Version 2025 (USC)

a. Using Print will bring up a Print dialog box where you can select which printer to print to

= Print
General |
Select Printer
7® Microsoft Print to PDF

™l OneNote for Windows 10

™ Microsoft XPS Document Writer

X

< >
Status: Ready Preferences
Location:
Comment: Find Printer
Page Range
© Al Number of copies: |1 E
C < GIGinent Pac
(@ ﬁ = : I
2 22 g3
Pit | Cancel | |
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3. Print Preview

a. Using Print Preview will bring up a window where you can view how the report will look on paper
before sending it to the printer

% Print Preview = (m] X
&% e @ ;
Highway Safety Software Rural Two Lane Segment Report

Project Information

Analyst Date 9/9/2024

Jurisdiction Analysis Year 2024

Project Description HSM Chapter 10: Sample Section Number 1

Problem 5

Input Data

Length of Segment (mi) 1,500 AADT (veh/day) 10000

Lane Width (ft) 100 Grade (%) 20

Shoulder Type Gravel Shoulder Width (ft) 40

Driveway Density (driveway/mi) 6 Roadside Hazard Rating 4

Centerline Rumble Strips No Passing Lanes No Passing or Climbing Lanes

Two-Way Left Tum Lane No Segment Lighting No

Automated Speed Enforcement No Calibration Factor 1.10

Crash Modification Factors

Lane Width - CMF1 1172 Centerline Rumble Strips - CMF7 1.000

Shoulder Type/Width - CMF2 1.093 Passing Lanes - CMF8 1.000

Horizontal Curve - CMF3 1.000 Two-Way Left Turn Lane - CMF9 1,000

Superelevation - CMF4 1.000 Roadside Design - CMF10 1,069

Grade - CMFS 1.000 Lighting - CMF11 1.000

Driveway Density - CMF6 1012 Auto. Speed Enforcement - CMF12 | 1.000

Combined CMF 1385

Predicted Roadway Section Crashes .
| Type text to find.. «r v !

b. The print icon in the toolbar found in the top left-hand corner can then be selected

&
c. A print dialog box will pop up where you can select which printer to print to
= Print X

Generdl |

[~ Select Printer

7® Microsoft Print to PDF
A Microsoft XPS Document Writer
A OneNote for Windows 10

< >
Status: Ready Preferences
Location:
Comment: Find Printer...
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Glossary of Terms

AADT

Annual average daily traffic; the counted (or estimated) total traffic volume in one year divided by 365 days/year.

Rural Two-Lane, Two-Way Roads (Chapter 10); Rural Multilane Highways (Chapter 11); Urban and Suburban
Arterials (Chapter 12)

For each roadway segment, the AADT is the average daily two-way, 24-hour traffic volume on that roadway segment
in each year of the evaluation period.

For each intersection, two values are required in each predictive model. These are the AADT of the major street,
AADT g, and the two-way AADT of the minor street, AADT pn.

In Chapter 10, AADT s and AADTqin are determined as follows: if the AADTs on the two major road legs of an
intersection differ, the larger of the two AADT values is used for the intersection. For a three-leg intersection, the
minor road AADT is the AADT of the single minor road leg. For a four-leg intersection, if the AADTs of the two minor
road legs differ, the larger of the two AADT values is used for that intersection. If AADTs are available for every
roadway segment along a facility, the major road AADTs for intersection legs can be determined without additional
data.

In Chapter 11, AADT s and AADTmin are determined as follows: if the AADTs on the two major-road legs of an
intersection differ, the larger of the two AADT values are used for AADT 5. For a three-leg intersection, the AADT
of the minor-road leg is used for AADTmin. For a four-leg intersection, the larger of the AADTs for the two minor-
road legs should be used for AADT . If a highway agency lacks data on the entering traffic volumes, but has two-
way AADT data for the major and minor-road legs of the intersection, these may be used as a substitute for the
entering volume data. Where needed, AADT .t can be estimated as the sum of AADT g and AADT min.

In Chapter 12, AADT ps; and AADT min are determined as follows: if the AADTSs on the two-major-road legs of a four-
leg intersection differ, the larger of the AADTSs for the two minor road legs is used. For a three-leg intersection, the
AADT of the single minor road leg is used. If AADTs are available for every roadway segment along a facility, the
major-road AADTSs for intersection legs can be determined without additional data.

Freeways (Chapter 18)
For each freeway segment, the following five AADT values are required:
(1) the AADT volume of the freeway segment (AADT¥),

(2) the AADT volume of the nearest entrance ramp upstream of the segment for the increasing milepost travel
direction (AADTp,ent),

(3) the AADT volume of the nearest entrance ramp upstream of the segment for the decreasing milepost travel
direction (AADTe,ent),

(4) the AADT volume of the nearest exit ramp downstream of the segment for the increasing milepost travel
direction (AADTs,ex), and
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(5) the AADT volume of the nearest exit ramp downstream of the segment for the decreasing milepost travel
direction (AADTp,ext).

For each ramp entrance speed-change lane, two values are required. They include the AADT volume of the freeway
segment and the AADT volume of the ramp.

For each ramp exit speed-change lane, only the AADT volume of the freeway segment is required. The AADT
volume of the ramp is not needed.

The AADT volumes are needed for each year of the evaluation period. The AADT volume for a given year represents
an annual average daily 24-hour traffic volume. The freeway segment AADT volume is a two-way volume (i.e., the
total of both travel directions). Each ramp AADT volume represents a one-way volume.

b,ext b.ent

—— e —— R ExIErEay -

Direction

e Secondary _ .
Direction

Segment of Interest

Ramps (Chapter 19)

The AADT volume of the ramp is needed for each ramp segment. The AADT volume of the C-D road is needed for
the evaluation of each C-D road segment.

For each crossroad ramp terminal, one AADT value is needed for each intersection leg. Thus, for a four-leg ramp
terminal, the following values are needed: AADT volume of the crossroad leg “inside” the interchange, AADT volume
of the crossroad leg “outside” of the interchange, AADT volume of the exit ramp, and AADT volume of the entrance
ramp. The inside crossroad leg is the leg that is on the side of the ramp terminal nearest to the freeway. The outside
crossroad leg is on the other side of the ramp terminal. The AADT of the loop ramp at a terminal with either an A4
or B4 configuration is not needed (or used in the calculations.

The AADT volumes are needed for each year of the evaluation period. The AADT volume for a given year represents
an annual average daily 24-hour traffic volume. The ramp and C-D road segment AADT volume is a one-way
volume. The crossroad segment AADT volume is a two-way volume (i.e., total of both travel directions).

AADT, is the AADT volume of the ramp segment in veh/day. AADT, is the AADT volume of the C-D road segment
in veh/day.

Crossroad Ramp Terminals at Single-Point (SP) Diamond Interchanges and Tight Diamond (TD)
Interchanges (NCHRP 17-68 Chapters 8 and 9)

AADTxuq is the AADT volume on the crossroad in veh/day. AADTramp is the sum of ramp AADTSs in veh/day. Ramp
AADTs include entrance ramp 1 AADT (AADTen1), entrance ramp 2 AADT (AADTenz), exit ramp 1 AADT (AADTex1),
and exit ramp 2 AADT (AADTexz2). All ramp AADTSs are in veh/day.

Add Horizontal Curve

For Freeway Segment, Ramp Segment, and Freeway Intersection analyses, a button for adding a horizontal curve
is available when ‘Include Horizontal Curves’ is checked.

For Freeway Segment and Speed Change Lanes analyses, clicking on the button ‘Add Horizontal Curve’ will add a
row of inputs which include the following: Primary Radius, Secondary Radius, and Length in Segment. Primary
Radius is measured for roadbed curves and Secondary Radius is measured to the inside edge of the traveled way.

For Ramp Segment and C-D Road Segment analyses, clicking on the button ‘Add Horizontal Curve’ will add a row
of inputs which include the following: Radius of Curve, Average Entry Speed, and Length in Segment.

The user can add an unlimited number of horizontal curves.
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Add Section

For facility analyses, a button for adding a section is available. Clicking on the button ‘Add Section’ will add a row
of inputs which include the following: Section Type, Facility Type, Model Type, Details, N(spf), and N(predicted).
Section Type can either be Segment or Intersection. Facility Type can either be Rural Two-Lane or Rural Multilane
in a Rural Facility analysis. Facility Type can only be Urban in an Urban Facility analysis. Section Type and Facility
Type cannot be changed within the rows. They must be specified before the new section is added. Model Type can
be changed within the rows and the choices available are dependent on Section Type and Facility Type
combinations. Clicking on Details within a row will bring the user to the Details page for that specific section. N(spf)
specifies the predicted average crash frequency for base conditions for that individual section. N(predicted)
specifies the predicted average crash frequency for that individual section, which is dependent on the inputs
specified on the Details page. The user can add an unlimited number of sections.

Add User-Defined CMF

A button is provided to add user-defined CMFs, if desired. After clicking ‘Add User-Defined CMF’, a row will be
added to the User-Defined CMFs table. The row includes the following: CMF Name, CMF Description, CMF Type,
and CMF Value. The user can make changes to each of these inputs and the value specified for the CMF will get
applied in the analysis.

Agency

This field is provided to document the agency or company associated with this analysis or project.

Analysis Type

This specifies the type of analysis to be done. Choices include: Segment, Intersection, Rural Facility, Urban Facility,
Freeway Facility, and Ramp Facility.

Analysis Year

This field is provided to document the year for which the analysis is being performed.

Analyst

This field is provided to document the name of the analyst.

Angle

The angle to next leg is used to measure the relative intersection skew; it is measured in degrees. Angle is measured
for each leg of the roundabout.

Any Ramps within 0.5 mi

A checkbox is provided to indicate if there are any ramps within 0.5 miles (or 0.8 kilometers in metric). If ramps are
within 0.5 miles (or 0.8 kilometers in metric) of the end point of the segment, there is a potential for increased
crashes due to lane changing.

Approach

A lane or set of lanes at an intersection that accommodates all left-turn, through, and right-turn movements from a
given direction.
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Approaches for which Right-Turn-on-Red is Prohibited

This is the number of signalized intersection approaches for which right-turn-on-red is prohibited. This affects the
CMF for right-turn-on-red operation (CMF4).

Approaches for which U-Turn is Prohibited

This indicates the number of approaches from which U-turns are prohibited via “No U-turn” signs. It is used in the
calculation of the U-turn Prohibition CMF.

Approaches with Turn Lanes

The number of approaches with left-turn lanes and the number of approaches with right-turn lanes are necessary
for determining the effects of individual geometric design of intersections. Approaches include the major and minor
road approaches. Turn lanes include exclusive left-turn lanes and exclusive right-turn lanes. Stop-controlled
approaches are not considered in determining the number of approaches with right- or left-turn lanes.

Area Type
This specifies whether the area is rural or urban.

See also Rural Areas and Urban Environment.

Automated Speed Enforcement

Automated speed enforcement systems use video or photographic identification in conjunction with radar or lasers
to detect speeding drivers. The systems automatically record vehicle registrations without needing police officers
at the scene.

Average Entry Speed

The estimated speed of vehicles upon entering the curve. HSM Equations 19-59 and 19-60 are used in the method
for calculating average entry speed.

The procedure for predicting the average curve entry speed for each curve on a ramp or C-D road is developed for
use with the horizontal curve CMF. It is not intended to be used with other applications, or to predict vehicle speed
at other points along a ramp or C-D road.

The speed prediction procedure consists of a sequence of steps that lead to a prediction of average entry speed
for each horizontal curve on the subject ramp or C-D road. Each curve is addressed by the procedure in the same
sequence as they are encountered when traveling along the ramp or C-D road. In this manner, the speed for all
previous curves encountered must be calculated first, before the speed on the subject curve can be calculated. The
steps used will vary depending on whether the segment is part of an entrance ramp, exit ramp, connector ramp, or
C-D road.

The horizontal curves are located along the ramp or C-D road using a linear referencing system. For exit ramps,
ramp-mile 0.0 (or ramp-kilometer 0.0 in metric) is located at the gore point. For entrance ramps that intersect the
crossroad, ramp-mile 0.0 (or ramp-kilometer 0.0 in metric) is located at the point where the ramp reference line
intersects with the near edge of traveled way of the crossroad. The location of ramp-mile 0.0 (or ramp-kilometer 0.0
in metric) is shown in the figure below for simple situations.
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Exit Ramp, C-D Road, Entrance Ramp with Speed-Change Lane

Gore point

Ramp-mile 0.0

This barrier is on the

freeway \and ramp.

This barrier is on the M

<+«—— Reference line

This barrier is on the ramp. B

Entrance Ramp with Intersection

Ramp-mile 0.0

<+«—— Reference line

Measure lane and shoulder widths in areas with
constant cross section. Measure along a line
such as line A or line B_ If necessary, move the
line off the subject segment to the nearest point

with constant cross section.

It is shown in the figure below for more complex ramp and C-D road combinations.

(both ramps)

a. Exit Ramp

Ramp-mile 0.0

Ramp 1 has the highest volume so its ramp-mile 0.0 is
used for the combined entrance ramp segments.

b. Entrance Ramp

C-D road 1 has the highest volume so its ramp-mile 0.0 is used for the combined entrance ramp segments.

———

T

Ramp-mile 0.0

(C-D road 1, Ramp 2,

and Ramp 4)

T e .
-
-

. C-Droad1s” Tt
"3‘ , Ramp 3, Ramp4: ,*'
e - ka

Ramp2 *,

Censt ‘._.:'g" Ramp 5
~~ +
»®

A o “Ramp-mile 0.0
(Ramp 3)

P
-

S

«— Ramp-mile 0.0
(Ramp 5)

--.-""+-‘

c¢. Entrance and Exit Ramps with C-D Road
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When a specific entrance ramp or C-D road segment serves traffic from two or more sources combined, ramp-mile
0.0 (or ramp-kilometer 0.0 in metric) for this segment should be that of the one ramp that is the source of the highest
daily traffic volume.

The input data needed for this procedure are identified in the table below. The first three variables listed represent
required input data. Default values are provided for the remaining variables.

Variable Description Default Value Applicable Site Type

X Ramp-mile of the point of change None All

i

from tangent to curve (PC) for

curve 7 (mi)?

R, Radius of curve i (ft)? None All
LM Length of horizontal curve 7 (mi) None All
v, Average traffic speed on the Estimate as equal to the speed All

Sfwy
freeway during off-peak periods  limit

of the typical day (mi/h)

: Average speed at the point 15 — ramps with stop-, yield-. or  Entrance ramp, exit ramp.
wwoad £ 3
where the ramp connects to the signal-controlled crossroad ramp  connector ramp at service
crossroad (mih) terminals interchange

30 — all other ramps at service
interchanges

S Average speed on C-D road or 40 C-D road. connector ramp at
connector ramp (measured at system mterchange
the mid-point of the C-D road or

ramp) (mi'h)

* If the curve is preceded by a spiral transition, then X, is computed as equal to the average of the TS and 5C ramp-mile
locations, where TS is the point of change from tangent to spiral and SC is the point of change from spiral to curve.
" If the curve has spiral transitions, then R, is equal to the radius of the central circular portion of the curve.

Base Model

A regression model for predicting the expected average crash frequency in each HSM prediction procedure given
a set of site characteristics. The base model, like all regression models, predicts the value of a dependent variable
as a function of a set of independent variables. The expected average crash frequency is adjusted for changes to
set site characteristics with the use of a CMF.

Bicycle Crash Adjustment Factor

For roadway segments, fuiker is the bicycle crash adjustment factor. It is used in the determination of the number of
vehicle-bicycle collisions per year for a roadway segment. The values of fyier are likely to depend on the climate
and the bicycling environment in particular states or communities. The following tables show the bicycle crash
adjustment factors for roadway segments, but users are encouraged to replace the values in the table with suitable
values for their own state or community through the calibration process.
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Table 54. Bicycle crash adjustment factor for two-way roadway segments.

S Road Bicycle Crash Adjustment Factor (fhire)
Type Posted Speed 30 mph or Lower Posted Speed Greater Than 30 mph
. Total P Total
P e F 2 P bl L N g
Segments | Crashes S} Segments | Crashes S,\
Crashes” Crashes®

s 2U 0.018 0.004
FEER 0.027 0.007
C |4U 0.011 0.002
= |4D 0.013 0.005
oI 0.050 0.012
- 6U 22 7 249 0.013 72 9 1359 0.007
_Z, 6D 106 16 2377 0.007 1661 190 24720 0.008
5‘ iy 16 8 324 0.025 250 46 10016 0.001
= 8D 1 0 612 122 92 6623 0.014

Note: Shaded cell = data not available.
* Excludes pedestrian and bicycle crashes.

Table 74. Bicycle crash adjustment factor for one-way roadway segments.

Bicycle Crash Adjustment Factor (foiker)
Posted Speed 30 mph or Lower Posted Speed Greater Than 30 mph
Source 1;:13)(: Number Total \;[‘?tal d f Number Total “];l?tal 1 f
M of Bicycle | © e ped of Bicycle | & _ s pod
Segments Crashes s Segments | Crashes i
' Crashes® i Crashes”
z 20 174 29 2767 0.011 276 11 676 0.016
%; 30 395 24 2217 0.011 162 11 911 0.012
& 40 81 T 342 0.021 a7 3 405 0.007

#Excludes pedestrian and bicycle crashes.

For intersections, fyiei is the bicycle crash adjustment factor. It is used in the determination of the number of vehicle-
bicycle collisions per year for an intersection. The values of fyxe; are likely to depend on the climate and bicycling
environment in particular states or communities. The following table shows the bicycle crash adjustment factors for
intersections, but users are encouraged to replace the values in the table with suitable values for their own state or

community through the calibration process.
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Table 12-30. Bicycle Crash Adjustment Factors for Intersections

Intersection Category Intersection Type Bicycle Crash Adjustment Factor (faes)
38T 0.016
35G 0.011
2x2 with five or fewer lanes
45T 0.018
45G 0.015
35T 0.048
35G 0.029
2x2 with six or more lanes
4ST 0.039
456G 0.019
38T 0.018
. 35G 0.016
or
i 4ST 0.022
45G 0.012

Note: These factors apply to the methodology for predicting total crashes (all severity levels combined). All bicycle collisions resulting from this
adjustment factor are treated as FI crashes and none as PDO crashes.

Source: HSIS data from California (2002-2006) for 2x2 intersections with five or fewer lanes; HSIS data from California and Illinois (2006-2010) and
state data from Texas (2008-2012) and Michigan (2008-2012) for other Intersection categories.

Calibration Factor

A factor to adjust crash frequency estimates produced from a safety prediction procedure to approximate local
conditions. The factor is computed by comparing existing crash data at the state, regional, or local level to estimates
obtained from predictive models.

California State

A checkbox is provided to indicate if the site under analysis is in California. If checked, the California state indicator
variable is 1.0. If not, it is 0.0. This indicator variable is used in the safety performance function calculations and is
only applicable to the following models: Urban Intersection Six or More Lanes 4SG and Urban Intersection Six or
More Lanes 3SG.

The project database was developed using data from five states: Texas, Illinois, California, Michigan, and Oregon.
These states were selected based on the state-owned mileage of the two street categories of interest and the
availability of crash data.

Crash and roadway data from California and lllinois were obtained from the Highway Safety Information System
(HSIS), while data from Texas, Michigan, and Oregon were obtained directly from the state highway agencies. Data
from Texas, lllinois, and California comprised the bulk of the project database. Data from Oregon were later added
to increase the mileage of one-way streets, and data from Michigan were added to increase the number of
intersections in the sample.

Data for the five states were combined for model calibration and the development of crash modification factors
(CMFs). These data were enriched through the inclusion of additional road inventory data extracted from Google
Earth and Google Street View. The enhanced database was then combined with the crash data to form the highway
safety database needed for model and CMF development and calibration.

Circulating AADT

Average annual daily traffic volume circulating the roundabout; measured in vehicles per day for each approach leg

Circulating Width

Circulating width is the width of the circulatory roadway within the roundabout. It is measured in feet and recorded
as the nearest integer foot (or nearest tenth of a meter in metric). Roundabouts in which the number of circulating
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lanes varies and/or roundabouts that are not circular (e.g., oblong shaped) may have circulating widths that vary.
In these instances, the aligned dimension will need to be used to measure the circulating width in front of the splitter
island on each leg.

Clear Zone

The total roadside border area, starting at the edge of the traveled way, available for use by errant vehicles.

Clear Zone Width

This width is measured from the edge of traveled way to typical limits of vertical obstruction (e.g., non-traversable
slope, fence line, utility poles) along the roadway. The clear zone width includes the outside shoulder. It is measured
for both travel directions. If this width varies along the segment, then use the estimated length-weighted average
clear zone width (excluding the portion of the segment with barrier). Do not consider roadside barrier when
determining the clear zone width for the predictive method. Barrier location and influence is addressed in other
CMFs. If the segment has roadside barrier on both sides for its entire length, then the clear zone width will not
influence the model prediction, and any value can be used as model input.

Controlled Right Turn at Exit Ramp

This information is needed only for the exit ramp. It is focused on the right turn movement, which may have a
different control type than the left-turn movement. Control types considered include: free flow, merge, yield, stop,
and signal (where free-flow and merge operation are recognized to represent "no control").

Crash

A set of events not under human control that results in injury or property damage due to the collision of at least one
motorized vehicle and may involve collision with another motorized vehicle, a bicyclist, a pedestrian, or an object.

Crash Distribution

Proportions to determine the distribution of crashes by collision type. Proportions can be edited, but defaults are
based off the following tables found in the Highway Safety Manual (HSM) and NCHRP reports:

e HSM Table 10-4. Default Distribution by Collision Type for Specific Crash Severity Levels on Rural Two-
Lane, Two-Way Roadway Segments

e HSM Table 10-6. Default Distribution for Collision Type and Manner of Collision at Rural Two-Way
Intersections

e HSM Table 11-4. Default Distribution of Crashes by Collision Type and Crash Severity Level for Undivided
Roadway Segments

e HSM Table 11-6. Default Distribution of Crashes by Collision Type and Crash Severity Level for Divided
Roadway Segments

e HSM Table 11-9. Default Distribution of Intersection Crashes by Collision Type and Crash Severity

e HSM Table 12.4. Distribution of Multiple-Vehicle Nondriveway Collisions for Roadway Segments by Manner
of Collision Type

e HSM Table 12-6. Distribution of Single-Vehicle Crashes for Roadway Segments by Collision Type
e HSM Table 12-11. Distribution of Multiple-Vehicle Collisions for Intersections by Collision Type
e HSM Table 12-13. Distribution of Single-Vehicle Crashes for Intersection by Collision Type

e NCHRP 17-58 Table 51. Distribution of multiple-vehicle collisions for roadway segments by manner of
collision type
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e NCHRP 17-58 Table 52. Distribution of single-vehicle crashes for roadway segments by collision type for
arterials with six or more lanes

e NCHRP 17-58 Table 61. Distribution of total vehicle collisions for intersections with six or more lanes by
collision type

e NCHRP 17-58 Table 71. Distribution of multiple-vehicle collisions for roadway segments by manner of
collision type

e NCHRP 17-58 Table 72. Distribution of single-vehicle crashes for roadway segments by collision type for
arterials with six or more lanes

e NCHRP 17-58 Table 79. Distribution of total vehicle collisions for 1x2 or 1x1 intersections by collision
e NCHRP 17-68 Table 10. Distributions for crash severity level at rural all-way stop-controlled intersections

e NCHRP 17-68 Table 11. Distributions for collision type and manner of collision and crash severity at rural
all-way stop-controlled intersections

e NCHRP 17-68 Table 13. Distributions for collision type and manner of collision and crash severity at urban
and suburban all-way stop-controlled intersections

e NCHRP 17-68 Table 26. Distributions for crash severity level at three-leg intersections with signal control
on rural two-lane highways

e NCHRP 17-68 Table 27. Distributions for collision type and manner of collision and crash severity at three-
leg intersections with signal control on rural two-lane highways

e NCHRP 17-68 Table 28. Distributions of intersection crashes by collision type and crash severity at three-
leg intersections with signal control on rural multilane highways

e NCHRP 17-68 Table 47. Distribution of MV crashes for Intersection on high-speed urban and suburban
arterials

e NCHRP 17-68 Table 48. Distribution of SV crashes for Intersections on high-speed urban and suburban
arterials

e NCHRP 17-68 Table 98. Distributions for collision type and manner of collision at crossroad ramp terminals
at single-point diamond interchanges

e NCHRP 17-68 Table 105. Distributions for collision type and manner of collision at tight diamond
interchange crossroad ramp terminals

Crash Frequency

Number of crashes occurring at a particular site, facility, or network in a one-year period, and is measured in number
of crashes per year.

Crash Modification Factor (CMF)

An index of how much crash experience is expected to change following a modification in design or traffic control.
CMF is the ratio between the number of crashes per unit of time expected after a modification or measure is
implemented and the number of crashes per unit of time estimated if the change does not take place.

Crash Prediction Algorithm

Procedure used to predict average crash frequency, consisting of three elements. It has two analytical components:
baseline models and crash modification factors, as well as a third component: crash histories.
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Crash Rate

The number of crashes per unit of exposure. For an intersection, this is typically the number of crashes divided by
the total entering AADT; for road segments, this is typically the number of crashes per million vehicle-miles traveled
on the segment.

Crash Rate Method

A method that normalizes the frequency of crashes against exposure (i.e., traffic volume for the study period for
intersections, and traffic volume for the study period and segment length for roadway segments).

Crash Reduction Factor (CRF)

The percentage of crash reduction that might be expected after implementing a modification in design or traffic
control. The CRF is equivalent to (1 — CMF).

Crash Severity

The level of injury or property damage due to a crash, commonly divided into categories based on the KABCO
scale.

Cross Section Lanes

The total number of through lanes in the segment. Rural Ramp Segments are limited to one lane. Urban ramp
segments are limited to two lanes. A segment with a lane-add or -drop taper is considered to have the same number
of through lanes as the roadway just downstream of the taper. If the segment ends at a ramp terminal, then the
number of through lanes is not based on the lane assignment, or lane markings, at the terminal.

Crossroad Median Width

This width is measured along a line perpendicular to the centerline of the crossroad in the vicinity of the intersection.
If no median exists, then a width of 0.0 ft (or 0.0 m in metric) is used in the predictive model. If a raised curb is
present, then the width is measured from face-of-curb to face-of-curb. If a raised curb is not present, then the width
is measured between the near edge of the traveled way for the two opposing travel directions. If a left turn bay is
present, then the median width includes the width of the left turn bay. It is measured from the lane line delineating
the bay to the face of curb adjacent to (or the near edge of the traveled way for) the opposing travel direction. If the
median width is different on the two crossroad legs, then use an average of the two widths.

Curb Length with On-Street Parking

This is the sum of curb length, in miles (or kilometers in metric), with on-street parking for both sides of the road
combined. This can be determined from field measurements or video log review to verify parking regulations.
Estimates can be made by deducting from twice the roadway segment length allowances for intersections widths,
crosswalks, and driveway widths.

For one-way urban and suburban arterials, curb length with on-street parking is measured for the left side of the
road and the right side of the road separately.

Daily Pedestrian Volume

This is the sum of daily pedestrian volumes, in pedestrians/day, crossing all intersection legs.

Date

This field is provided to document the date when the analysis is performed.
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Delete Horizontal Curve

For Freeway Segment, Ramp Segment, and Freeway Intersection analyses, a button for deleting a horizontal curve
is available when ‘Include Horizontal Curves’ is checked. Clicking on the button ‘Delete Horizontal Curve’ will delete
the row of inputs corresponding to the currently selected horizontal curve(s).

Delete Section

For facility analyses, a button for deleting a section is available. Clicking on the button ‘Delete Section’ will delete
the row of inputs corresponding to the currently selected section(s).

Delete User-Defined CMF

A button is provided to delete any user-defined CMFs. In the user-defined CMF table, the user must first select the
desired CMF(s) to be deleted. After selecting the desired row(s), the user can click ‘Delete User-Defined CMF’ and
then the selected row(s) will be removed and they will no longer apply to the analysis.

Distance from Inside Shoulder to Barrier

Measured from the edge of the inside shoulder to the barrier face. A barrier is associated with the freeway if the
offset from the near edge of traveled way is 30 feet of less. Barrier adjacent to a ramp, but also within 30 feet of the
freeway traveled way should also be associated with the freeway.

Distance from Outside Shoulder to Barrier

Measured from the edge of the outside shoulder to the barrier face. A barrier is associated with the freeway if the
offset from the near edge of traveled way is 30 feet (or 9.1 meters in metric) or less. Barrier adjacent to a ramp, but
also within 30 feet (or 9.1 meters in metric) of the freeway traveled way should also be associated with the freeway.

Distance from Segment to Downstream Ramp

This is the distance from the segment endpoint to the next downstream exit ramp. If there is an exit ramp within the
segment, this value is equal to 0.

This value is computed separately for the increasing and decreasing milepost directions.

Downstream entrance ramps are not of direct interest, and data are not needed for them if they exist in the vicinity
of the segment.

b, ext b,ent

____________ Primary T, o — —
Direction
E Secondary !
Direction

Segment of Interest

Distance from Segment to Upstream Ramp

This is the distance from the segment endpoint to the next upstream entrance ramp. If there is an entrance ramp
within the segment, this value is equal to 0.
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This value is computed separately for the increasing and decreasing milepost directions.

Upstream exit ramps are not of direct interest, and data are not needed for them if they exist in the vicinity of the
segment.

b,ext b,ent

——————————_— Primary o
Direction
B Secondary
Direction

Segment of Interest

Distance to Adjacent Intersection

Distance to the next public street intersection on the outside crossroad leg. This data element represents the
distance between the subject ramp terminal and the nearest public street intersection located in a direction away
from the freeway (measured along the crossroad from the subject terminal center to the intersection center).

Distance to Adjacent Ramp

This data element represents the distance between the subject ramp terminal and the adjacent ramp terminal
(measured along the crossroad from terminal center to terminal center). If there is no adjacent ramp terminal, then
use the distance to the next public street intersection (located in the direction opposite to the intersection described
by the distance to adjacent intersection data field).

Driveway Density

The number of driveways per mile (or per kilometers in metric) on both sides of the roadway combined.

Driveway Type
Seven specific driveway types have been considered in modeling. These are:
e Major commercial driveways
e Minor commercial driveways
e Major industrial/institutional driveways
e Minor industrial/institutional driveways
e Major residential driveways
e Minor residential driveways
e Other driveways

Major driveways are those that serve sites with 50 or more parking spaces. Minor driveways are those that serve
sites with less than 50 parking spaces. It is not intended that an exact count of the number of parking spaces be
made for each site. Driveways can be readily classified as major or minor from a quick review of aerial photographs
that show parking areas or though user judgment based on the character of the establishment served by the
driveway. Commercial driveways provide access to establishments that serve retail customers. Residential
driveways serve single- and multiple-family dwellings. Industrial/institutional driveways serve factories, warehouses,
schools, hospitals, churches, offices, public facilities, and other places of employment. Commercial sites with no
restriction on access along an entire property frontage are generally counted as two driveways.
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The table below shows SPF coefficients for multiple-vehicle driveway related collisions:

Coefficients for Specific Roadway Types

Driveway Type (j) 2U 3T 4U 4D 5T

Number of Driveway-Related Collisions per Driveway per Year (N)

Major commereial 0.158 0.102 0.182 0.033 0.165
Minor commercial 0.050 0.032 0.058 0.011 0.053
Major industrial/institutional 0.172 0.110 0.198 0.036 0.181
Minor industrial/institutional 0.023 0.015 0.026 0.005 0.024
Major residential 0.083 0.053 0.096 0.018 0.087
Minor residential 0.016 0.010 0.018 0.003 0.016
Other 0.025 0.016 0.029 0.005 0.027

Regression Coefficient for AADT (t)

All driveways 1.000 1.000 1.172 1.106 1.172

Overdispersion Parameter (k)

All driveways 0.81 1.10 0.81 1.39 0.10

Proportion of Fatal-and-Injury Crashes (£, )

All driveways 0.323 0.243 0.342 0.284 0.269

Proportion of Property-Damage-Only Crashes

All driveways 0.677 0.757 0.658 0.716 0.731

Note: Includes only unsignalized driveways; signalized driveways are analyzed as signalized intersections. Major driveways serve 50 or more
parking spaces; minor driveways serve less than 50 parking spaces.

Economic Analysis

Societal Crash Costs:

The Federal Highway Administration (FHWA) has completed research that establishes a basis for quantifying, in
monetary terms, the human capital crash costs to society of fatalities and injuries from highway crashes. These
estimates include monetary losses associated with medical care, emergency services, property damage, lost
productivity, and the like, to society as a whole. They are not to be confused with damages that may be awarded to
a particular plaintiff in a personal injury or wrongful death lawsuit. Tort liability damages are based only on the
particularized loss to the individual plaintiff and are not allowed to include any societal costs of crashes, which can
be used if desired.

State and local jurisdictions often have accepted societal crash costs by crash severity and collision type. When
available, these locally-developed societal crash cost data are used with procedures in the HSM.

HSM Default Values:
e Fatal/Injury (K/A/B/C): $158,200
e PDO (O): $7,400

Because SPFs and CMFs do not always differentiate between fatal and injury crashes when estimating average
crash frequencies, many jurisdictions have established a societal cost that is representative of a combined
fatal/injury crash.

Empirical Bayes Analysis

Method used to combine observed crash frequency data for a given site with predicted crash frequency data from
many similar sites to estimate its expected crash frequency.

Entering AADT

Average annual daily traffic volume entering the intersection; measured in vehicles per day for each approach leg
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Entrance/Exit
Entrance ramps: Merge points
Exit ramps: Diverge points

Entrance/Exit Ramp Name

An input is provided to specify the name of the entrance/exit ramp

Entry Width

The entry width should be measured per leg for each roundabout site. The entry width is measured at the entrance
line (i.e., the continuation of the inscribed circle diameter) and is the perpendicular width of the lane relative to a
vehicle entering the circulatory roadway. The width is measured from the splitter island curb to the curb face at the
outside edge of travel way. In the absence of a curb on the outside edge of travel way, the width is measured from
the splitter island curb face to the paved edge of travel way. Measurements should be entered in feet and rounded
to the nearest foot.

Exit Ramp with Free-Flow Right Turn

A checkbox is provided to indicate whether the exit ramp has free-flow right turns

Exiting AADT

Average annual daily traffic volume exiting the intersection; measured in vehicles per day for each approach leg

Expected Average Crash Frequency

The estimate of long-term expected average crash frequency of a site, facility, or network under a given set of
geometric conditions and traffic volumes (AADT) in a given period of years. In the Empirical Bayes (EB)
methodology, this frequency is calculated from observed crash frequency at the site and predicted crash frequency
at the site based on crash frequency estimates at other similar sites.

Expected Average Crash Frequency, Change in

The difference between the expected average crash frequency in the absence of treatment and with treatment in
place.

Expected Crashes

As estimated of long-range average number of crashes per year for a particular type of roadway or intersection.

Facility

A length of highway that may consist of connected sections, segments, and intersections.

Facility Type
The facility types and facility site types in the HSM Part C are defined below.
e Chapter 10-Rural Two-Lane, Two-Way Roads—includes all rural highways with two-lanes and two-way
traffic operation. Chapter 10 also addresses two-lane two-way highways with center two-way left-turn lanes

and two-lane highways with added passing or climbing lanes or with short segments of four-lane cross-
sections (up to two miles in length) where the added lanes in each direction are provided specifically to
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enhance passing opportunities. Short lengths of highway with four-lane cross-sections essentially function
as two-lane highways with side-by-side passing lanes, and therefore, are within the scope of the two-lane,
two-way highway methodology. Rural highways with longer sections of four-lane cross-sections can be
addressed with the rural multilane highway procedures in Chapter 11. Chapter 10 includes three- and four-
leg intersection with minor-road stop control and four-leg signalized intersections on all the roadway cross-
sections to which the chapter applies.

e Chapter 11-Rural Multilane Highways—includes rural multilane highways without full access control. This
includes all rural nonfreeways with four through travel lanes, except for two-lane highways with side-by-
side passing lanes, as described above. Chapter 11 includes three- and four-leg intersections with minor-
road stop control and four-leg signalized intersections on all the roadway cross-sections to which the
chapter applies.

e Chapter 12-Urban and Suburban Arterial Highways—includes arterials without full access control, other
than freeways, with two or four through lanes in urban and suburban areas. Chapter 12 includes three- and
four-leg intersections with minor-road stop control or traffic signal control and roundabouts on all of the
roadway cross-sections to which the chapter applies.

e Chapter 18-Freeways—have fully-restricted access control and grade separation with all intersecting
roadways. Freeways are accessed only through grade-separated interchanges. Roads having at-grade
access should be analyzed as rural highways or suburban arterials.

e Chapter 19—-Ramp/Ramp Terminals—applies to the following site types: entrance ramp segment with one
or two lanes, exit ramp segment with one or two lanes, C-D road segment with one or two lanes, and
crossroad ramp terminal. Connector ramp segments are represented using one of these site types.

Fixed-Object Density

In estimating the density of fixed objects, only point objects that are 4 inches (or 10.2 centimeters in metric) or more
in diameter and do not have breakaway design are considered. Point objects that are within 70 ft (or 21.3 meters in
metric) of one another longitudinally along the road are counted as a single object. Continuous objects that are not
behind point objects are counted as one point object for each 70 ft (or 21.3 meters in metric) of length.

The Fixed-Object Density is measured in fixed objects per mile (or per kilometer in metric), for both sides of the
road combined.

Fixed-Object Offset

The offset distance is an estimate of the average distance from the edge of the traveled way to roadside objects
over an extended roadway segment. If the average offset to fixed objects exceeds 30 ft (or 9.1 meters in metric),
use the value of offset for 30 ft (or 9.1 meters in metric). Only fixed objects on the roadside on the right side of the
roadway in each direction of travel are considered; fixed objects in the roadway median on divided arterials are not
considered.

Forward Direction

Setting the forward direction will indicate which approaches are on the major street and which approaches are on
the minor street.

Freeway Segment

When using the predictive method, the freeway within the defined project limits is divided into individual sites. A site
is either a homogenous freeway segment or a speed-change lane. A facility consists of a contiguous set of individual
sites. A roadway network consists of a number of contiguous facilities.

Three freeway segments are shown schematically in the figure below. They are labeled F; in the figure. The
presence of a speed-change lane adjacent to a freeway segment requires a reduction in the effective length of the
freeway segment. This reduction is used to account for the crashes assigned to the speed-change lanes. The
equation for computing the “effective” segment length is shown in the bottom of the figure for a freeway segment
with one ramp entrance and one ramp exit.
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Grade

The base condition for grade is a generally level roadway. The CMFs in the table below are applied to each
individual grade segment on the roadway being evaluated without respect to the sign of the grade. The sign of the
grade is irrelevant because each grade on a rural two-lane, two-way highway is an upgrade for one direction of
travel and a downgrade for the other. The grade factors are applied to the entire grade from one point of vertical
intersection (PVI) to the next (i.e., there is no special account taken of vertical curves). The CMFs in the following

table apply to total roadway segment crashes:

Approximate Grade (%)

Level Grade
(= 3%)

Moderate Terrain
(3%< grade = 6%)

Steep Terrain

(> 6%)

1.00

1.10

1.16
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Horizontal Curve

The presence or absence of horizontal curve (curve/tangent) is necessary to select a SPF and to determine whether
the site-specific conditions vary from the base conditions and, therefore, whether a CMF is applicable. If the
segment has one or more curve:

e Length of horizontal curve (miles, or kilometers in metric), (this represents the total length of the horizontal
curve and includes spiral transition curves, even if the curve extends beyond the limits of the roadway
segment being analyzed);

e Radius of horizontal curve (feet, or meters in metric);

e Presence or absence of spiral transition curve, even if the beginning and/or end of the horizontal curve are
beyond the limits of the segment being analyzed); and

e Superelevation of horizontal curve and the maximum superelevation (emax) used according to policy for the
jurisdiction, if available.

Horizontal Curve Length

Curve length is measured along the reference line from the point where the tangent ends and the curve begins (i.e.,
the PC) to the point where the curve ends, and the tangent begins (PT). If the curve PC and PT do not lie on the
reference line, then they must be projected onto this line and the curve length measured between these projected
points along the reference line.

If the curve has spiral transitions, then measure from the “effective” PC point to the “effective” PT point. The effective
PC point is located midway between the TS and SC, where the TS is the point of change from tangent to spiral and
the SC is the point of change from spiral to circular curve. The effective PT is located midway between the CS and
ST, where CS is the point of change from circular curve to spiral and ST is the point of change from spiral to tangent.

The length of curve in segment is the length of the curve within the boundaries of the segment (or speed-change
lane). This length cannot exceed the segment length or the curve length.

Horizontal Curve Radius

Radius is measured separately for each roadbed curve. The line used to define curve radius is the inside edge of
the traveled way. This line is established separately on each roadbed. If the curve has spiral transitions, then use
the radius of the central circular portion of the curve.

lllinois State

A checkbox is provided to indicate if the site under analysis is in lllinois. If checked, the lllinois state indicator variable
is 1.0. If not, it is 0.0. This indicator variable is used in the safety performance function calculations and is only
applicable to the following models:

e Urban Segments Six or More Lanes (i.e., 6D, 6U, 7T, 8D)

e Urban Segments One-Way (i.e., 20, 30, 40)

e Urban Intersections Six or More Lanes Signalized (i.e., 4SG, 3SG)
e Urban Intersections One-Way Signalized (i.e., 4SG, 3SG)

The project database was developed using data from five states: Texas, lllinois, California, Michigan, and Oregon.
These states were selected based on the state-owned mileage of the two street categories of interest and the
availability of crash data.

Crash and roadway data from California and lllinois were obtained from the Highway Safety Information System
(HSIS), while data from Texas, Michigan, and Oregon were obtained directly from the state highway agencies. Data
from Texas, lllinois, and California comprised the bulk of the project database. Data from Oregon were later added
to increase the mileage of one-way streets, and data from Michigan were added to increase the number of
intersections in the sample.
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Data for the five states were combined for model calibration and the development of crash modification factors
(CMFs). These data were enriched through the inclusion of additional road inventory data extracted from Google
Earth and Google Street View. The enhanced database was then combined with the crash data to form the highway
safety database needed for model and CMF development and calibration.

Include Horizontal Curves
If the segment includes 1 or more horizontal curves, select this box to input additional information about the curves.

For Rural Two-Lane Undivided Segments, segment endpoints should be located at the Point of Curvatures and the
Point of Tangency of each curve, limiting each segment to either no curves, or the entire segment is a curve. To
calculate values for multiple segments, use the Rural Facility Module.

Inscribed Circle Diameter

The inscribed circle diameter (ICD) is the parameter used to discuss the general size of a roundabout. It is the
diameter of the largest circle that can be inscribed within the outer edges of the circulatory roadway. The ICD serves
as the width of the roundabout. The measurement is taken in feet and rounded to the nearest integer (or meters
and rounded to the nearest tenth of a meter in metric).

Insert Horizontal Curve

For Freeway Segment, Ramp Segment, and Freeway Intersection analyses, a button for inserting a horizontal curve
is available when ‘Include Horizontal Curves’ is checked.

For Freeway Segment and Speed Change Lanes analyses, clicking on the button ‘Insert Horizontal Curve’ will add
a row of inputs before the selected row. The added row includes the following inputs: Primary Radius, Secondary
Radius, and Length in Segment. For Ramp Segment and C-D Road Segment analyses, clicking on the button ‘Insert
Horizontal Curve’ will add a row of inputs before the selected row. The added row includes the following inputs:
Radius of Curve, Average Entry Speed, and Length in Segment.

The user can insert an unlimited number of horizontal curves.

Insert Section

For facility analyses, a button for inserting a section is available. A row of inputs must be selected before inserting
a section. Clicking on the button ‘Insert Section’ will add a row of inputs before the selected row. The added row
includes the following inputs: Section Type, Facility Type, Model Type, Details, N(spf), and N(predicted). Section
Type can either be Segment or Intersection. Facility Type can either be Rural Two-Lane or Rural Multilane in a
Rural Facility analysis. Facility Type can only be Urban in an Urban Facility analysis. Section Type and Facility Type
cannot be changed within the rows. They must be specified before the new section is added. Model Type can be
changed within the rows and the choices available are dependent on Section Type and Facility Type combinations.
Clicking on Details within a row will bring the user to the Details page for that specific section. N(spf) specifies the
predicted average crash frequency for base conditions for that individual section. N(predicted) specifies the
predicted average crash frequency for that individual section, which is dependent on the inputs specified on the
Details page. The user can add an unlimited number of sections.

Inside Shoulder Width

Represents only the paved width, and is an average for both roadbeds. Should be measured where the cross
section is constant, and should not be measured where one or more edges are discontinuous or tapered. If a width
varies along the segment or speed change lane (but not enough to justify beginning a new segment), then compute
the length-weighted average widths. Rules for defining segment boundaries are provided in section 18.5.2.
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Interchange

Intersections that consist of structures that provide for the cross-flow of traffic at different levels without interruption,
thus reducing delay, particularly when volumes are high.

Interchange Ramp Terminal

A junction with a surface street to serve vehicles entering or exiting a freeway.

Intersection

General area where two or more roadways or highways meet, including the roadway, and roadside facilities for
pedestrian and bicycle movements within the area.

Intersection Related Crash

A crash that occurs at the intersection itself or a crash that occurs on an intersection approach within 250 ft (or 76.2
meters in metric) of the intersection and is related to the presence of the intersection.

Is Left Side Ramp

Ramp Entrance or Exit on left side of the roadbed.

Is Major Street One-Way

A checkbox is provided to indicate whether or not the major street is one-way. If checked, the method type used
will be One-Way.

Is Minor Street One-Way

A checkbox is provided to indicate whether or not the minor street is one-way. If checked, the one-way on minor
street indicator variable is 1.0. If not, it is 0.0. This indicator variable is used in the safety performance function
calculations.

Jurisdiction

This field is provided to document any jurisdiction convention or project related information.

KABCO

An injury scale developed by the National Safety Council to measure the observed injury severity for any person
involved as determined by law enforcement at the scene of the crash. The acronym is derived from (Fatal Injury
(K), Incapacitating Injury (A), Non-Incapacitating Injury (B), Possible Injury (C), and No Injury (O).) The scale can
also be applied to crashes, for example, a K crash would be a crash in which the most severe injury was a fatality,
and so forth.

Lane Width

The lateral distance, measured in feet (or meters in metric), between stripes for a given lane.
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Lanes Added

Lane added to the ramp segment or C-D road, not as a result of a second merging ramp. If a lane is added, then
the length of the taper in the segment is needed.

Lanes Dropped

Lane dropped from the ramp segment or C-D road, not as a result of a second diverging ramp. If a lane is dropped,
then the length of the taper in the segment is needed.

Lanes, Primary Direction

Number of through lanes in the increasing milepost direction. Rural Freeways are limited to eight lanes. Urban
Freeways are limited to ten lanes. A segment with a lane add or drop taper is considered to have the same number
of through lanes as the roadway just downstream of the taper.

Lanes, Secondary Direction

Number of through lanes in the decreasing milepost direction. Rural Freeways are limited to eight lanes. Urban
Freeways are limited to ten lanes. A segment with a lane add or drop taper is considered to have the same number
of through lanes as the roadway just downstream of the taper.

Left-Turn Lane Present on Crossroad Leg

The lane (or bay) can have one or two lanes. A lane (or bay) is considered to be present when it (a) is for the
exclusive use of a turn movement, (b) extends 100 ft or more back from the stop line, and (c) ends at the intersection
stop line.

The Crossroad Left-Turn Lane CMF is applicable to any crossroad approach that is either signalized or uncontrolled.
It is not applicable to a stop-controlled approach. The CMF value is applicable to turn bays that have a design that
is consistent with agency policy such that their length adequately provides for vehicle storage or deceleration, as
appropriate.

Left-Turn Lane Width

This variable represents the total width of all lanes that exclusively serve turning vehicles on the subject approach.
Itis measured from the near edge of the traveled way of the adjacent through lane to the near lane marking (or curb
face) that delineates the median.

Left-Turn Lanes

The lane (or bay) can have one or two lanes. A lane (or bay) is considered to be present when it (a) is for the
exclusive use of a turn movement, (b) extends 100 ft or more back from the stop line, and (c) ends at the intersection
stop line.

The base condition for intersection left-turn lanes is the absence of left-turn lanes on the intersection approaches.
CMFs apply to installation of left-turn lanes on any approach to a signalized intersection but only on uncontrolled
major-road approaches to stop-controlled intersections. The CMFs for installation of left-turn lanes on multiple
approaches to an intersection are equal to the corresponding CMF for installation of a left-turn on one approach
raised to a power equal to the number of approaches with left-turn lanes. There is no indication of any change in
crash frequency for providing a left-turn lane on an approach controlled by a stop sign, so the presence of a left-
turn lane on a stop-controlled approach is not considered in applying the table found below:
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Number of Approaches with Left-Turn Lanes®

Intersection Type Intersection Traffic Control One Approach  Two Approaches Three Approaches Four Approaches
Three-leg intersection ~ Minor-road stop control® 0.67 0.45 = —

Traffic signal 0.93 0.86 0.80 —
Four-leg intersection Minor-road stop control® 0.73 0.53 — —

Traffic signal 0.90 0.81 0.73 0.66

* Stop-controlled approaches are not considered in determining the number of approaches with left-turn lanes.
® Stop signs present on minor-road approaches only.

The CMFs in the table apply to total intersection crashes (not including vehicle-pedestrian and vehicle-bicycle
collisions). A CMF of 1.00 is always used when no left-turn lanes are present.

Left-Turn Phasing

Types of left-turn signal phasing considered include permissive, protected, protected/permissive, and
permissive/protected. Protected/permissive operation is also referred to as a leading left-turn signal phase;
permissive/protected operation is also referred to as a lagging left-turn signal phase. The base condition for the
Intersection Left-Turn Signal Phasing CMF is permissive left-turn signal phasing. This CMF applies to total
intersection crashes (not including vehicle-pedestrian and vehicle-bicycle collisions) and is applicable only to
signalized intersections. A CMF value of 1.00 is always used for unsignalized intersections.

If several approaches to a signalized intersection have left-turn phasing, the values of CMF,; for each approach are
multiplied together.

Length

The distance, in miles (or kilometers in metric), from end to end of the segment.

Lighting

Artificial lighting is often provided on roadway segments in urban and suburban areas. Lighting is also often provided
at rural locations where road users may need to make a decision.

Major Street Posted Speed

For Urban Intersections, the Major Street Posted Speed can be indicated. Options include the following: Under 50
mi/h (or Under 80 km/h in metric) and 50 mi/h and over (or 80 km/h and over in metric). If the former option is
selected, the Method Type will be General, Six or More Lanes, or One-Way depending on other inputs entered. If
the latter option is selected, the Method Type will be High-Speed.

Maximum Lanes Crossed by Pedestrian

The values of nianesx in Equation 12-29 represents the maximum number of traffic lanes that a pedestrian must cross
in any crossing maneuver at the intersection. Both through and turning lanes that are crossed by a pedestrian along
the crossing path are considered. If the crossing path is broken by an island that provides a suitable refuge for the
pedestrian so that the crossing may be accomplished in two (or more) stages, then the number of lanes crossed in
each stage is considered separately. To be considered as a suitable refuge, an island must be raised or depressed;
a flush or painted island is not treated as a refuge for purposes of determining the values of Njnesx.

Median

The portion of a divided highway separating the traveled ways from traffic in opposite directions.
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Median Barriers

Median barriers are devices used to prevent a vehicle from striking a more severe obstacle or feature located in the
median or to prevent crossover median crashes.

Median Width

The width, in feet (or meters in metric), of the median, which is the portion of a divided highway separating the
traveled ways from traffic in opposite directions.

Method Type

This indicates the method used for urban intersection calculations. The different method types include: General, Six
or More Lanes, One-Way, and High-Speed. The General methodology can be found in Chapter 12 of the Highway
Safety Manual. The Six or More Lanes methodology can be found in Chapter 6 of NCHRP 17-58. The One-Way
methodology can be found in Chapter 8 of NCHRP 17-58. The High-Speed methodology can be found in Chapter
5 of NCHRP 17-68.

Michigan State

A checkbox is provided to indicate if the site under analysis is in Michigan. If checked, the Michigan state indicator
variable is 1.0. If not, it is 0.0. This indicator variable is used in the safety performance function calculations and is
only applicable to the following models: Urban Intersection Six or More Lanes 4SG and Urban Intersection Six or
More Lanes 3SG.

The project database was developed using data from five states: Texas, Illinois, California, Michigan, and Oregon.
These states were selected based on the state-owned mileage of the two street categories of interest and the
availability of crash data.

Crash and roadway data from California and lllinois were obtained from the Highway Safety Information System
(HSIS), while data from Texas, Michigan, and Oregon were obtained directly from the state highway agencies. Data
from Texas, lllinois, and California comprised the bulk of the project database. Data from Oregon were later added
to increase the mileage of one-way streets, and data from Michigan were added to increase the number of
intersections in the sample.

Data for the five states were combined for model calibration and the development of crash modification factors
(CMFs). These data were enriched through the inclusion of additional road inventory data extracted from Google
Earth and Google Street View. The enhanced database was then combined with the crash data to form the highway
safety database needed for model and CMF development and calibration.

Minor Street

The lower volume street controlled by stop signs at a two-way or four-way stop-controlled intersection; also referred
to as a side street. The lower volume street at a signalized intersection.

Model Type
This specifies the Site Type for the combination of Facility Type and Section Type being analyzed.
See also Site Type.

Multilane Highway

A highway with at least two lanes for the exclusive use of traffic in each direction, with no control, partial control, or
full control of access, but that may have periodic interruptions to flow at signalized intersections.
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Non-Ramp Public Street Leg

This situation occurs occasionally. When it does, the public street leg is opposite from one ramp, and the other
ramp either does not exist or is located at some distance from the subject ramp terminal such that it is not part of
the terminal. This information is needed only for signalized terminals.

Number of Access Points

An access point is a driveway (not a public roadway) located along one of the legs of the roundabout of interest.
The count of access points on a leg represents the number of driveways or unsignalized access points on the leg
(either side) within 250 feet (or 76.2 meters in metric) of the yield line.

Number of Alcohol Sales Establishments

The number of alcohol sales establishments within 1,000 ft (or 304.8 meters in metric) of the center of an
intersection. The base condition for alcohol sales establishments is the absence of alcohol sales establishments
near the intersection. Any alcohol sales establishments wholly or partly within 1,000 ft (or 304.8 meters in metric)
of the intersection may be counted.

The CMF for alcohol sales establishments indicates that an intersection with alcohol sales establishments nearby
is likely to experience more vehicle-pedestrian collisions than an intersection without alcohol sales establishments
even if the traffic and pedestrian volumes at the two intersections are identical. This indicates the likelihood of higher
risk behavior on the part of either pedestrians or drivers near alcohol sales establishments. The CMF includes any
alcohol sales establishment which may include liquor stores, bars, restaurants, convenience stores, or grocery
stores. Alcohol sales establishments are counted if they are on any intersection leg or even on another street, as
long as they are within 1,000 ft (or 304.8 meters in metric) of the intersection being evaluated.

Number of Bus Stops

The number of bus stops within 1,000 ft (or 304.8 meters in metric) of the center of the intersection. The base
condition for bus stops is the absence of bus stops near the intersection.

Multiple bus stops at the same intersection (i.e., bus stops in different intersection quadrants or located some
distance apart along the same intersection leg) are counted separately. Bus stops located at adjacent intersections
would also be counted as long as any portion of the bus stop is located within 1,000 ft (or 304.8 meters in metric)
of the intersection being evaluated.

Number of Channelized Right-Turn Approaches

This indicates the number of approaches with channelized right-turn lanes. It is used in the calculation of the Right-
Turn Channelization CMF for intersections of six-or-more lane arterials.

Number of Circulating Lanes

The number of circulating lanes represents the count of circulating lanes immediately downstream of the entry that
forms the end of the segment under study.

Number of Crossroad Lanes

Lanes on the crossroad. This value only include lanes that continue through the intersection. Count the lanes along
the crosswalk (or the logical location of the crosswalk if it is not marked).
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Number of Driveways

The number of driveways of a specific type, nj, is the sum of the number of driveways of that type for both sides of
the road combined. The number of driveways is determined separately for each side of the road and then added
together.

See also Driveway Type.

Number of Entering Lanes

The number of entering lanes represents the count of lanes entering the roundabout for each leg. The number of
entering lanes per leg does not include right-turn bypass lanes on the leg.

Number of Exiting Lanes

The number of exiting lanes represents the count of lanes exiting the roundabout for each leg. The number of exit
lanes per leg does not include any lanes that may be formed from a bypass lane.

Number of Lanes Serving the Exit Ramp

Lanes can serve any movement. If right turn channelization is provided, then count the lanes at the last point where
all exiting movements are joined (i.e., count at the channelization gore point). All lanes counted must be fully
developed for at least 100 ft before intersecting the crossroad. If a lane's development length is less than 100 ft,
then it is not counted as a lane for this application. The lane (or lanes) associated with the loop exit ramp at a B4
terminal configuration are not included in this count.

Number of Legs

A leg of a roundabout should be counted as such it is a public roadway (i.e., not a private driveway). A leg does not
need to accommodate two-way traffic. A leg can, but does not need to, separate opposing traffic with a physical or
painted splitter island. Options are provided for 4-leg and 3-leg roundabouts.

Number of Luminaires

A luminaire is a light fixture that appears to have been designed to illuminate the roadway right-of-way along the
legs of the roundabout and through a roundabout. Luminaires do not include adjacent lighting that is oriented to
illuminate roadside buildings or features like billboards or other advertising signs. The number of luminaires
represents the count of luminaires within 250 feet (or 76.2 meters in metric) of the roundabout entry point on each

leg.

Number of Railroad Crossings

This indicates the number of railroad-highway crossings within the limits of the roadway segment. It is used in the
calculation of the Railroad Crossing Presence CMF for six-or-more lane arterials.

Number of Through Lanes on Major Street

This indicates the number of through lanes on the major street. It is used in the calculation of the Number of Lanes
CMF.

If the number of lanes is 5 or less, the method type used will be General. If the number of lanes is 6 or more, the
method type used will be Six or More Lanes. If ‘Is Major Street One-Way?’ is checked, the method type used will
be One-Way and the number of through lanes on major street will have no influence on the method type used. If
the ‘Major Street Posted Speed’ selected is '50 mi/h and over’ (or '80 km/h and over’ in metric), then the method
type used will be High-Speed.
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Number of Through Lanes on Minor Street

This indicates the number of through lanes on the minor street. It is used in the calculation of the Number of Lanes
CMF.

Number of Traffic Lanes that Oppose Left Turn

Number of lanes on the crossroad that conflict with left turn movements

Number of Unsignalized Driveways

This number represents the count of unsignalized driveways on the outside crossroad leg and within 250 feet (or
76.2 meters in metric) of the ramp terminal. The count is taken on both sides on the leg (two travel directions). The
count should only include "active" driveways (i.e., those driveways with an average daily volume of 10 veh/day or
more).

Number of Unsignalized Public Street Approaches

This number represents the count of unsignalized public street approaches on the outside crossroad leg and within
250 feet (or 76.2 meters in metric) of the ramp terminal. The count is taken on both sides on the leg (two travel
directions). If a public street is present at the terminal, then it is not counted for this entry.

See Non-Ramp Public Street Leg.

Number of Years of Observed Crashes

The Empirical Bayes analysis uses prior years of observed crash history to estimate the expected crash frequency.
This is the number of years of observed crashes used. The Highway Safety Manual recommends at least 2 years
of observed crash history should be used. Each year of observed crash history used should have the same
geometric conditions as reported on the details page.

Observed Crashes

Observed crashes for this segment or intersection occurring during the years specified. Crashes should be assigned
to the appropriate segment or intersection depending on the appropriate criteria:

1. All crashes occurring within the curb-line limits of the intersection are assigned to the intersection

2. Other crashes are assigned to the segment or the intersection depending on their characteristics. Crashes
classified on the crash report as intersection-related or have characteristics consistent with an intersection
related crash are assigned to the intersection to which they are related; such crashes would include rear-
end collisions related to queues on an intersection approach. Crashes that occur between intersections and
are not related to an intersection, such as collisions related to turning maneuvers at driveways, are assigned
to the roadway segment on which they occur.

Outbound Leg associated with a Ramp Terminal

A roundabout is considered a ramp terminal intersection if one or more of the legs connected to the roundabout is
a ramp leading to a controlled access facility, such as a freeway. This adjustment only applies to one-way outbound-
legs (i.e. legs connected to an on-ramp that only serve exiting traffic from a roundabout). Checkboxes are provided
to indicate if the subject leg is an outbound leg associated with a ramp terminal.
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Outside Shoulder Width

Represents only the paved width, and is an average for both roadbeds. Should be measured where the cross
section is constant, and should not be measured where one or more edges are discontinuous or tapered. If a width
varies along the segment or speed change lane (but not enough to justify beginning a new segment), then compute
the length-weighted average widths. Rules for defining segment boundaries are provided in section 18.5.2.

Parking

There are two broad types of parking facilities: at the curb or on-street parking, and off-street parking in lots or
parking structures. Parking safety is influenced by a complex set of driver and pedestrian attitudinal and behavioral
patterns.

Certain kinds of crashes may be caused by curb or on-street parking operations, these include:

e Sideswipe and rear-end crashes resulting from lane changes due to the presence of a parking vehicle or
contact with a parked car;

e Sideswipe and rear-end crashes resulting from vehicles stopping prior to entering the parking stall;

e Sideswipe and rear-end crashes resulting from vehicles exiting parking stalls and making lane changes;
and

e Pedestrian crashes resulting from passengers alighting from the street-side doors of parked vehicles, or
due to pedestrians obscured by parked vehicles.

Parking Type

There are three types of on-street parking. These include: No Parking, Parallel Parking, and Angle Parking. No
Parking is when parking is prohibited on the street. Parallel parking is when the vehicle parks aligned with the road.
Angle parking is when the vehicle parks on a specified angle to the curb.

Passing Lane
A lane added to improve passing opportunities in one or both directions of travel on a two-lane highway.

The base condition for passing lanes is the absence of a lane (i.e., the normal two-lane cross section). The CMF
for a conventional passing or climbing lane added in one direction of travel on a rural two-lane, two-way highway is
0.75 for total crashed in both directions of travel over the length of the passing lane from the upstream end of the
lane addition taper to the downstream end of the lane drop taper. This value assumes that the passing lane is
operationally warranted, and that the length of the passing lane is appropriate for the operational conditions on the
roadway. There may also be some safety benefit on the roadway downstream of a passing lane, but this effect has
not been quantified.

Pedestrian

A person traveling on foot or in a wheelchair

Pedestrian Activity

Pedestrian crossing volumes are categorized into general levels of Pedestrian Activity. There are five levels of
pedestrian activity. These include: High, Medium-high, Medium, Medium-low, and Low. The following table shows
estimates of pedestrian crossing volumes based on general level of pedestrian activity.
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General Level of Pedestrian Activity

Estimate of PedVol (pedestrians/day)
for Use in Equation 12-29

3SG Intersections

4SG Intersections

High

Medium
Medium
Medium

Low

-high

-low

1,700
750
400

120

3.200

1,500

700

240

n

0

Pedestrian Crash Adjustment Factor

For roadway segments, fpeqr is the pedestrian crash adjustment factor. It is used in the determination of the number
of vehicle-pedestrian collisions per year for a roadway segment. The values of fpeqr are likely to depend on the
climate and the walking environment in particular states or communities. The following tables show the pedestrian
crash adjustment factors for roadway segments, but users are encouraged to replace the values in the table with
suitable values for their own state or community through the calibration process.

Table 53. Pedestrian crash adjustment factor for two-way roadway segments.

— Road Pedestrian Crash Adjustment Factor (fpedr)
Type Posted Speed 30 mph or Lower Posted Speed Greater Than 30 mph
" Total _ Total
A m:fb “ Pe(-{:stt‘:‘]iau DLV and Fpear ) u?fbﬂ Pe(-{ : s-tt?'lian MV and Fpear
Segments Crashes ) o Segments Crashes . o
Crashes® Crashes®

p 2U 0.036 0.005
= | 0.041 0.013
L 0.022 0.009
< |4D 0.067 0.019
= T&r 0.030 0.023
- 6U 22 10 549 0.018 72 18 1359 0.013
g 6D 106 69 2377 0.029 1661 369 24720 0.015
,E: T 16 11 324 0.034 250 138 10016 0.014
= Tgp |1 1 612 122 150 6623 0.023

Note: Shaded cell = data not available.
@ Excludes pedestrian and bicycle crashes.

Table 73. Pedestrian crash adjustment factor for one-way roadway segiments.

Pedestrian Crash Adjustment Factor (fpear)
Posted Speed 30 mph or Lower Posted Speed Greater Than 30 mph
‘ Road . Total : Total
Souree | yepe | N el P M B | T i MY s frea
Segments Crashes Crashes® Segments Crashes Ciiahias

T 20 774 48 2767 0.017 216 12 676 0.018
é 30 395 52 2217 0.024 162 15 911 0.017
1=
A 40 81 1 342 0.021 57 12 405 0.030

# Excludes pedestrian and bicycle crashes.

For intersections, feqi is the pedestrian crash adjustment factor. It is used in the determination of the number of
vehicle-pedestrian collisions per year for a stop-controlled intersection. The values of fpeqi are likely to depend on
the climate and walking environment in particular states or communities. The following table shows the pedestrian
crash adjustment factors for stop-controlled intersections, but users are encouraged to replace the values in the

table with suitable values for their own state or community through the calibration process.
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Table 12-29. Pedestrian Crash Adjustment Factors for Stop-Controlled Intersections

Intersection Category Intersection Type Pedestrian Crash Adjustment Factor (fpea)
35T 0.021

2x2 with five or fewer lanes :
4ST 0.022
35T 0.051

2x2 with six or more lanes
4ST 0.049

152 o 1x 35T 0.015

R 4ST 0.020

Note: These factors apply to the methodology for predicting total crashes (all severity levels combined). All pedestrian collisions resulting from this
adjustment factor are treated as FI crashes and none as PDO crashes.

Source: HSIS data from California (2002-2006) for 22 intersections with five or fewer lanes; HSIS data from California and Illinois (2006-2010) and
state data from Texas (2008-2012) and Michigan (2008-2012) for other intersection categories.

Pedestrian Crosswalk

Pedestrian roadway crossing facility that represents a legal crosswalk at a particular location.

Pedestrian Refuge

An at-grade opening within a median island that allows pedestrians to wait for an acceptable gap in traffic.

pLT/D

pLmp is left-turn crashes susceptible to correction by a TWLTL as a proportion of driveway-related crashes. It is used
in the calculation of CMFy, (i.e., Two-Way Left-Turn Lanes CMF) for rural two-lane segments. The value of p 7o is
estimated as 0.5, and as such, is hardcoded as 0.5 in HSS.

Posted Speed

This is the speed limit, in mi/h (or km/h in metric), that is posted for the roadway.

Predicted Average Crash Frequency

The estimate of long-term average crash frequency which is forecast to occur at a site using a predictive model
found in Part C of the HSM.

Predictive Method

The methodology in Part C of the HSM used to estimate the ‘expected average crash frequency’ of a site, facility,
or roadway under given geometric conditions, traffic volumes, and period of time.

Presence of School

The base condition for schools is the absence of a school near the intersection. The CMF for schools within 1,000
ft (or 304.8 meters in metric) of the center of the intersection is presented in the following table:

Presence of Schools within 1,000 ft of the Intersection CMF:‘,
No school present 1.00
School present 1.35
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A school may be counted if any portion of the school grounds is within 1,000 ft (or 304.8 meters in metric) of the
intersection. Where one or more schools are located near the intersection, the value of the CMF is independent of
the number of schools present. This CMF applies to total vehicle-pedestrian collisions.

This CMF indicates that an intersection with a school nearby is likely to experience more vehicle-pedestrian
collisions than an intersection without schools even if the traffic and pedestrian volumes at the two intersections are
identical. Such increased crash frequencies indicate that school children are at higher risk than other pedestrians.

Project Description

This field is provided for the user to document the analysis with any information for identification purposes.

Project-Level Parameters

A checkbox is provided on the General page of a facility analysis for the user to indicate if parameters should be
applied on a level that is project wide or if separate section-level parameters should be provided on the Details page
of each section. Checking the box will indicate the project-level parameters will be applied to all the corresponding
sections. Leaving the checkbox unchecked will indicate each section will apply its own parameters.

Proportion of AADT during High Volume Hours

Proportion of freeway AADT volume that occurs during hours where the lane volume exceeds 1,000 vehicles per
hour per lane. If local data is not available, a default value can be computed as 1.0 — exp(1.45 — 0.000124 x AADT
/ n), where n is the number of lanes in both directions, and AADT is total AADT for both directions.

Proportion of Barrier on Outside Shoulder

Length of barrier present divided by length of segment

Proportion of Crashes that Occur at Night

For segments, this is the proportion of total crashes for unlighted roadway segments that occur at night. It is denoted
by pnr. The tables below show the nighttime crash proportions for unlighted roadway segments based on roadway

type.
Rural Two-Lane, Two-Way Roads (Chapter 10)

Proportion of Total Nighttime Crashes by Severity Level Proportion of Crashes that Occur at Night
Roadway Tvpe Fatal and Injury p, PDO Do r,
2U 0.382 0.618 0.370

Note: Based on HSIS data for Washington (2002-2006)

Rural Multilane Highways (Chapter 11)

Proportion of Crashes that

Roadway Type Proportion of Total Night-Time Crashes by Severity Level Occur at Night
Fatal and Injury p, PDO Py Py
4U 0.361 0.639 0.255

Proportion of Crashes that

Proportion of Total Nighttime Crashes|by Severity Level Occur at Night
Roadway Type Fatality and Injury p, PDO Dy P,
4D 0.323 0.677 0426
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Urban and Suburban Arterials (Chapter 12)

Proportion of Total Nighttime Crashes by Severity Level Proportion of Crashes that Occur at Night
Roadway Segment Type Fatal and Injury p, PDO P P,
20 0424 0.576 0316
3T 0.429 0.571 0.304
4U 0.517 0483 0.365
4D 0.364 0.636 0410
5T 0432 0.568 0.274

For intersections, this is the proportion of total crashes for unlighted intersections that occur at night. It is denoted
by pni. The tables below show the nighttime crash proportions for unlighted intersections.

Rural Two-Lane, Two-Way Roads (Chapter 10)

Proportion of Crashes that Occur at Night

Intersection Type P,

38T 0.1-60
48T 0.244
4SG 0.286

Note: Based on HSIS data for California (2002-2006)

Rural Multilane Highways (Chapter 11)

Intersection Type Proportion of Crashes that Occur at Night, p .
3ST 0.276
4ST 0.273

Urban and Suburban Arterials (Chapter 12)

Proportion of Crashes that Occur at ;“iight|

Intersection Type Py

3ST 0.238
45T 0.229
35G and 45G 0:235

Proportion of Fatal-and-Injury Crashes for Combined Sites

Since there are no models for fatal-and-injury crashes at three- and four-leg stop-controlled urban intersections
(3ST and 4ST) in HSM Table 12-12, HSM Equation 12-25 is replaced with the following equation in these cases:

Nhisvryy = Nbisvtotal) X Toisv
where:
fvisv = proportion of fatal-and-injury crashes for combined sites.

The default value of fyisy is 0.31 for 3ST and 0.28 for 4ST intersections. It is recommended that these default values
be updated based on locally available data.
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Proportion of Length Adjacent to Speed Change Lane

If there is a speed change area due to a second merging or diverging ramp, this is the length of that speed change
area divided by the length of the segment.

Proportion of Length Adjacent to Taper
This is the length of the taper within the segment divided by the segment length.

Proportion of Length within a Type B Weaving Section

This weaving section has the following characteristics: (a) one of the two weaving movements can be made without
making any lane changes, (b) the other weaving movement requires at most one lane change, and (c) the ramp
entrance and ramp exit associated with the weaving section are located on the right side of the freeway.

Typical Type B weaving sections are shown in the figure below.

a. Major Weave with Lane Balance
at Exit Gore

b. Major Weave with Merge
at Entry Gore

c. Major Weave with Merge at Entry
Gore and Lane Balance at Exit Gore

Other weaving section types are addressed directly by the predictive method.

The proportion is the length of the weaving section located in the segment divided by the length of the segment.
This value is computed separately for the increasing and decreasing milepost directions.

Proportion of Length within a Weaving Segment

Computed as the ratio of the length of the weaving section in the segment to the length of the segment. If the
segment is wholly located in the weaving section, then this variable is equal to 1.0.
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Proportion of Median Barrier Length

Length of barrier present divided by the length of segment. A barrier is associated with the freeway if the offset from
the near edge of traveled way is 30 feet (or 9.1 meters in metric) or less. Barrier adjacent to a ramp, but also within
30 feet (or 9.1 meters in metric) of the freeway traveled way should also be associated with the freeway.

Proportion of Multiple-Vehicle Crashes Represented by Rear-End Collisions

This is the proportion of crashes that are multiple-vehicle, rear-end collisions and it is denoted by p. The proportion
of multiple-vehicle fatal-and-injury crashes represented by rear-end collisions is denoted by premvry. The proportion
of multiple-vehicle property-damage-only crashes represented by rear-end collisions is denoted by premvrpoy).

These proportions are used in the calculation of the Red Light Cameras CMF, rather than the proportions provided
in the crash distributions tables. The defaults between the two are the same, but they can all be edited.

Proportion of Multiple-Vehicle Crashes Represented by Right-Angle
Collisions

This is the proportion of crashes that are multiple-vehicle, right-angle collisions and it is denoted by pr.. The
proportion of multiple-vehicle fatal-and-injury crashes represented by right-angle collisions is denoted by pramv(F).

The proportion of multiple-vehicle property-damage-only crashes represented by right-angle collisions is denoted
by pramvPpO)-

These proportions are used in the calculation of the Red Light Cameras CMF, rather than the proportions provided
in the crash distributions tables. The defaults between the two are the same, but they can all be edited.

Proportion of Nighttime Crashes that Involve a Fatality

This is the proportion of total nighttime crashes for unlighted roadway segments that involve a fatality or injury. It is
denoted by pin. The tables below show the nighttime crash proportions for unlighted roadway segments based on
roadway type.

Rural Two-Lane, Two-Way Roads (Chapter 10)

Proportion of Total Nighttime Crashes by Severity Level Proportion of Crashes that Occur at Night
Roadway Tvpe Fatal and Injury p, PDO Pour P,
2U 0.382 0.618 0.370

Note: Based on HSIS data for Washington (2002-2006)

Rural Multilane Highways (Chapter 11)

Proportion of Crashes that

Roadway Type Proportion of Total Night-Time Crashes by Severity Level Occur at Night
Fatal and Injury p, PDO . P,
4U 0361 0.639 0.255

Proportion of Crashes that

Proportion of Total Nighttime Crashes|by Severity Level Occur at Night
Roadway Type Fatality and Injury p_ PDO D P,
4D 0.323 0.677 0.426

Highway Safety Software User Guide Glossary of Terms - 93



Urban and Suburban Arterials (Chapter 12)

Proportion of Total Nighttime Crashes by Severity Level Proportion of Crashes that Occur at Night

Roadway Segment Type Fatal and Injury p, PDO P P,

20 0424 0.576 0316
3T 0.429 0.571 0.304
4U 0.517 0483 0.365
4D 0.364 0.636 0410
5T 0432 0.568 0.274

Proportion of Nighttime Crashes that Involve Property Damage

This is the proportion of total nighttime crashes for unlighted roadway segments that involve property damage only.
It is denoted by ppn. The tables below show the nighttime crash proportions for unlighted roadway segments based
on roadway type.

Rural Two-Lane, Two-Way Roads (Chapter 10)

Proportion of Total Nighttime Crashes by Severity Level Proportion of Crashes that Occur at Night
Roadway Tvpe Fatal and Injury p, PDO . P,
2U 0.382 0.618 0.370

Note: Based on HSIS data for Washington (2002-2006)

Rural Multilane Highways (Chapter 11)

Proportion of Crashes that

Roadway Type Proportion of Total Night-Time Crashes by Severity Level Occur at Night
Fatal and Injury p, PDO Py Py
4U 0.361 0.639 0.255

Proportion of Crashes that

Proportion of Total Nighttime Crashes|by Severity Level Occur at Night
Roadway Type Fatality and Injury p, PDO Dy P,
4D 0.323 0.677 0426

Urban and Suburban Arterials (Chapter 12)

Proportion of Total Nighttime Crashes by Severity Level Proportion of Crashes that Occur at Night

Roadway Segment Type Fatal and Injury p, PDO Dis P

2U 0424 0.576 0.316
3T 0.429 0.571 0.304
4U 0.517 0483 0.365
4D 0.364 0.636 0410
5T 0432 0.568 0274

Proportion of Related Crashes

This is the proportion of total crashes constituted by related crashes. It is denoted by py-.
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Proportion of Rumble Strips on Inside Shoulders

Length of rumble strips divided by the length of the roadway. Rumble strips are devices designed to give strong
auditory and tactile feedback to errant vehicles leaving the travel way.

Proportion of Rumble Strips on Outside Shoulders

Length of rumble strips divided by the length of the roadway. Rumble strips are devices designed to give strong
auditory and tactile feedback to errant vehicles leaving the travel way.

Protected Left-Turn

This information is needed for each crossroad left-turn movement that exists at the terminal. An affirmative response
is indicated if the left-turn operates as protected only. If it operates as permissive or protected-permissive, then the
response is negative.

Ramp Length

Length of entrance or exit ramp. Measured from the gore point to the taper point.

Ramp Terminal Type

There are many different configurations of crossroad ramp terminals used at interchanges. Configurations include
D3ex, D3en, D4, A4, B4, A2, B2, SP, and TD. They are identified below. Differences among the terminals shown
below reflect the number of ramp legs, number of left-turn movements, location of crossroad left-turn storage (i.e.,
inside or outside of the interchange), and control type (i.e., signalized or stop controlled).

Exit Ramp Freeway
Outside Inside
+ >
approach approach

A R A A IS

= =1

Inside Outside
el
approach approach
Exit Ramp

Three-Leg Ramp Terminal with Diagonal Exit Ramp (D3ex)
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Exit Ramp
Outside Inside
—
approach approach

Freeway

Inside
approach

Exit Ramp

Outside
approach

Three-Leg Ramp Terminal with Diagonal Exit Ramp (D3ex)

Exit Ramp
Outside Inside
> ——
approach approach

Freeway

Inside
approach

Exit Ramp

Three-Leg Ramp Terminal with Diagonal Exit Ramp (D3ex)

—

Outside
approach
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Outside

approach

Inside
approach

Entrance Ramp

Freeway

Entrance Ramp

Inside
—
approach

Outside

approach

Outside

approach

Three-Leg Ramp Terminal with Diagonal Entrance Ramp (D3en)

Inside
approach

Entrance Ramp

Freeway

Entrance Ramp

Inside
approach

Three-Leg Ramp Terminal with Diagonal Entrance Ramp (D3en)

Outside

approach
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Freeway Entrance Ramp

Inside Outside
| | —
approach approach

Outside Inside
- . gl |
pproach approach
| |
| |
Entrance Ramp

Three-Leg Ramp Terminal with Diagonal Entrance Ramp (D3en)

Exit Ramp Freeway Entrance Ramp

Inside
approach

Outside
approach

Outside
approach

Inside
approach

Entrance Ramp Exit Ramp

Four-Leg Ramp Terminal with Diagonal Ramps (D4)
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Exit Ramp Freeway Entrance Ramp

Inside
approach

Outside
approach

approach approach

Entrance Ramp Exit Ramp

Four-Leg Ramp Terminal with Diagonal Ramps (D4)

Exit Ramp Freeway Entrance Ramp

Inside
approach

Outside
approach

Outside
approach

approach

Entrance Ramp Exit Ramp

Four-Leg Ramp Terminal with Diagonal Ramps (D4)
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Exit Entrance
Ramp Ramp

Outside
approach

Entrance
Ramp

Inside
approach

Inside
approach

Outside
approach

Entrance Exit
Ramp Ramp

Four-Leg Ramp Terminal at Four-Quadrant Partial Cloverleaf A (A4)

Exit Entrance
Ramp Ramp

Outside
approach

Entrance
Ramp

Freeway

Inside
approach

Inside
approach

Entrance
Ramp

Outside
approach

Entrance Exit
Ramp Ramp

Four-Leg Ramp Terminal at Four-Quadrant Partial Cloverleaf A (A4)
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Exit Entrance
Ramp Ramp

Inside
approach

Outside
approach

Outside
approach

Inside
approach

Entrance Entrance Exit
Ramp Ramp Ramp

Four-Leg Ramp Terminal at Four-Quadrant Partial Cloverleaf A (A4)

Exit Entrance

Exit Ramp Freeway Ramp Ramp

Inside
approach

Outside
approach

Outside
approach

Inside
approach

Entrance Exit

Exit Ramp
Ramp Ramp

Four-Leg Ramp Terminal at Four-Quadrant Partial Cloverleaf B (B4)
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. Exit Entrance
Exit Ramp Ramp Ramp

Outside Inside
e
approach approach

Inside Outside
.
approach approach

Entrance Exit ' . Exit Ramp
Ramp Ramp

Four-Leg Ramp Terminal at Four-Quadrant Partial Cloverleaf B (B4)

. Exit Entrance
Exit Ramp Freeway Ramp Ramp

Outside Inside
——y
approach approach

Inside Outside
R
approach approach

Entrance Exit - ' Exit Ramp
Ramp Ramp

Four-Leg Ramp Terminal at Four-Quadrant Partial Cloverleaf B (B4)
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Exit Entrance
Ramp Ramp Freeway

Inside | I
approach

Outside
approach

Outside
approach

Inside
| | approach

Entrance Exit
Ramp Ramp

Three-Leg Ramp Terminal at Two-Quadrant Partial Cloverleaf A (A2)

Exit Entrance
Ramp Ramp Freeway

Inside | |
approach

Outside
approach

- =
0O YL N
—~ =

Inside

————
| | approach approach

Entrance Exit
Ramp Ramp

Three-Leg Ramp Terminal at Two-Quadrant Partial Cloverleaf A (A2)
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Exit Entrance
Ramp Ramp

Outside
approach

Inside
approach

Freeway

Three-Leg Ramp Terminal at Two-Quadrant Partial Cloverleaf A (A2)

Outside
approach

Entrance Exit
Ramp Ramp

Inside

approach

Inside Outside
| approach approach
Entrance Exit
Ramp Ramp
Exit Enti

Freeway ' Ramp 'barg:,e
Inside Outside
approach approach

Three-Leg Ramp Terminal at Two-Quadrant Partial Cloverleaf B (B2)
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Exit Entrance
Freeway Ramp Ramp

| Inside
approach

Outside

approach approach

Entrance Exit
Ramp Ramp

Three-Leg Ramp Terminal at Two-Quadrant Partial Cloverleaf B (B2)

Exit Entrance
Freeway ' Ramp Ram

Outside
approach

| Inside
approach

Inside
approach

Outside
approach

Entrance Exit
Ramp Ramp

Three-Leg Ramp Terminal at Two-Quadrant Partial Cloverleaf B (B2)
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Entrance Exit
Ramp Ramp

Single-Point Diamond Interchange Ramp Terminal

Exit Entrance
Ramp F reeway

Entrance Exit
Ramp Ramp

Tight Diamond Interchange Ramp Terminal
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Ramp Type

There are two types of ramps: entrance ramp and exit ramp. An entrance ramp is a ramp from a crossroad to a
freeway. An exit ramp is a ramp from a freeway to a crossroad.

Red Light Cameras
These are cameras installed for enforcement of red signal violations at a signalized intersection.

The base condition for red light cameras is their absence. A study indicates a CMF for red light camera installation
of 0.74 for right-angle conditions and a CMF of 1.18 for rear-end collisions. In other words, red light cameras would
typically be expected to reduce right-angle collisions and increase rear-end collisions. There is no evidence that red
light camera installation affects other collision types.

Right Shoulder Width

For one-way arterials, the right shoulder width is measured at successive points along the roadway. An average
shoulder width is computed for each point and this average is rounded to the nearest 1.0 ft. A new segment is
started if the rounded value for the current point changes from that of the previous point (e.g., from 6 to 7 ft). Right
shoulder width is measured in feet (or meters in metric) and is used in the calculation of the Right Shoulder Width
CMF.

Right-Turn Bypass Lane

A right-turn bypass lane is a lane, typically for right turns but sometimes for through movements at T-intersections,
that is separated from the adjacent entry lane either by a channelized island or pavement markings used to create
physical, horizontal separation between the bypass lane and the adjacent roundabout entry lanes. Right-turn bypass
lanes should not be included in the count of number of entering lanes on a leg.

Right-Turn Channelization

This channelization creates a turning roadway that serves right-turn vehicles. It is separated from the intersection
by a triangular channelizing island (delineated by markings or raised curb). The gore point at the upstream end of
the island must be within 200 ft (or 61.0 meters in metric) of the downstream stop line for the right turn channelization
to be considered "present". If this distance exceeds 200 ft (or 61.0 meters in metric), then the right-turn movement
can be free-flow, stop, or yield controlled.

Right-Turn Lane Present on Crossroad Leg

The lane (or bay) can have one or two lanes. A lane (or bay is considered to be present when it (a) is for the
exclusive use of a turn movement, (b) extends 100 ft (or 30.5 meters in metric) or more back from the stop line, and
(c) satisfies one of the following rules:

e |If the bay or turn lane does not have island channelization at the intersection, then it must end at the
intersection stop line.

o If the bay or turn lane has island channelization at the intersection, then the bay or turn lane must have (a)
stop, yield, or signal control at its downstream end, and (b) an exit gore point that is within 200 ft (or 61.0
meters in metric) of the intersection.

The Crossroad Right-Turn Lane CMF is applicable to any crossroad approach that is either signalized or
uncontrolled. It is not applicable to a stop-controlled approach. The CMF value is applicable to turn bays that have
a design that is consistent with agency policy such that their length adequately provides for vehicle storage or
deceleration, as appropriate.
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Right-Turn Lanes

The lane (or bay) can have one or two lanes. A lane (or bay is considered to be present when it (a) is for the
exclusive use of a turn movement, (b) extends 100 ft (or 30.5 meters in metric) or more back from the stop line, and
(c) satisfies one of the following rules:

o If the bay or turn lane does not have island channelization at the intersection, then it must end at the
intersection stop line.

e If the bay or turn lane has island channelization at the intersection, then the bay or turn lane must have (a)
stop, yield, or signal control at its downstream end, and (b) an exit gore point that is within 200 ft (or 61.0
meters in metric) of the intersection.

The base condition for intersection right-turn lanes is the absence of right-turn lanes on the intersection approaches.
CMFs apply to installation of right-turn lanes on any approach to a signalized intersection, but only on uncontrolled
major road approaches to stop-controlled intersections. The CMFs for installation of right-turn lanes on multiple
approaches to an intersection are equal to the corresponding CMF for installation of a right-turn lane on one
approach raised to a power equal to the number of approaches with right-turn lanes. There is no indication of any
safety effect for providing a right-turn lane on an approach controlled by a stop sign, so the presence of a right-turn
lane on a stop-controlled approach is not considered in applying the table found below:

Number of Approaches with Right-Turn Lanes®

Intersection Type Intersection Traffic Control One Approach  Two Approaches  Three Approaches  Four Approaches
Three-Leg Intersection Minor road stop control® 0.86 0.74 — —
Minor road stop control® 0.86 0.74 — —

Four-Leg Intersection
Traffic signal 0.96 0.92 0.88 0.85

3 Stop-controlled approaches are not considered in determining the humber of approaches with right-turn lanes.
b Stop signs present on minor road approaches only.

The CMFs in the table apply to total intersection crashes. A CMF values of 1.00 is always used when no right-turn
lanes are present. This CMF applies only to right-turn lanes that are identified by marking or signing. The CMF is
not applicable to long tapers, flares, or paved shoulders that may be used informally by right-turn traffic.

Road Type

Road Type refers to the land use. There are two categories of Road Type. These include: Residential/Other and
Commercial or Industrial/Institutional.

Roadside

The area between the outside shoulder edge and the right-of-way limits. The area between roadways of a divided
highway may also be considered roadside.

Roadside geometry refers to the physical layout of the roadside, such as curbs, foreslopes, backslopes, and
transverse slopes.

Designing a roadside environment to be clear of fixed objects with stable flattened slopes is intended to increase
the opportunity for errant vehicles to regain the roadway safely or to come to a stop on the roadside. This type of
roadside environment, called a “forgiving roadside,” is also designed to reduce the chance of serious consequences
if a vehicle leaves the roadway.

Roadside features include signs, signals, luminaire supports, utility poles, trees, driver-aid call boxes, railroad
crossing warning devices, fire hydrants, mailboxes, bus shelters, and other similar roadside features.
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Roadside Barrier

A longitudinal device used to shield drivers from natural or man-made objects located along either side of a traveled
way. It may also be used to protect bystanders, pedestrians, and cyclists from vehicular traffic under special
conditions.

Roadside Fixed Objects

These are objects fixed on the side of the roadway.

The base condition is the absence of roadside fixed objects on a roadway segment.

Roadside Hazard Rating

Considers the clear zone in conjunction with the roadside slope, roadside surface roughness, recoverability of the
roadside, and other elements beyond the clear zone such as barriers or trees. As the RHR increases from 1 to 7,
the crash risk for frequency and/or severity increases.

Roadway

The portion of a highway, including shoulders, for vehicular use.

Roadway Segment

A portion of a road that has a consistent roadway cross-section and is defined by two endpoints.

Rumble Strips
Devices designed to give strong auditory and tactile feedback to errant vehicles leaving the travel way.

Centerline rumble strips are installed on undivided highways along the centerline of the roadway which divides
opposing directions of traffic flow. Centerline rumble strips are incorporated in the roadway surface to alert drivers
who unintentionally cross, or begin to cross, the roadway centerline. The base condition for centerline rumble strips
is the absence of rumble strips.

Rural Areas

Places outside the boundaries of urban growth boundary where the population is less than 5,000 inhabitants.

Safety

The number of crashes, by severity, expected to occur on the entity per unit of time. An entity may be a signalized
intersection, a road segment, a driver, a fleet of trucks, etc.

Safety Performance Function (SPF)

An equation used to estimate or predict the expected average crash frequency per year at a location as a function
of traffic volume and in some cases roadway or intersection characteristics (e.g., number of lanes, traffic control, or
type of median).

Section

The sections of a facility are numbered in a natural order (1, 2, 3, etc.). A drop-down menu is provided to select
which section details to show.
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Section Name

This field is provided for each section to identify the section or specify the start point and end point of the section
under analysis.

Section Type

This specifies whether the section being analyzed is a Segment or an Intersection.

Segment
A portion of a facility on which a crash analysis is performed. A segment is defined by two endpoints.

See also Roadway Segment.

Shoulder

A portion of the roadway contiguous with the traveled way for accommodation of pedestrians, bicycles, stopped
vehicles, emergency use, as well as lateral support of the subbase, base, and surface courses.

Shoulder Type

There exists four shoulder types: paved, gravel, composite, and turf.

Shoulder Width

The width of the shoulder, in feet (or meters in metric).

Sideslope

A sideslope is a roadway cross-section element. It is the slope of the cut or fill expressed as a ratio of vertical
distance to horizontal distance. The CMF for the sideslope for undivided roadway segments of rural multilane
highways is presented in the following table:

1:6 1:7 or Flatter

h

1:2 or Steeper 1:3 1:4 1:

1.18 1.15 1.12

—
(=]
Yol

1.05 1.00

The base conditions are for a sideslope of 1:7 or flatter.

Site

Project location consisting of, but not limited to, intersections, ramps, interchanges, at-grade rail crossings, roadway
segments, etc.

Site Type

The following table identifies the site types on rural two-lane, two-way roads for which SPFs have been developed
from predicting average crash frequency, severity, and collision type.
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Site Type Site Types with SPFs in Chapter 10

Roadway Segments Undivided rural two-lane, two-way roadway segments (2U)

Unsignalized three-leg (stop control on minor-road approaches) (3ST)

Intersections Unsignalized four-leg (stop control on minor-road approaches) (4ST)

Signalized four-leg (4SG)

These specific site types are defined as follows:

Undivided roadway segment (2U)—a roadway consisting of two lanes with a continuous cross-section
providing two directions of travel in which the lanes are not physically separated by either distance or a
barrier. In addition, the definition includes a section with three lanes where the center lane is a two-way left-
turn lane (TWLTL) or a section with added lanes in one or both directions of travel to provide increased
passing opportunities (e.g., passing lanes, climbing lanes, and short four-lane sections).

Three-leg intersection with stop control (3ST)—an intersection of a rural two-lane, two-way road and a minor
road. A stop sign is provided on the minor road approach to the intersection only.

Four-leg intersection with stop control (4ST)—an intersection of a rural two-lane, two-way road and two
minor roads. A stop sign is provided on both minor road approaches to the intersection.

Four-leg signalized intersection (4SG)—an intersection of a rural two-lane, two-way road and two other rural
two-lane, two-way roads. Signalized control is provided at the intersection by traffic lights.

The following table identifies the site types on rural multilane highways for which predictive models have been
developed for estimating expected average crash frequency, severity, and collision type. The four-leg signalized
intersection models do not have base conditions and, therefore, can be used only for generalized predictions of
crash frequencies.

Site Type Site Types with SPFs in Chapter 11

Roadway Segments Rural four-lane undivided segments (417)

Rural four-lane divided segments (4D)

Intersections Unsignalized three-leg (Stop control on minor-road approaches) (38T)

Unsignalized four-leg (Stop control on minor-road approaches) (4ST)

Signalized four-leg (45G)

These specific site types are defined as follows:

Undivided four-lane roadway segment (4U)—a roadway consisting of four lanes with a continuous cross-
section which provides two directions of travel in which the lanes are not physically separated by either
distance or a barrier. When multilane roadways whose opposing lanes are separated by a flush median
(i.e., a painted median) are considered undivided facilities, not divided facilities, the predictive models in
Chapter 11 do not address rural multilane highways with flush separators.

Divided four-lane roadway segment (4D)-Divided highways are non-freeway facilities (i.e., facilities without
full control of access) that have the lanes in the two directions of travel separated by a raised, depressed,
or flush median which is not designed to be traversed by a vehicle; this may include raised or depressed
medians with or without a physical median barrier, or flush medians with physical median barriers.

Three-leg intersection with stop control (3ST)—an intersection of a rural multilane highway (i.e., four lane
divided or undivided roadway) and a minor road. A stop sign is provided on the minor-road approach to the
intersection only.
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Four-leg intersection with stop control (4ST)—an intersection of a rural multilane highway (i.e., four lane
divided or undivided roadway) and two minor roads. A stop sign is provided on both minor-road approaches
to the intersection.

Four-leg signalized intersection (4SG)—an intersection of a rural multilane highway (i.e., four lane divided
or undivided roadway) and two other rural roads which may be two lane or four land rural highways.
Signalized control is provided at the intersection by traffic lights.

The following table identifies the specific site types on urban and suburban arterial highways that have predictive
models. Separate SPFs are used for each individual site to predict multiple-vehicle nondriveway collisions, single-
vehicle collisions, driveway-related collisions, vehicle-pedestrian collisions, and vehicle-bicycle collisions for both
roadway segments and intersections. These are combined to predict the total average crash frequency at an

individual site.

Site Tyvpe Site Types with SPFs in Chapier 12

Roadway Segments Two-lane undivided arterials (2U)
Three-lane arterials including a center TWLTL (3T)
Four-lane undivided arterials (410
Four-lane divided arierlals (including a ralsed or depressed median) (4D)
Five-lane arierials including a center TWLTL (5T)
Six-lane undivided arterials (61)
Six-lane divided arterials (Including a ralsed or depressed median) (6D)
Seven-lane arterials including a center TWLTL (7T)
Eighi-lane divided arierlals {including a raised or depressed median) (8D)
Two-lane one-way arterials (20J)
Three-lane one-way arterials (30)
Four-lane one-way arerials (40)

Intersectlons Unsignalized three-leg intersectlon (stop control on minor-road approaches) (35T)

Signalized three-leg intersection {35G)
Unsignalized four-leg intersection (stop conirol on minor-road approaches) (45T)
Signalized four-leg intersection (45G)

These specific site types are defined as follows:

Two-lane undivided arterial (2U)—a roadway consisting of two lanes with a continuous cross-section
providing two directions of travel in which the lanes are not physically separated by either distance or barrier.

Three-lane arterials including a center TWLTL (3T)—a roadway consisting of three lanes with a continuous
cross-section providing two directions of travel in which center lane is a two-way left-turn lane (TWLTL).

Four-lane undivided arterials (4U)—a roadway consisting of four lanes with a continuous cross-section
providing two directions of travel in which the lanes are not physically separated by either distance or a
barrier.

Four-lane divided arterials (including a raised or depressed median) (4D)—a roadway consisting of four
lanes with a continuous cross-section providing two directions of travel in which the lanes are physically
separated by either distance or a barrier.

Five-lane arterials including a center TWLTL (5T)—a roadway consisting of five lanes with a continuous
cross-section providing two directions of travel in which the center lane is a two-way left-turn lane (TWLTL).

Six-lane undivided arterial (6U)—a roadway consisting of six lanes with a continuous cross-section
providing two directions of travel in which the lanes are not physically separated by either distance or a
barrier.

Six-lane divided arterials (including a raised or depressed median) (6D)—a roadway consisting of six lanes
with a continuous cross-section providing two directions of travel in which the lanes are physically separated
by either distance or a barrier.
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Seven-lane arterials including a center TWLTL (7T)—a roadway consisting of seven lanes with a continuous
cross-section providing two directions of travel in which the center lane is a TWLTL.

Eight-lane divided arterials (including a raised or depressed median) (8D)—a roadway consisting of right
lanes with a continuous cross-section providing two directions of travel in which the lanes are physically
separated by either distance or a barrier.

Two-lane one-way arterial (20)—a roadway consisting of two lanes with a continuous cross-section
providing one direction of travel in which the lanes are not physically separated by either distance or a
barrier.

Three-lane one-way arterial (30)—a roadway consisting of three lanes with a continuous cross-section
providing one direction of travel in which the lanes are not physically separated by either distance or a
barrier.

Four-lane one-way arterial (40)—a roadway consisting of four lanes with a continuous cross-section
providing one direction of travel in which the lanes are not physically separated by either distance or a
barrier.

Three-leg intersection with stop control (3ST)—an intersection of an urban or suburban arterial and a minor
road. A stop sign is provided on the minor road approach to the intersection only.

Three-leg signalized intersection (3SG)—an intersection of an urban or suburban arterial and one minor
road. Signalized control is provided at the intersection by traffic signals.

Four-leg intersection with stop control (4ST)—an intersection of an urban or suburban arterial and two minor
roads. A stop sign is provided on both the minor road approaches to the intersection.

Four-leg signalized intersection (4SG)—an intersection of an urban or suburban arterial and two minor
roads. Signalized control is provided at the intersection by traffic signals.

Skew Angle, Exit Ramp

Skew angle equals 90 minus the intersection angle, in degrees. The intersection angle is the acute angle between
the crossroad centerline and a line along the center of an imaginary vehicle stopped at the end of the ramp (i.e.,
where it joins the crossroad). The vehicle is centered in the traveled way and behind the stop line. If vehicles can
exit the ramp as left- or right-turn movements, then use a left-turning vehicle as the vehicle of reference. This
information is needed only for terminals with one-way stop control. At a B4 terminal configuration, the skew angle
represents that for the diagonal exit ramp (not the loop exit ramp). The following figure shows the exit ramp skew
angle (one-way stop control):

Skew angle

Intersection

angle Inside approach \ Outside approach

Crossroad

1 1
— i
Outside approach Inside approach | ! ! Intersection
! ! angl
gle
1 1
| 1
If a left-turn movement is not served : :
by the ramp, then reference angles to 1 '
a right-turn vehicle at the stop line. Reference angles to a left-turn vehicle at the stop line.
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Skew Angle, Intersection

The skew angle for an intersection is defined as the absolute value of the deviation from an intersection angle of 90
degrees. The absolute value is used in the definition of skew angle because positive and negative skew angles are
considered to have similar detrimental effect. The base condition of intersection skew angle is zero degrees of skew
(i.e., an intersection angle of 90 degrees).

If the skew angle differs for the two minor road legs at a four-leg stop-controlled intersection, values of CMFy; is
computed separately for each minor road leg and then averaged.

Since the traffic signal separates most movements from conflicting approaches, the risk of collisions related to skew
angle between the intersecting approaches is limited at a signalized intersection. Therefore, the CMF for skew angle
at four-leg signalized intersections is 1.00 for all cases.

Speed-Change Lane

When using the predictive method, the freeway within the defined project limits is divided into individual sites. A site
is either a homogenous freeway segment or a speed-change lane. A facility consists of a contiguous set of individual
sites. A roadway network consists of a number of contiguous facilities.

A speed-change land site is defined as the section of the roadway area located (a) between the marked gore and
taper points of a ramp merge or diverge area, and (b) on the same side of the freeway as the merge or diverge
area. The location of the gore and taper points is defined in the figure below.

Entrance Ramp with Parallel Design
| Ramp Entrance Length |

...................................................... SE—
- /7: '\Taper point

Exit Ramp with Taper Design
I Ramp Exit Length |

Taper point / \

* Point where marked gore is 2 ft wide (gore point)
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Two speed-change lanes are shown schematically in the figure below. The speed-change lane associated with an
entrance ramp is labeled SCs, and that associated with an exit ramp is labeled SCex.

PLAN VIEW

Ramp Entrance Ramp Exit Length,

La
_ Length, Lgp | Cross ‘ = .
™ i Ramp -road Ramp
4 SCen FCey
Y — 7|7/ 7 "Freel®y  ~_ ~— — /70 T 7 7
b e B o e o o o ol o GRRE o o o s o e oo o R o
Ly o Lesa o Less
COMPOMENT PARTS
Speed-Change Lane Speed-Change Lane
Type: ramp entrance Type: ramp exit
Seg. length =L, Seg. length =L,
Freeway Segment
Effective segment length, L' = le —Lep/2 — Lgy!2
ERSECR e - o e e S N o - . e R o L - L ot T - - B R 2 1|

Mate: Freeway segment length does nat include the length of speed-change lanes if these lanes are adjacent to the segment

Spiral Transition

A spiral transition provides a gradual transition from moving in a straight line to moving in a curve around a point,
and vice versa. Spiral transitions are considered part of the horizontal curve they adjoin.

When a horizontal curve is present, it is necessary to specify the presence or absence of a spiral transition curve
at the beginning and end of the horizontal curve, even if the beginning and/or end of the horizontal curve are beyond
the limits of the segment being analyzed.

Superelevation

The banking of a roadway in a curve to counteract lateral acceleration.
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Superelevation Variance

This represents the superelevation rate contained in the AASHTO Green Book minus the actual superelevation of
the curve. This is denoted by SV and is measured in ft/ft (or m/m in metric).

Taper Area

An area characterized by a reduction or increase in pavement width, typically located between mainline and ramp
or areas with lane reductions.

Traffic Barrier

A device used to prevent a vehicle from striking a more severe obstacle or feature located on the roadside or in the
median or to prevent crossover median crashes. There are four classes of traffic barriers, namely, roadside barriers,
median barriers, bridge railings, and crash cushions.

Traveled Way

Lanes, excluding the shoulders.

Turn Bay

The lane (or bay) can have one or two lanes. A lane (or bay) is considered to be present when it (a) is for the
exclusive use of a turn movement, (b) extends 100 ft (or 30.5 m in metric) or more back from the stop line, and (c)
ends at the intersection stop line.

Two-Way Left-Turn Lanes

The installation of a center two-way left-turn lane (TWLTL) on a rural two-lane, two-way highway to create a three-
lane cross-section can reduce crashes related to turning maneuvers at driveways. The base condition for two-way
left-turn lanes is the absence of a TWLTL.

The CMF for TWLTL installation is not applied unless the driveway density is greater than or equal to five driveways
per mile. If the driveway density is less than five driveways per mile, the CMF for TWLTL installation is 1.00

Urban Environment

An area typified by high densities of development or concentrations of population, drawing people from several
areas within a region.

User-Defined CMF Description

In the User-Defined CMFs table, the user can specify a longer detailed description of a CMF for any added user-
defined CMFs.

User-Defined CMF Name

In the User-Defined CMFs table, the user can specify a short name for a CMF for any added user-defined CMFs.

User-Defined CMF Type

In the User-Defined CMFs table, the user can specify the type of CMF for any added user-defined CMFs. The
different CMF types include the following: Total, FI, PDO. Depending on the type selected, the user-defined CMF
will get applied with the calculated CMFs in the methodology for the facility/model type combination established.
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User-Defined CMF Value

In the User-Defined CMFs table, the user can specify the value of the CMF for any added user-defined CMFs. This
value will then get applied in the analysis based on the CMF type established for it.

Volume

The number of persons or vehicles passing a point on a lane, roadway, or other traffic-way during some time interval,
often one hour, expressed in vehicles, bicycles, or persons per hour.

Weaving Section Length

This is the total length of the Type B weaving section length. This length is measured along the edge of the freeway
traveled way from the gore point of the ramp entrance to the gore point of the next ramp exit, as shown in the figure
below.

L wey = weaving section length

The gore point is located where the pair of solid white pavement edge markings that separate the ramp from the
freeway main lanes are 2.0 ft (or 0.61 m in metric) apart. If the markings do not extend to a point where they are
2.0 ft (or 0.61 m in metric) apart, then the gore point is found by extrapolating both markings until the extrapolated
portion is 2.0 ft (or 0.61 m in metric) apart. If the measured gore-to-gore distance exceeds 0.85 miles, or 1.368
kilometers in metric (4,500 ft, or 1371.6 m in metric), then a weaving section is not considered to exist. Rather, the
entrance ramp is a “lane add” and the exit ramp is a “lane drop”.

This value is computed separately for the increasing and decreasing milepost directions.
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